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Release Notes Summary

9.6.0

9.6.0
Improvements
e WordCounter | Korean | Option to count as words
Added a new configuration just for Korean to be counted with character-based and the ability to count as

word-based like other languages except Chinese/Japanese.

9.6.0

Fixed Issues
¢ Fixed issue with word count configuration having the wrong attribute in the content XML file.

e Fixed issue with TM not being visible under the Select TM to Update section.

9.6.0
Known Issues

e MacOS: Issue with Catalina/Big Sur reporting keystroke logging during opening of application
e TXLF Editor column outlines get hidden when windows display settings are set to 125%



This section provides basic information to get started with Wordfast Pro, a stand-alone desktop application you
install on and access with your local computer.

Wordfast Pro is the latest standalone, multi-platform TM tool designed to address the needs of translators,
language service providers, and multi-national companies. It offers a complete translation environment that stores
your translated content for reuse on future projects, thereby maximizing efficiency, increasing overall consistency
and reducing translation costs.

Cross-platform compatibility — Browser-based tool runs natively on Windows, Mac, and Linux.

Target-only Live Preview — After translation, provides a preview to proofread a target-only version with
layout and formatting.

Segment filtering — Filters segments based on terms, regular expressions, match scores, notes, and other
attributes.

Configure multi-lingual translation projects — Supports translation into multiple target languages and can
send as a single package or separate packages based on language pairs.

Export and import translation packages — Allows configuration and export of translation packages for fast,
seamless translation management.

Format flexibility — Supports virtually any file format, including MS Office, Adobe InDesign, FrameMaker,
PDF, HTML, XML, SDL Trados Xliff, MemoQ XiIiff, and more.

Chain files — Allows combination of multiple files into a single file to improve the consistency of repeated
segments and facilitate file management.

Unlimited TM and glossary access — Accesses an unlimited number of TMs and glossaries simultaneously
and prioritizes as primary or secondary.

Activation of Wordfast Pro requires a license and online or offline registration.

An unlicensed version of Wordfast Pro working in Demo mode is limited.

e You can only create bilingual projects.

e You can only store up to 500 translation units (TUs) in a Translation Memory
(TM). To remove this restriction, purchase a license and activate the licensed
application.

To install Wordfast Pro:

1. Download the Wordfast Pro Windows Installer Package from http://www.wordfast.com/, based on your
operating system.

2. In your Downloads folder, double-click the .MSI, .DMG, or .TGZ file to open the Wordfast Pro Setup Wizard.


http://www.wordfast.com/

3. Complete all steps to align with your configuration, then click Finish.

Wordfast Pro opens in Demo mode. It still requires manual or online activation. Refer to Activation on page
9.

Activation

You can activate Wordfast Pro either manually or online. Both methods require an activation key. When you
purchase a Wordfast license, you can generate an activation key at https://www.wordfast.com/myaccount by
signing in with your sign in email and password. Copy and save the activation key.

To activate Wordfast Pro:

1. Open Wordfast Pro.

2. On the Sidebar, select the Open General icon to open the Wordfast Pro 5 application dialog.

3. Select Online Registration or Manual Registration, then follow the activation instructions.

About W Pleass snter your activation key and follow the instructions

Online Registration

License Type: Full, your license is activated
Manual Registration
Activation Key:

Update Wordfast Pro
. Licensawill expire in 324 days

-

Close
Option Description
Online Registration Enter the Activation Key, then select Activate.
Manual Registration a. Enter the Activation Key, then select Generate.

b. Copy the generated text into an email and send it
to the email address provided on the screen.

c. Save the license file from the return email.
d. Select Browse to the license file.
e. Select the license file, then select Activate.

After you activate the software, you can select either registration option to view the
number of days remaining on your license.



https://www.wordfast.com/myaccount

4. Restart Wordfast Pro.

The Wordfast Pro activation process is complete.

W=
To resolve any license issues, select the Open General icon j then select
Feedback.

Licensure

You can view license information after you have activated Wordfast Pro.

On the Sidebar, select the Open General icon 3 to view product information, your current license
information, Wordfast Pro update info, and to provide application feedback.

Wordfast Pro automatically monitors for updates. If an update is available, you receive
notification after you open the application.

About w About Wordfast Pro 5

Online Registration

Product Name: Wordfast Pro
Manual Registration
Version: 3.15.0.
Update Wordfast Pro
Build 1D: 20200124-1654
Feedback . -
JWM info: 11.0.5 {amded)
WIN 10.0
Copyright (c) Wordfast Pro, 2020. All rights reserved.
Privacy Policy
Close
Option Description
About Use to review product information, including your current version number.
Online Registration Use to activate your Wordfast Pro license online.

Manual Registration Use to manually activate your Wordfast Pro license through e-mail.




Option Description

Update Wordfast Pro Use to check for updates to the application and to add languages for the
application's Hunspell spelling dictionary.

Feedback Use to send feedback about software issues. Be as specific as possible, providing
the exact steps you took when the issue occurred. When sending feedback from the
Wordfast Pro desktop, the values from Name and Your Email are remembered and
saved after sending the report.
Please do not submit software usage questions to Feedback.

For software usage questions, select the Help icon to review the online help. If
you still have questions after reviewing the online help, sign in to your user account
at https://www.wordfast.com/myaccount and submit a Hotline request.

Start Wordfast Pro

After you install and activate Wordfast Pro, it is ready to use.
To start Wordfast Pro:

1. Double-click the Wordfast Pro icon on the desktop or select Wordfast Pro from the Windows Start menu.

W |: 1 |: ,,.,I |: | |: | |: | |: | |: 1 |=-" g E |§‘ IQ"
= 230 L@ LR Lo L3 e = T 4 oLl i
Open Create Open Close Add  Modify Remove Hecalculate Import Export Import SOL  Export SDL
TXLF Project Project Project Project Project Project  Progress Package Package Package Package
Projecis Location Source Language ~ ||| Target Language ~ || Date C... LastS... Comp... IE:]I 1 =
Wordfast Test C:\Users\Won  English German 2019/ 2019/.. 1%

. Quick Project  C:\Usersi\Won  English German 2019/ 2019/.. 5%
Another Test | C:\Users\Dest  English German 2019/ 2019/ . MNfA

Spanish {Latin Amet...
, Wordfast1 C:\Users\Won  English German 2019/... 2019/... MN/A

u German (Germany)
Wordfast_test C:\Users\Won  English German (Germany) 2019/... MN/A
Wordfast3 C:\Users\Won  English German 2019/... MN/A

—_—
-

4

Wordfast Pro opens to the Project List view.

2. (Optional) Select another view if you have created a project and are ready to begin translation or review.


https://www.wordfast.com/myaccount

2. Wordfast user interface overview

TransStudio Online allows users to coordinate and manage the translation process through an intuitive user
interface. Once you open the submission in Project Director (PD), you can open the files using TransStudio
Online and begin translation.

TransStudio Review allows users to coordinate and manage the review process through an intuitive user
interface. Once you open the submission in Project Director (PD), you can open the files using TransStudio
Review and begin your review.

Wordfast Pro allows users to coordinate and automate the translation and review process through an intuitive,
stand-alone user interface.

Select icons on the Sidebar to move among views.

Wordfast Pro uses a Sidebar to navigate among views. Click the icons to change from one view to another.
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Sidebar Icon Action

Select to open the General view.

The General view includes general product information, as well as a form to
provide product Feedback.

In Wordfast Pro, you will also find product registration and software update
information here. See Activation on page 9 or Licensure on page 10 for more
information.

yg

Select to open the Project List view.

Select to open the Current Project view.
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f
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Sidebar Icon Action

n/ Select to open the TXLF Editor view.

% Select to open the Quick Tools view.

_I—I- Select to open the Preferences view.

el

<< Select to collapse the Sidebar. This action hides the icons and increases the
workspace.

Select :3" to expand the Sidebar.

The view that TransStudio Online opens with depends on your selection in PD.

The view that TransStudio Review opens with depends on your selection in PD.

If you select a submission with multiple files, TransStudio opens in the Current Project view. .
[ ]

If you select a single submission file, TransStudio opens in the TXLF Editor view. n

The default view is the Project List view. ' l

When you begin working on a project from the project list, the result is the Current Project view. .

Each view is explained in more detail in the subsequent sections.

The Project List view displays a list of your active projects.
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Item Action
Sidebar Click icons to switch among user views. User views include General application
information, Project List, Current Project, TXLF Editor, Quick Tools, and
Preferences.
Action Button Perform a specific task.
Action Bar Access all action buttons associated with a specific user view and tab.
Project List View all files associated with a specific project.

Current project view

The Current Project view displays a list of the TXLF files that are included in a selected project. Double-click a
file from the list of TXLF files to open it in the TXLF Editor.
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File Filter Language File List File Progress Project Progress Filter
Pair Bar Bar
Item Action
Sidebar Select icons to switch among user views.
Menu Tab Access the various tools of the application. Each user view contains different

tabs.

Action Button

Perform a specific task.

Action Bar

Access all action buttons associated with a specific tab.

Collapsed Items

Access any remaining tools that do not fit in the window.

File Filter

Create filter criteria to refine the file list.

Language Pair

Access the file list associated with a specific source and target language pair.

File List

Access a specific file within the language pair.

Project Progress Bar

View the percentage of work completed on a project.

File Progress Bar

View the percentage of work completed on a file.

You can view file information, filter criteria, and sort files using the provided search options.
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Files Word Count

TXLF File Location

Creation Date Last Saved Complete

Translation Status Complete Last Saved

Item Action

Files Lists the files available in the current project. Type a file name in the box to
locate a file in the project list.

Word Count Displays the total word count of each file in the project.

Last Saved Displays the date and time of the most recently saved the file.

Complete Displays the file progress bar with completion percentage.

Clears filter criteria.

Sorts filter criteria in ascending or descending order.

Changes the sort order, the sort options are: Files, Word Count, Translations
Status, Complete, and Last Saved.

Item Action

Files Lists the files available in the current project. Type a file name in the box to
locate a file in the project list.

Word Count Displays the total word count of each file in the project.

TXLF File Location

Displays the directory path to the stored file location. Type a path name in the
box to locate a file or to group files in a particular path.

Creation Date

Displays the date and time the file was created based on the user's system
settings.

Last Saved

Displays the date and time of the most recently saved the file.

Complete

Displays the file progress bar with completion percentage.

Clears filter criteria.

Sorts filter criteria in ascending or descending order.

Change the sort order. The sort options are Files, Word Count, Translations
Status, Complete, and Last Saved.

The TXLF Editor view is your default translation and edit review and edittranslation and review workspace.

You can choose from two layouts for your TXLF Editor workspace.

¢ Table view—This layout displays the source segment to the left and the target segment to the right.

e Stacked view—This layout displays the source segment row directly above the target segment in a

spanned row.



You can select either layout view by selecting the drop-down menu for the Switch Editor Layout action on the

File tab.
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Pane Column Column Pane Bar Column
Item Action
Sidebar Select icons to switch between user views, including the Current Project
or TXLF Editor views and user preferences.
Menu Tab Access a specific function and its action buttons.

File Name Tab

View an open or chained file.

Action Bar

Access all action buttons associated with a specific tab.
If the action bar is not large enough to display all the action buttons, an

additional Collapsed Items button

show the remaining action buttons.

appears and acts as a drop-down to

Action Button

Perform a task.

Table Filter

Create filter criteria and or search in the open file.
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Item

Action

Comments & Ratings Column

Use for evaluating the quality of translation.

View Selector

Toggle between the TXLF Editor Advanced and Simple views. The
Advanced View displays all Action Buttons and options required to
complete a file. The Simple View displays the minimum Action Buttons to
complete file review.

Editor Pane

Access editor tab content or interact with it using menus and sub-menus.

Source Column

View numbered, color-coded segments after source file analysis.

Target Column

Use as primary work area for translation entry with or without leveraging a
translation memory (TM).

Terminology Pane

Search the source or target glossaries, add terms to terminology
glossaries if enabled, or open a remote glossary.Search the source or
target glossaries, or add terms to terminology glossaries, if enabled.

Score Column

View the TM match score represented as a percentage.

Progress Bar

View the progress of the total review based on the number of translated,
reviewed, and signed-off segments. If you have chained files, the
percentage includes all the segments in the chained file.

Status Column

View the status of a segment.

Segment State Column

View the state of the reviewed segment. Toggle between Reviewed and
Signed Off.

Item Action
Sidebar Select the icons to switch among user views.
File Name Tab View an open or chained file.

Action Button

Perform a task.

Menu Tab Access a specific function and its Action Buttons.

Filter Bar Filter how segments are sorted and displayed.

Action Bar Access all Action Buttons associated with a specific tab.
Table Filter Create filter criteria for searching in the open file.

Collapsed Items

Access any remaining tools that do not fit in the window.

Preview Pane

View the translated content in its original format for MS Word .DOC
and .DOCX files, MS PowerPoint .PPT and .PPTX files, Markdown .MD
files, MS Excel .XLS and .XLSX files, or JSON .JSON files.

Editor Pane

Access editor tab content or interact with it using menus and sub-menus.

Source Column

View numbered text segments that will be translated in the Target Column.

Target Column

Use as primary work area for translation entry with or without leveraging a
translation memory (TM).




Item

Action

Terminology Pane

Search the source or target glossaries, or add terms to terminology
glossaries, if enabled.

Segment Score Column

View the TM match score represented as a percentage.

Status Column

View the status of a segment by its status icon.

Segment State Column

View the state of the translated segment. Toggle between Needs
Translation and Translated.

Progress Bar

View the progress of the total translation based on the number of
translated segments. If you have chained files, the percentage includes all
the segments in the chained file.

Item Action

Sidebar Select the icons to switch among user views.

Menu Tab Access a specific function and its Action Buttons.

File Name Tab View an open or chained file.

Action Bar Access all Action Buttons associated with a specific tab.

Action Button

Perform a task.

Table Filter

Create filter criteria for searching in the open file.

Segment Score Column

View the TM match score represented as a percentage.

Status Column

View the status of a segment by its status icon.

Collapsed Iltems

Access any remaining tools that do not fit in the window.

Editor Pane

Access editor tab content or interact with it using menus and sub-menus.

Source Column

View numbered text segments that will be translated in the Target Column.

Target Column

Use as primary work area for translation entry with or without leveraging a
translation memory (TM).

Terminology Pane

Search the source or target glossaries, or add terms to terminology
glossaries, if enabled.

Progress Bar

View the progress of the total translation based on the number of
translated segments. If you have chained files, the percentage includes all
the segments in the chained file.

Segment State Column

View the state of the translated segment. Toggle between Needs
Translation and Translated.

° When the Preview, Editor, or Terminology panes are resized, Wordfast will remember
the settings the next time it is run.

0 When the Editor or Terminology panes are resized, TSO will remember the settings
the next time you sign in.




When the Editor or Terminology panes are resized, TSR will remember the settings
the next time you sign in.

In addition to the Table View and Stacked View layouts, you can choose from two views which affect the Menu
tabs:

e Advanced View—This view displays all Action Buttons and options.

¢ Simple View—This view combines Action Buttons from multiple Menu tabs, as shown in the following
table, and places them onto a single Review tab. This view displays only the minimum Action Buttons and
options required to complete a file review.

Simple View Action Button Advanced View Action Button Location
Save File tab > Save
Finish Review File tab > Finish Review
Preview File tab > Preview
Download Source Files File tab > Download Source Files
Highlight All Terms Terminology tab > Highlight All Terms
Mark All Signed Off Translation tab > Mark All Signed Off
Translation  Terminology  Review Simple View 2 A X
e & B B B 5 B B B
Close Close Al Recalculate  Save Save Al Finish ¥ GetMSWord  Downlbad  Switch Editor ™ Preview =
Progress Review Table Source Files Layout
G Edit Formatting Translation Terminology Review SimpleView ? A X%

B & B B [k S &

£ X X " B =] + =3 @ @
Close Close All Recalculate Save Save All Finish ~  Get MSWord Download Switch Editor ~  Preview

[ Progress Review Table Source Files Layout

Review Advanced View 7 A X
¢ | m B 2 ® B
Save ™ Finish ™ Preview ™ Download Highlight Mark Al
Review Source Files  AllTerms  Signed Off

P = & E T =

Spelicheck File Save Finish ~  Preview Download Highlight Mark Al
[ Review Source Files All Terms Signed Off

Either the Advanced View or Simple View is set as the default by a system administrator when they create a
project.

Filter criteria

Use filter criteria to narrow your search for segment content.

Source or Target Match Case Regex - |Filter: - D }‘J X Sort: | Document « -l:l-



Source or Target Match Case Regex Enter text to filter segments.. Filter: Select special filter(s Q Q ® Document ~ £

Option Action

Source or Target Select from drop-down menu to search source, and or target segments, or
user attributes.

Match Case Make your search case-sensitive.
Regex Select to search on regular expression or wild card characters.
Text Filter Filter segments based on text search.

Type or paste text into the text filter box and press Enter or select the
Filter .
Q

button.

Special Filters Select the drop-down list for more search filter criteria (listed below).

Activate the filter action.

Q
Activate the cumulative filter action for all search fields.
@
Reset the toolbar filter fields.
X
Sort Select from drop-down menu to order the remaining search list.
Configure the maximum word count for the segment filter.
1

Special Filters are a drop-down list of all available search filter criteria:

¢ 100% match segments: segments matching completely in the TM

¢ Aligned segments: segments that contains aligned score coming from aligner tool

¢ All except 100% and Context match segments: segments with partial TM match, no match, or modified
segments

e All except 100%, Context match and Auto-propagated segments: segments that are modified, fuzzy,
MT, no match, Align and Client provided scores

¢ All except 100%, Context match and Translated segments: segments that are fuzzy, modified, MT, no
match, Align and Client provided scores with state Needs Translated Segments

¢ All except 100%, Context match and Auto-propagated and Translated segments: segments that are
fuzzy, modified, MT, no match, Align and Client provided scores with state Needs Translated Segments

¢ All except Duplicate segments: will show one instance of repeated segments

¢ All except auto-propagated: all statuses except the segments that are auto-propagated
¢ All except locked segments: all segments that are not locked

e Auto-propagated segments: all auto-propagated matches



Client provided segments: segments provided by the client TM

Committed segments: segments with translated content committed to the TM

Context match segments: all 100+% context matches. Context matches provide more refined matches
that are based on contextual references in the TM. For example, a segment is considered a context match
when the previous and next segments also have a 100% match against the TM.

Do not write to TM segments: this is a status in editor to mark segments that should not be written to TM
Duplicate segments: segments being duplicated in the file

Edited 100% match segments: segments that contain 100% matches that are edited

Edited MT segments: MT segments that have been edited

Edited context match segments: segments that contain context matches that are edited

Edited fuzzy match segments: segments that contain fuzzy matches that are edited

Edited no match segments: segments that contain no matches that are edited

Edited source segments: source segments that have changed

Empty target segments: segments without a translated target

Excel Sheetname Segments: segments that contain sheetnames from an Excel file

First instance of Duplicate Segments: shows first instance of a segment that has more than one segment
with the same source

Fuzzy match segments: segments with partial TM match

Locked segments: segments that cannot be edited

Merged segments: segments that have been merged

Modified segments: all modified segments. By default all modified segments are highlighted in pink
Needs translation segments: untranslated segments

No match segments: segments with no match in the TM

Requires rating: segments with no ratings

Reviewed state segments: segments marked as reviewed

Segments merged across paragraph: segments have been merged across a paragraph

Segments with Transcheck warnings: segments with Transcheck warning status

Segments with grade and score comments: segments with grade and score comments with or without
ratings

Segments with changes: segments with modified target content

Segments with history: segments that have been edited and has a segment revision history viewable in
the Segment History tab

Segments with notes: segments containing comments

Segments with find/replace highlight all: segments containing text highlighted by Highlight All from the
Find/replace dialog.

Segments with ratings comments: segments with grade and score ratings with comments

Segments with ratings: segments with grade and score ratings with or without comments

Segments with repetitions: segments with repeated text strings

Segments with tags: segments that contain tags

Short segments: segments of fewer than {#} words, paragraphs or other blocks

Signed off state segments: segments are signed off

Split segments: segments that have been split into more than one segment due to length

TU Autocorrected Segments: segments that have a target have replacement TUs applied



¢ Translated state segments: segments that have been translated
¢ Unedited MT segments: Machine Translated segments that are unedited
¢ Unique segments: segments that are not repeated

You can quickly identify the status of a segment in the TXLF Editor view by its status icon.

Status Icon Segment Status

A non-linguistic error occurred in the segment during a Transcheck test.

The segment is locked, so you cannot edit it.

The segment is do not write to TM, so you cannot commit it to the translation memory.

The segment repeats more than once in the current file.

Dle & B|@

The segment has a note associated with it.

f' The content of the source segment was edited.
D', The segment was split.

A The segment was merged.

?11 Segments across a paragraph were merged.

The Segment State allows you to view, set, or change the state of a translation segment in the TXLF Editor view.
Untranslated target segments are automatically set to Needs Translation. Once a translation is committed to the
translation memory, the application considers the translation to be complete and changes the state to Translated.
Changes to the Segment State will also change the Translated completed percentage on the Progress Bar.

The Segment State allows you to view, set, or change the state of a review segment in the TXLF Editor view.
Changes to the Segment State will also change the Translated completed percentage on the Progress Bar.

The Segment State allows you to view, set, or change the state of a translation segment in the TXLF Editor view.
Untranslated target segments are automatically set to Needs Translation. Once a translation is committed to the
translation memory, the application considers the translation to be complete and changes the state to Translated.
Changes to the Segment State will also change the total translation completed percentage on the Progress Bar.



Segment  Segment State Description
State Icon

Needs Translation — This state indicates that the segment is not finished and is therefore not
included in the calculated progress shown on the Progress Bar.

e All untranslated target segments are set to Needs Translation, or select Mark All Needs
Translation to change all segments to Need Translation. After translating the segment,
select this icon to change the state to Translated.

Q/ e |If you commit a segment to the translation memory, or select Mark All Translated, this
state will automatically change to Translated.

e As you translate, you can commit the active segment to the TM by selecting the Next
Needs Translation Segment shortcut key (CTRL + Enter), and the active segment state
will change to Translated and then moves to the next segment whose status is set to
Needs Translation.

Needs Translation — This state indicates that the segment is not translated, and therefore not
included in the calculated translation progress shown on the Progress Bar.

All segments with machine translated content, empty segments, fuzzy, exact, and no matches
are set to Needs Translation by default. During the review process, if a segment does not need
changes, or comments, or ratings added, select the icon to set to Signed Off.

Q/ e If you commit a segment to the translation memory, or select Mark All Translated, this
state will automatically change to Translated.

e As you translate, you can commit the active segment to the TM by selecting the Next
Needs Translation Segment shortcut key (CTRL + Enter), and the segment state will
change to Translated and then moves to the next segment whose status is set to Needs
Translation.

Translated — This state indicates that the segment is finished and is therefore included in the
Progress Bar. Select this icon, or make a change in the translated segment, to change the state
back to Needs Translation.

\/ e Segments that are leveraged with Exact and Context matches are set to Translated by
default and are included in the Progress Bar percentage.”

e As you translate, when you commit segments to the TM by selecting Next Segment or its
shortcut key (ALT + DOWN), the segment state will change to Translated.**

Translated — This state indicates that the segment has been translated, the appropriate
changes were made, and were checked by a linguist. Segments that are committed to the TM
/ prior to review are automatically set to Translated, and are counted in the translation progress
shown on the Progress Bar.

Translated — This state indicates that the segment has been translated, the appropriate
changes were made, and were checked by a linguist. Segments that are committed to the TM
J prior to review are automatically set to Translated, and are counted in the translation progress
shown on the Progress Bar.

During the review process, if a segment does not need changes, or comments, or ratings
added, select the icon to set to Signed Off.




Segment  Segment State Description
State Icon

Reviewed — This state indicates the segment was reviewed. The state cannot be modified in
TSO.

v

Reviewed — This state indicates the segment was edited, or comments, or ratings were added.
This is set automatically and indicates the segment needs further review or corrections before
J being set to Signed Off.

Signed Off— This state indicates that the segment has gone through the entire translation and
review life cycle and is considered ready to deliver. Signed Off segments are counted in the
review progress shown on the Progress Bar. The state cannot be modified.

Signed Off — This state indicates that the segment has gone through the entire translation and
review life cycle and is considered ready to deliver. Signed Off segments are counted in the
review progress shown on the Progress Bar.

When a Signed Off segment is modified, or a comment, or rating is added, the segment state
changes to Reviewed automatically. This state can be reverted to Reviewed state if the Signed
Off segment is modified by the reviewer.

e The Signed Off state can be toggled to the Translated state when the previous state
of the segment was the Translated state and never had the Reviewed state for that
segment in history.

e The Signed Off state cannot be toggled back to the Translated state when any previous
state of the segment had the Reviewed state.

{ ™
. * You can change this default setting on a project-by-project basis in Preferences.

= Select Translation Memory in the Current Project Preferences section. Clear or
check the preferred check boxes in the Segment state section.
Segment state
| Set segments to Translated with leveraged Context Matches
| Set segments to Translated with leveraged 100% Matches

| Set segments to Tranzlated for Auto-propagated segments

. **You can change the Next Segment action so that the segment state does not
= change to Translated. In Preferences, select Segment in the General Preferences
section. Clear the check box for Commit changes the segment state to Translated
in the Segment actions section.




Segment actions
W Mext/Previcus Segment action leverages next/previcus segment

| Commit changes the segment state to Translated

Progress bar

The TXLF Editor view displays translation information and status in the Progress Bar at the bottom of the

window.
® EN-US — DE-DE Fillered Segments Total: 6 | Tmnsbsled: 84% 22 wodsdone) | Segments 413 | Begment (BreTgtiany: WA | Pamgrph (srcmgysien): i [ DESTRREER 20 wor s iy
o Translal
Bioned Off
L] E
@ EN-US — FR-FR Filteresd Segments Totak: 46 | Reviewed/Signed Off: 3% (1076 words done) | Segments: 1341253 | Segment (Src/TgtMax): Nia | Paragraph (Src/Tgtmax): Wi [T = Reviewed
Item Description

Source and Target
Languages

View the source and the target languages in the open translation file.

Filtered Segments Total

View the number of filtered segments in the open translation file. When filter
criteria is cleared the Filtered Segments Total is removed from the status.

Translated

View the percentage of filtered segments that are translated versus the total
number of filtered segments in the open translation file. The words done total is
calculated from all the translated segments from the filtered table. When filter
criteria is cleared, the Translated % is removed from the status.

Reviewed/Signed Off

View the percentage of filtered segments that are reviewed and signed off versus
the total number of filtered segments in the open translation file. The words done
total is calculated from all the reviewed and signed off segments from the filtered
table. When filter criteria is cleared, the Reviewed/Signed Off % is removed from
the status.

Segments View the number of segments completed versus the total number of segments in
the open translation file.
Segment (Src/Tgt/Max) View the character breakdown in a segment. This breakdown includes the

number of characters in the source and the target segments, and the maximum
number of characters allowed in the target. Hover over this portion of the toolbar
to view the progress in a larger display window.

A red box flashes around the Max segment value if the number of characters
exceeds the maximum allowed.

Segment (Src/TgtMax): 646731

The maximum length check counts HTML entities such as: &. These are real
characters and are counted as part of the overall character count (1 Character per
entity). Refer to Manage tags on page 128 for more information.




Item Description

Paragraph (Src/Tgt/Max) View the character breakdown in a paragraph. This breakdown includes the
number of characters in the source and target paragraphs, and the maximum
number of characters allowed in the target paragraph. Hover over this portion of
the toolbar to view the progress in a larger display window.

A red box flashes around the Max segment value if the number of characters
exceeds the maximum allowed.

Paragraph (Src/Tgt/Max): 646531

If the maximum length is set for a paragraph and the paragraph has only one
segment then the maximum length limit is shown in the editor for a filtered editor
table.

Percent Translated View the total progress of the translation in a file or in a group of chained files. If
you have chained files, the percentage complete will be the total for all the files as
if they were one.

View the total progress of the translation and review in a file or in a group of
chained files. If you have chained files, the percentages complete will be the totals
for all the files as if they were one. Hover over this portion of the toolbar to see the
progress in a larger display window. The window displays the percent translated,
the percent reviewed, and the percent signed-off, with color-coding that matches
the Segment States.

Select the Help icon E to access the online help for answers about how to use the software.

If you still have questions after reviewing the online help, sign in to your user account at https://
www.wordfast.com/myaccount and submit a Hotline request.

To send feedback about a software issue, select the Open General icon , then select Feedback. Be as
specific as possible, providing the exact steps you took when the issue occurred.

To send feedback about a software issue, select the Open General icon , then select Feedback. Be as
specific as possible, providing the exact steps you took when the issue occurred.

Please do not submit questions related to software usage to Feedback. Instead, sign in to your user account at
https://www.wordfast.com/myaccount and submit a Hotline request.


https://www.wordfast.com/myaccount
https://www.wordfast.com/myaccount
https://www.wordfast.com/myaccount

3. Manage projects

When Wordfast Pro opens, the default view is the Project List view. This view displays all your active translation
projects, and is where you manage the translation process for each project. On the Projects tab you can perform
many project operations, including creating projects, opening and closing projects, adding and removing projects,
and importing translation packages. After you create a project, you can keep a project on the projects list for

as long as it takes to complete it. A project stays in the projects list until you remove it. You can filter the list

of projects to display them by a variety of criteria including name, location, source or target language, and
completion percentage.

{ ™
a You can add a project to the projects list again, even after you remove it. Wordfast
does not erase removed projects, so you can retrieve them from the project folder on
your computer using the Add Project action.

\ Y,
e ™
a To bypass the typical project creation process, create a Quick Project with the Open
TXLF action.
\ J
Project Files Project TM Project Terminology Reports Reference Files 7 A X
B K6 E R B S B B _
Add Add Tranzkate 2 2N 5 = Close SAVE Modity E : Analyze Transcheck Segment Changes —
Files Folders File Files Fil= Project Project Project Expart Repaort Bepart
ﬁ Files Word... | TXLF File Localion Creation Date Last Saved Complete Q1=
- EN -> DE
Sample-File_ 188 C:\Users\ Public\WFP Proje 2019/11/13 10: 2019/11/13 10: | B3ty
Sample-Filz_an.. 19 C:\Users\Public\WFPPraje.. 2019/11/13 10:.. 2009/11/13 10:.. [
AdaptiveTrans... 193 C:\Users\Public\WFP\Proje. . 2019/11/13 10:... 2019/11/13 10:... 0%
n, Sample2_Sa.. 193 C:\Users\PubliciWFFProje. 2019/11/13 10:.. 20091113 10:... [ 18%
SampleFile_en... 7 Ci\Users' Public\WFP\Praje.. 2019/11/13 10:... . 5%
Sampled_Sa 197 C:\Users\Public\WFP\Proje. . 2019/11/13 10-.. I 19%
R

1L
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Open a TXLF file

A TXLF file contains text segments in a source language and a target language. In Wordfast Pro, to translate
the content in a TXLF file, you must create a project. A project may contain one TXLF file or multiple TXLF files.
This section describes how to create a Quick Project by opening existing TXLF files. To set up a new project and
prepare new TXLF files for translation, refer to Create a project on page 32.

To open a TXLF file:



1.

2.

Choose one of the following actions:

e Select the Project List icon ﬁ on the Sidebar to open the Project List view. Select Open TXLF, then
browse to select a file.

Projects

B B B EEBEREER F B8 B & R

Open Create Open Cloze Add Modify Remoaove Recalculate Import Export Import SDL  Export SDL
TXLF Project Project Project Project Project Project Progress Package Package Package Package

e Drag-and-drop one or more TXLF files to the project list.

If you used drag-and-drop, determine if you want to remember your choice on the Quick Open TXLF dialog,
then choose one of three possible actions.

Quick Open TXLF x

How would you like to open your TXLF files?
Nete: Quick Projects will not remain in the project list once closed.

Remember this choice

Open in New Project Open in Quick Project Cancel

a) (Optional) Select Remember this choice to use your selected option each time you choose the Quick
Open TXLF action without displaying the dialog again. Use General Preferences > General to show this
dialog again, after you choose to Remember this choice.

b) Select Open in New Project to use the standard Project Creation dialog.
c) Select Open in Quick Project to open the TXLF file in TXLF Editor as a temporary Quick Project.
d) Select Cancel to disregard the TXLF file open action and close the dialog.

If you chose to open the Quick Project, make your edits in the TXLF Editor, then save your changes and
select Close.

4. Select Save Project to retain the project in the project list.



5. In the Save Project dialog, modify the project details.

W Use this dialog to change the project name and set the location where the

project will be saved.

Project Name:" Quick Project

Save Project To:* C\sers'Documents'WFP\Resources Browse...

Save Cancel

Required fields are marked with a red asterisk.

a) Enter the Project Name.
b) Browse and select the file location in the Save Project To field.

c) Select Save.

Create a project

In Wordfast Pro, every translation begins with a project. Projects act as repositories for all related content, along
with associated translation memories (TMs) and glossaries.

G You must create a project before you begin translation, unless you use the Open
TXLF action.

6 A project also requires file format filters to convert the source content into segments
prior to beginning the translation process.

To create a project:

1. Click the Project List icon ﬁ on the Sidebar to open the Project List view.

2. Click Create Project.
Project
D B EREBERER B BB A B B &

Open Create Open Close Add Modify Remove Recalculate Import Export Import SDOL  Export SDL
THLF Project Project Project Project Project Project Progress Package Package Package Package




3. On the Project Creation dialog, enter a project name.

Required fields are marked with a red asterisk.

Project Creation x
Project Name:™ Wordfastg Source Flles Reference Flles
Reuse Project: None - | (3] Add File E') Add Folder ? Create Filter Remove Files
Save Project To* Cr\UserswafWaordfastProlprojects Browse... Name Type Path
Source Language:” English (United States) -
Target Language(s):” Spanish (Mexico) X

[m]

Translatlon Memory Glossary Blocklist
= = = Ml .
= Create :0 Add =t Import odify Remove
Name Priority Read O... Type Path
Options

&/ Bun analysis repart on documents

Pre-translate TXLF files

Create Project Cancel

(Optional) If you want to reuse the profile of a previously created local project, select it from the Reuse Project
drop-down list.

Project reuse removes all existing translation memories, glossaries, and blocklists

from the new project. On the Reuse Project Warning dialog, click Yes to agree to
reuse the project.

Enter the Save Project To location or click Browse... to select the location for your project.

Select Source Language and Target Language(s) from the drop-down lists.

. You can refine the source language and target language drop-down list results by
= starting to type a language name.

On the Editor pane, click the Translation Memory tab, if it is not already active.
Translation Memory Glossary Blocklist

(= (= . - R

='IEE Create '.:'ﬂ Add =T Impaort odif 2 MOVE

Name Priority Read ... | Type Path



8.

10.

11.

(Optional) Click Create to add a new local TM for your project.
a) On the Create TM dialog, enter a unique name for the TM.
b) Select a target language to create a language pair, then select the location for the TM on your local disk.

c) Select either primary or secondary priority from the drop-down list to determine the TM you leverage first.

You can select only one TM as the primary. The primary status dictates that the
content of that TM overrides any content in secondary TMs.

d) (Optional) To prevent any edits to the TM, select Read-only.
e) Click OK.

(Optional) To add an existing TM to your project, click Add, then select a local, remote, or a project-specific
TM from the drop-down menu.

. To use an online tool for work and production that integrates with Wordfast Pro, use
= Wordfast Anywhere (WFA) as your remote, unlimited, and private TM.

a) Add Local — Select a location on your local disk.

b) Add Remote — Enter the TM Server, WF Server, or WFA Server details on the Connect to Remote TM
dialog. Refer to Connect to a remote TM on page 159 .

¢) Add Project TMs — Enter the details on the Add Project TMs dialog by selecting the project.

The source language, target languages, and list of TMs auto-populate, based on the
project you select. Remove the target languages or TMs that you do not want to import
from the target languages and list of TM fields.

(Optional) To import an existing TM to your project, click Import.

a) On the Import Translation Memory dialog, select the import File Type: TMX or WF TXT TM format from
the File Type drop-down list.

b) Click Browse to locate and select the project file that contains the TM that you want to import.

c) Select either the Create a new TM or Import into existing TM option. Refer to Import a local TM on page
174.

d) If the TU already exists, select an overwrite option from the drop-down list.
e) Select Delete all TUs from existing TM if you want the import to overwrite and create a clean TM.
f) Click OK.

(Optional) To edit an existing TM in your project, click Modify.
a) On the Modify Local Translation Memory dialog, modify the name of the TM or its priority.

b) Select whether you want to protect the TM as read-only.



12.

13.

14.

15.

16.

17.

(Optional) On the Editor pane, click the Glossary tab.

Translation Memory Blocklist
Create D-I Add m Impaort
D o p
Name Read Only | Type Path

(Optional) Click Create to add a new local glossary for your project.

a) On the Create Glossary dialog, enter a unique name for the glossary.

b) Select a target language from the drop-down list, then select the location for the glossary on your local disk.
¢) If you want to prevent any edits to the glossary, select Read-only.

d) Click OK.

(Optional) To add an existing glossary to your project, click Add, then select a local, remote, or a project-
specific glossary from the drop-down list.

a) Add Local — Select a location on your local disk.

b) Add Remote — Enter the TMGR Server, WF Server, or WFA Server details on the Connect to Remote
Glossary dialog. Refer to Connect to a remote glossary on page 179.

c) Add Project Glossary — Enter the details on the Add Project Glossary dialog by selecting the project.

(Optional) To import an existing glossary to your project, click Import.
a) On the Import Glossary dialog, select the import File Type from the drop-down list: TBX or Tab delimited.
b) Click Browse to locate and select the project file that contains the glossaries that you want to import.

¢) To configure a glossary creation option, select either Create a new glossary or Import into existing
glossary. Refer to Import a local glossary on page 189.

d) Select an overwrite option for preexisting terms.

e) Select Delete all terms from existing glossary if you want to ensure the import overwrites a clean
glossary.

f) Click OK.

(Optional) On the Editor pane, click the Blocklist tab.
Translation Memory Glossary
[?‘ Create ﬁ}ré Add ﬁ%‘ Import

Name Read Only | Type Path

(Optional) Click Create to create a new local blocklist for your project.

a) On the Create Blocklist dialog, enter a unique name for the blocklist.

b) Select a target language for the blocklist, then select the location for the blocklist on your local disk.
¢) If you want to prevent any edits to the blocklist, select Read-only.

d) Click OK.



18. (Optional) To add an existing blocklist to your project, click Add, then select a local or remote blocklist from the
drop-down list.

a) Add Local — Select a location on your local disk.
b) Add Remote — Enter the details on the Connect to Remote Blocklist dialog. Refer to Connect to a
remote blocklist on page 194.
19. (Optional) To import an existing blocklist to your project, click Import.
a) On the Import Blocklist dialog, select the import File Type: TXT.
b) Click Browse to locate and select the project file that contains the blocklist that you want to import.

c) Select the blocklist creation option: Create a new blocklist or Import into existing blocklist. Refer to
Import a local blocklist on page 198.

d) Select an overwrite option for preexisting terms.

e) Select Delete all terms from existing Blocklist if you want to ensure the import overwrites a clean
blockilist.

f) Click OK.

20. On the Source Files tab, choose a method to add project source files.

Reference Files

Eﬂ?’-‘ Add File E; Add Folder ? Create Filter

Name Type Path

° You can drag-and-drop files from a folder to the Files panel.

° To copy source files into the Source File folder within the Project folder on your
computer, select Copy Source or TXLF Files into Project Folder Structure in your

General Preferences.
\. J

a) (Optional) Add File — Click to browse to the source file.
b) (Optional) Add Folder — Click to browse to the folder location for source files.

c) (Optional) Create Filter — Click to create a conversion filter the source files. You can create multiple filters.

21. (Optional) On the Reference Files tab, choose a method to add supporting documentation.

Source Files
!{I:' AddFile [ Add Folder
Name Type Path

a) (Optional) Add File — Click to browse to the source file.

b) (Optional) Add Folder — Click to browse to the folder location for source files.



22. (Optional) Select any additional Options.
Run analysis report on  Analyzes source files against TMs and generates a report. You can also view this
documents report on the Reports tab, after opening the project.
Pre-translate TXLF files Populates TM leveraged segments when TXLF files are open.

Use primary MT onno  Leverages primary machine translation (MT) when there are no matches with the
match segments local and remote TMs. This option is only available if you selected Pre-translate
TXLF files.

23. Click Create Project to analyze the files and display the project creation summary.

Wordfast1 x

Here you can see the number of the files added, TMs,
®® hiocklists and glossaries along with any errors that might
have occurred.
Ea Bilingual (TXLF) Files
Created: 1
Failed: ]

..:\., Translation Memories
[~

Added: 1
D—l Glossaries
Added: 2
!{'} Reference Files
Added: 0
i Blocklists
Added: 2

~] Open created project

24. (Optional) On the Wordfast dialog, select Open created project.
25. Click OK.

The project is created.

Open a project

Once you create a project, the next step is to open it. You cannot open files for translation without first opening
the associated project.

To open a project:

1. Inthe Project List view, select a project name from the list.



2. Click Open Project or double-click the project name to open it.

RE R BEBRER B B 88 B &

Create Open Cloze Add Muodify Remove Recalculate Import Export Import SOL  Export SDL
TXLF Project Project Project Project Project Project Progress Package Package Package Package

The project opens in the Current Project view. A list of the project's language pairs and the associated
translation files displays on the Project Files tab.

Project Files Project TM Project Terminology Reporia Reference Files ? A X

Mew 2L & B RBBH & B B _
Ao Add Tranciate  Chain  Open Sourcs Clse Save Modity  Bllingua Analyze  Trangcheck  Sspment Changes =
Files Folders Filz Files Fil= Project Project Project Expaort Report Beport
ﬁ |Fil¢s | Wurd...l|TXLF File Location | Creation Date _ Complete ‘ Q1=
< EN -> DE
o [ sample-File_ . 183 Ci\Users\Public\WFP\Proje 2019/11/13 10: 0191113 10:.. [ |
n B sample-File_en.. 19 Ci\Users\Public\WFP\Proje..  2019/11/13 10:..  2019/11/13 10:.. [
o [ AdaptiveTrans.. 103 Ct\Users\Public\WFP\Proje...  2019/11/13 10:..  2019/11f13 10:.. | 0% |
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Modify a project
You can change the project name and target language using the Modify Project action.
To modify a project:

1. Inthe Project List view, select a project, then click Modify Project.

2R E R REBL R B B B B &

Open Create Open Cloze Add Muodify Remove Recalculate Import Export Import SOL  Export SDL
TXLF Project Project Project Project Project Project Progress Package Package Package Package




2. (Optional) On the Modify Project dialog, enter a different name in the Project Name field.

Modify Project x
e se this dialog to change the project name and either add or remove
target languages.
Project Mame:* Project1
Target Language(s):* German X
O
OK Cancel

3. (Optional) In the Target Language(s) field, add a language by selecting one from the drop-down list. Deselect
a language to remove it.

4. Click OK.

The modifications are active and the project list displays the changes.

Remove a project

To remove a project:

You can add a project to the Project List again, even after you removed it. Wordfast
Pro does not erase removed projects, so you can still retrieve them from the project
folder on your computer using the Add Project action.

1. Click the Project List icon m on the Sidebar to open the Project List view.

2. Select the project from the list, then click Remove Project.
Project
B B BEERB B R B B B & &

DOpen Create DOpen Close Add Modify Remave Recalculate Import Export Import SDL  Export SDL
THLF Project Project Project Project Project Project Progress Package Package Package Package



3. On the Remove dialog, click one of the action buttons.

*) Remove from the list only

Remaove from the list and move the following resources to Archive folder

Resources #
TXLF Files 2
Reference Files 1
oK Cancel
Remove from the list only Remove the project from the Projects List but retain

project resources in the project folder on your computer.

Remove from the list and move the following Move the project TXLF, reference, and source files to
resources to Archive folder the Archive sub-folder within the project folder on your
computer.

4. Click OK.

The project is no longer in the Projects List.

Package files

A package file contains all of the required information to work on a translation project. You can use a package file
to share content and files among different Wordfast Pro (WFP) users. The package file can contain complete or
incomplete projects.

A package file generally includes:

e Source files

e All target translatable files

e [nstructions

e Background information

e Reference files

e Comments

e Connection to at least one Translation Memory (TM)
¢ Connection to at least one glossary and blocklist

To access a package file from another user, import the file into WFP. Wordfast connects the imported files to
translation memories and glossaries. It provides you access to all translatable files and additional resources,
including TMs and glossaries, without any additional setup or configuration.

To share a completed project with other users, export it as a package file.



Import package files

Package files allow different Wordfast Pro users to share files. When you import a package file, you automatically
connect the files to translation memories and glossaries. You also gain access to all translatable files and
additional resources. This eliminates the need for manually creating a project.

To import package files:

1. Click the Project List icon ﬁ on the Sidebar to open the Project List view.

2. Click Import Package.
Proecs
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Open Create Open Close Add Modify Remave Recalculate Import Export Import SDL  Export SDL
THLF Project Project Project Project Project Project Progress Package Package Package Package

3. On the Import Package dialog, click Browse to locate and select the package file.

Required fields are marked with a red asterisk.

. Alternatively, you can drop a package file into the white space on the Import Package
= dialog to begin the import process.

e mport Package _ i
Select options to import a GLP file to the project list

Select a GLP file:” CUsers\rafDocuments\WWORKING-GloballinkW Browse...
Source Language: en-Us
Target Language(s): de-DE

* | Update an existing project
Select project to update:” Wordfast3 -
*) Only update the project's existing TXLF files

Update the project's existing TXLF files and add new files

Create a new project

~/| Open project after importing

Import Cancel




4. Choose one of the following:
e Update a project by clicking Update an existing project and its options.

e Create a new project by clicking Create a new project and its options. The project location drop-down

gives three options. The selected option is remembered the next time a package is imported.

o Create project in projects folder (Default): creates the project in the projects folder under the
WordfastPro directory.

o Create project in same location as the package: creates the project in the same location that the
package has been saved to.

o Enter the location to create the project: activates the Browse... button so that you can then
choose a location.

5. (Optional) Select Open project after importing to open the project in the Current Project view when the
import completes.

6. Click Import.

The package file is imported.

Export package files

Use Export Package to share a complete project package with other Wordfast Pro users.

To export package files:

1. Click the Project List icon ' l on the Sidebar to open the Project List view.

2. Select a project from the list of projects , then click Export Package.
Projects
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3. On the Export Package dialog, select either Entire Project or Specific target languages and resources.

Export Package x
as Export Package
Select options to prepare a project export for distribution or archiving
Project Info
Project Mame: Project 1
Project Location: C\Users'WordfastPro\projecis\Project 1
Source Language: English
Export

*) Entire Project

Specific target languages and resources

Resources to Include in Export

Package Mame

Select Maming Convention: | Project Mame -

Preview: Project 1.glp

Select Location to Save

ChUsers\Documents\Source\WFP Export Browse...
Export Cancel
Entire Project Click to export all target languages and their associated resources.
Specific target a. Click to export specific target languages and associated resources.
languages and b. Click items from the drop-down list for further options to deselect specific
resources Target Language and resources for exclusion from the export.

4. Choose an existing name from the Select Naming Convention drop-down list or enter a name of your choice
in the Custom Name field.

The Preview field provides the name of the file as it will export below the Package
Name fields.

5. Select a save location for the project package, then click Export.

The exported project package is built and saved to the folder location.



Import SDL package files

You can import an SDL package file for conversion of SDL source files to a compatible Wordfast Pro format.
Imports include scores for source content, but do not include translation memories, glossaries, and reference files.

To import SDL package files:

1. Click the Project List icon ﬁ on the Sidebar to open the Project List view.

2. Click Import SDL Package or drop the SDL Package file into the application window.

Projects
Open Create Open Close Add Modify Remave Hecalculate Import Export Import SDOL | Export SDL

TXLF Project Project Project Project Project Project Progress Package Package Package Package

3. On the Import Package dialog, click Browse to locate and select the SDL Package file.

c If the SDL Package file contains unsupported target languages, a warning message
notifies you. Click OK.

Import Package xX
e |mport SDL Package
Select options to import a package file to the project list
Select a package:* | C:Users\Desktop\Project 5.sdippx Browse...
Source Language: en-Us
Target Language(s): it-1T,de-DE

Create a new project

Project Name* | Project 5 |

Location:* | CUsers'Wordfastd\projects | Browse...

Open project after importing

Import Cancel

4. Enter the new Project Name.

5. Browse to and select the save location for the new project.



. (Optional) Select Open project after importing to automatically open the project in the Current Project view
after import. If this option is not selected, the project displays in the Project List view.

. Click Import.

The SDL Package file import completes.

Export SDL package files

Use Export SDL Package to export an SDL package.

To export package files:

. Click the Project List icon ﬁ on the Sidebar to open the Project List view.

. Select a project from the list of projects, then click Export SDL Package.
projcts

Open Create Open Cloze Add Muodify Remove Recalculate Import Export Import SDL ~ Export SDL
TXLF Project Project Project Project Project Project Progress Package Package Package Package

. On the Export Package dialog, select the location of the original package and the location for the exported
package.

When exporting the SDL package, the Select original package: text box automatically
selects the file path of the original imported package file location based on the




previously used SDL package location. If the selected project was not imported from
the SDL package then the Select original package: text box will be blank.

Export Package x

-
e Export SDL Package
Select options to export SDL return package for projects containing SDLXLIFF files
Select original package:™ | ChUsers'WordfastPro\projects\Praject 1 | Browse...
Select refurn package location:™ |G:\Users‘.[lncumerﬂs\Soum&\WFP Export | Browse...

=l o

The exported project package is built and saved to the folder location.




4. Manage project files

When you open a project, the view changes to the Current Project view. On the Project Files tab, the language
pair of the project displays the list of translation files.

/_' DR Project TM Project Terminology T~ X
Fevizw Fils Ghain Transcheck  Silingus Ssgment Change:  Finizk Finish Al
es Fisport Expart Rapon Review Review
Files Word Co...| Translation Sta...| Complste Last Saved e 1=
. g EN-> DE
File_1-PK_Word_TXLF-d.. 214 Madified . S5%T

N

Tir

© oo I e

Project TM  Project Terminology 2AX

Project Files

C P il l.—::" [E)
Review File Chain Transcheck Bilingual Segment Changes Finish Finish All
Files Report Export Report Review Review
Files Word Cour Translation Statt Complete LastSaved @@ 11 =
n/ ~-% EN US -> DE DE
Sample-File_en-de -S. 188 Modified N 18% 2021/02/16 10:51:52 ...
- - Sample-File_en-de.dr 188 Opened 0%
-
<
® EN-US — DE-DE [ | 9% Reviewed
MOl Project TM  Project Terminology 2 AR
Translate  Chain  Transcheck  Bilingual  Segment Changes  Complete  Complete
File Files Report Export Report All
Files Word Cour Translation Stati Complete Last Saved D =
~f EN US -> DE DE
Sample-File_en-de -S. 188 Modified T 18% 2021/02/16 10:51:52 ...
s F Sample-File_en-de.di 188 Opened 0%
-

«

® EN-US — DE-DE [ | 9% Reviewed



Project Files Project TM Project Terminology Reporia Reference Files 2?2 A X

RB DL B REREGLG & BB

][

Transiate Chain Open Source Close Modity Bilingua Analyze  Transcheck  Segment Changes

Files Foldars Sile Files Fil= Project Project Project Export Report RBeport
Files | Word... || TXLF File Location || Creation Date _ Complete | a1l =
= EN-> DE

- [ sample-File_. 183 Co\Users\Public\WFP\Praje..  2009/111310:.. 200971113 10:.. (S |

ﬁ Sample-File_en. . 19 Co\Users\PublicWFP\Proje...  2019/13/13 10: . 2019/13j13 10: . [N

B adaptiveTrans.. 193 Ci\Users\PubliclWFP\Proje.. 20191113 10:..  2019/11f13 10:.. | 0% |

[ sample2_sa. 193 C:\Users\PubliclWFF\Proje..  2019/13/13 10: . 2019/11/13 10:. [ 18% |

B sampleFile_en.. 7 Ci\Users\Public\WFF\Proje...  2019/11/13 10:... sER

“ [ sampled_sa.. 197 C:\Users\PublicWFP\Proje...  2019/11/13 10: .

Amxan»m

o -0s . e

Add files

You can add files to an existing project using the Add Files option on the Project Files tab.

o If one or more of the source files have a different language code, you will receive a
prompt to modify the project and add the new target language.

To add files to a project:

1. Click the Project List icon ﬁ on the Sidebar to open the Project List view.

2. Select a project from the project list, then click Open Project.

3. Click the Current Project icon - on the Sidebar to open the Current Project view.
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4. Click Add Files on the Project Files tab.

Project Files Project TM Project Terminology Reports Reference Files

B B2 [0 B B E B B & &

Add Add Translate Chain Open Source Close Save Modify Bilingual Analyze Transcheck
Files Folders File Files File Project Project Project Export Report

5. Browse to and select one or more source files on the Open dialog.
6. Click Open.
7. On the Files Report dialog, click OK.

Add a folder

You can add a folder containing multiple files to an existing project using the Add Folders option on the Project
Files tab.

To add a folder to a project:

1. Inthe Current Project view, click Add Folders on the Project Files tab.
Project Files Project TM Project Terminology Reports Reference Files

B R B L B B BB B & €

Add Translate Chain Open Source Close Save Modify Bilingual Analyze Transcheck
Files Folders File: Files File Project Project Project Export Report

To activate the Current Project view, you must first open a project. Click the Project

List icon ﬁ on the Sidebar and select a project from the Project List view, then

click the Current Project icon . .

\ J

2. Browse to the folder, select it, then click Select Folder. During the import process, you might be asked to
define conversion filters for unknown file types.

3. View the statistics about the added files on the Files Report dialog, then click OK.

Open a source file

You can view a source file in its original format.
To open a source file:

1. Inthe Current Project view, select a file from the list, then click Open Source File.
Project Files Project TM Project Terminology Reports Reference Files

BB B [ B B E B B

Add Translate Chain Open Source Close Save Modify Bilingual
Files Folders File Files File Project Project Project Export



2. View the source file when its default application opens.

0 If the default application is not set, choose an application when prompted to do so.

Close a project

When you are finished working on a project, close it before you open another.

You can only have one project open at a time.

e In the Current Project view, click Close Project.

il

Open Create Open Close Add Modify
TXLF Project Project Project Project Project

Conduct a bilingual export

Use Bilingual Export to export the TXLF file with highlighted glossary terms into a .DOC or .DOCX format. This
allows you to edit and spell check the file using Microsoft Word, rather than the internal spell check.

You can also complete a bilingual export or import outside the Project List view using Quick Tools.

Bilingual exports require you to set Bilingual Export Options in Preferences >
General Preferences .

To conduct a bilingual export:



1.

In the Current Project view, select a file, and click Bilingual Export on the Project Files tab.
Project Files Project TM Project Terminology

2 ¢ B B & E B

Review Fis Chain Transchechk Eslngual Segment Changes Finish Finish Al
Files Report Expart Repart

eSOl Project TM  Project Terminology
E [ B B R

Review Review

Review File Chain Transcheck Bilingual Segment Ch:
Files Report Export Report
IHJEdIE Project TM  Project Terminology ?2AX
|:j4 P [““’3‘!’ % E I::¢ IE%)
Review File Chain Transcheck Bilingual Segment Changes Finish Finish All
Files Report Export Report Review Review

Project Files Project TM Project Terminology Reporis Reference Files

B E B b B BE E B B 8§ E

Add Translale Chain Open Source Close Save Modify

Sav Bilingual Analyze Tranzcheck
Files Folders File Files File

Project Project Project Export Report

0 You cannot select files that are already open for bilingual export in TXLF Editor view.

There are two entities that result from this action: a session log and the actual report. The bilingual exported

report is downloaded to your default download folder. For any glossary terms, the exported report contains
highlighted source and target terms with related comments.

Select the destination folder for the exported documents, then click Select Folder.

The session log is displayed. This log and the exported bilingual Word documents are saved in the selected
folder.
Log session start time Thu Sep 22 09:40:58 MDT 2021

Mumber of TXLF files exported successfully: 1
Mumber of TXLF files exported with warnings 0

Mumber of TXLF file exports failed: 0

INFO ToReviewhlultiTxlf v1.17.0

INFO Bilingual Review Export

INFO Processing Ch\Users'\Downloads\215 Batchi1 TR dem.. .QBRG-En-Frls_fr-CA-Training_ Excel-fr-CAZTHE XE#F xlsc bf
INFO 145 tus written.




3. (Optional) Open the bilingual export report and review the results.

OFRT:Glo

OFRT:Glo

OmRT:Glo

OmRT:Glo

OmRT:Glo

From: Glossary
Sowrce: submission
Target: soumission
Glossary: TMGR

<FID»221f3lba—6074-4648-b856-835aeb6eB8564</FID> QRG-En—FrCa fr-CA-Training Exzcel-fr-
CRETR_XE¥ xlsx.txzlf
ID Source (en) Target (fir-ca) Score
1 Sheet] -
2 T30 Ezzentialz Fudiments de TS0 100%%
3 Cuick Reference Guide for TransStudio Guide de référence rapide pour 9%
Online TransStudio Online 3
4 Introduction Introduction 100%%
3 This document| provides users with Ce document| présente aux utilisatenrs les 100%
essential tasks associated with taches essentielles associées a TransStudio
TranzStudio Online (TS0 and assumes Online (TS0 et suppoze que vous
vou are already familiar with the interface | connaizsez d&)a I'interface ef les fonctions
and basic software finctions. de base du logiciel.
g Use the online help| for more details. Utilisez 1'aide en ligne| pour obtenir plus de 100%
détails.
7 Claim a Submiszion Demander une soumission 100%
8 Before you can access and u‘c_&r]c onyour [ Avant de pouveir zccéder a vos fichiers| et 100%
ﬁlﬂEL you must log in to Project les fraiter, vous deves vous connecter a
Darector| (PD) and use the FD Project Director| (FDY) et utiliser le tablean
das]l]ma:d|. de bord| de PD.

Analyze project files

Project analysis compares source files to a connected translation memory (TM) to leverage reusable content. Use

the Analyze action to assess files prior to translation or to pretranslate files.

To analyze project files:

1.

In the Current Project view, click Analyze on the Project Files tab.

Project Files

E
Add

Files

Project Terminology

Reports Reference Files

E 2 P B E E B B &
Add Translate Chain Open Source Close Save Modify Bilingual Analyze
Folders File Files File Projec Projec Project Export

OFRT-Glo
OFRT-Glo
OFRT-Glo
OFRT-Glo
OFRT-Glo
OFRT:Glo
OFRT:Glo

Transcheck
Report



2. On the Project Analyze dialog, select the language pairs and files for analysis.

Verify that the TXLF file you want to analyze is not open in TXLF Editor. You cannot
analyze an open file.

Project Analyze x
Project Files (1) Analysis Options
| Project Languages/Files Word Count | Pretranslate | 100 % | % matches and |Copy all tags on segments when t ~
v = EN -> DE DE Use primary MT on ng match segments
v = [l AdaptiveTranscheck.doox.bdf 532 Calculate analysis report percentage by: Words -

-

¥ | o matches

W Calculate internal fuzzy matches | 75
M| Include internal fuzzy matches with TM matches
Lock segments with 100% matches from being edited
Do not allow segments to be mernged
Do not allow sources to be edited
Ignare translated segments in from report
Ignore translated exact segments from report

Report Settings

*) Show only analysis report summary

Export Report

Translation Memory (2 )

./ | TM Name Location
~ <% EN-> DE DE S
™ ! German_DE C:\Users\Documents\So...
A AdantivaTranerhark o O\l lears\Ninrnmants) o h
Analyze Cancel
3. Select options below the Analysis Options heading.
Option Action
Pretranslate Select to create translated TXLF files, based on Pretranslate options.

Selecting Pretranslate is an optional step. The percentage defines the minimum
leverage required to pre-translate a specific segment.

¢ % matches—Select the percentage of matches to pre-translate from the
list.
e Select one of the following actions from the drop-down list:
o Copy all tags on segments when there is no TM match
o Copy segment source to target when there is no TM match
o Do nothing

e Select Use primary MT on no match segments to leverage machine
translation (MT) matches for all segments that do not have a TM match. If
you have TM matches, but do not select the TM before you click Analyze,
the MT overwrites all target segments.




Option Action

Calculate analysis Select an option from the drop-down menu to set the calculation percentage by
report percentage by either words or segments.

Calculate internal fuzzy Select to set the calculation percentage for internal partial matches, then

matches optionally select Include internal fuzzy matches with TM matches.

Lock segments with Select to prevent the edit of 100% matches and the overwrite of the TM with
100% matches from those edits.

being edited

Do not allow segments  Select to prevent the merging of translation units (TUs) during analysis.
to be merged

Do not allow sources to Select to prevent an overwrite of the source segment with new edits.
be edited

Ignore translated Do not consider target segments identified in the Analysis report.
segments from report

Ignore translated exact Do not consider exact match target segments identified in the Analysis report.
segments from report

4. Select the format for the output report below the Report Settings heading.
a) (Optional) Click Show only analysis report summary.

b) (Optional) Click Export Report, then complete the required fields and select a location.
5. Select a TM below the Translation Memory heading.
6. Click Analyze.
7. On the Report File dialog, view the project files analysis.

8. Click OK.

Use a Transcheck Report to verify target segments and identify a variety of common errors within segments in the
translated files.

If you have specific terms you want Transcheck to ignore, you can mark those
= segments for exclusion in the Transcheck Report using the Transcheck All action. This
reduces false positives during Transcheck error detection.

To run a Transcheck Report:



1.

In the Current Project view, click Transcheck Report on the Project Files tab.

Project Files Project TM Project Terminology Reports Reference Files

BB B [ B B E B

Translate Chain Open Source Close Save Modify
Files Folders File Files File Project Project Project

Project Filea Project TM Project Terminology

2 R B B B B

Tranzlats Chain Tranachsck Bilingual Segment Changss Comgplsta Complsta
Fil= Filsz Regort Export Raport All

Project Files Project TM Project Terminology

2 [ B H = E B

Review Fia Chain Transcheck Bilingua Segment Changes Finish Finish All
Files Report Export Report Review Rewview

==

Bilingual
Export

-
=il
Analyze

H][ladZI-50 Project TM Project Terminology 2 AR

E [ B B R B

N

Review File Chain  Transcheck Bilingual Segment Changes Finish Finish All
Files Report Export Report Review Review

MG Project TM  Project Terminology
= [# E# E [

Review File Chain  Transcheck Bilingual Segment Changes
Files Report Export Report

|-vnc_

Transcheck
Report



2. On the Project Transcheck dialog, select one or more files.
Project Transcheck

Project Files (1) Transcheck Tests

Configure desired check in Preferences > Transcheck

Project Languages/TFiles Word Count

g EM US -= DE DE Glossary (0) Blocklist (0)

V] Sample2_Sample-en-de-teml-de... 201 Glossary Location
Sample3_Sample-en-de-teml-de... 180 EM US -= DE DE
Sampled_Sample-en-de-tuml-de .. 184

Fun Transcheck Cancel

Project Transcheck p 4

Project Files (1) Transcheck Tests

Project Languages/Files Word Count
Configure desired check in Preferences = Transcheck

3% EN -> DE DE
Blocklist (1)

vl -l sample-File_en-de.docx.txIf 188

~!'| Glossary Location
BiLingual-Table.doc.txIf 1051

vl EN -> DE DE

vl Glossary EN-DE

Run Transcheck Cancel



Project Transcheck

Project Files (1) Transcheck Tests
) ) Configure desired check in Preferences » Transcheck
| Project Languages/Files Word Count
7 %% EN-= DEDE Report Settings
vl “ [ Transcheck.dooc.bdf 532 Reoart Name:"

Report Location:™ CAlzers\Documents\Source Browse...

Glossary (1) Blocklist (1)

| | Glossary Location

v/ =W EN-> DEDE

vl de-DE-TechDoc C:\Users\Documents...
Run Transcheck Cancel

3. To select the Transcheck Tests you want to conduct, click the underlined Preferences > Transcheck path
name in Transcheck Tests. This link opens the Preferences dialog where you can configure the preferred
settings for each Transcheck.

{ )
0 Consistency checks are accessible through the Project Transcheck dialog. Or click

the Preferences icon 0= on the Sidebar, then click Transcheck under Current
Project Preferences.

a. Source Consistency — Use to search for segments with the same target
translation, but with different source segments.

b. Target Consistency — Use to search for segments with same source segments,
but with different target translations.

Select the appropriate check boxes to ignore differences such as case, numbers, tags,
and white space for source and target file consistency checks. Click OK to return to

the Project Transcheck dialog.
\ J

4. Enter the Report Name and browse to select the Report Location folder, or accept the default settings.

5. (Optional) If you want to enable the Glossary or Blocklist checks, select the location of the Glossary or
Blocklist from the list on each tab.



6. Click Run Transcheck.

Il

Report is optimized for Google Chrome, some features might not work well in your current browser.

Project TransCheck Report
Report Summary (1 files)

File Name Errars in file {visible highlights)

PD_en-de.docx. tdf 0

Ignored Terminology Errors:

B = [ =]

Highlight: & Exact Match B Fuzzy Match| B Exact (No Match)| [|Fuzzy (No Match)

| Toggle Global Search Filters | Global search filker is OFF

Project TransCheck Report - Wordfastl - English - German
Report Summary (1 file)

TransCheck ran successfully on 1 file and found 39 errors.

Target Consistency Check ran successfullr with 0 errors.

Source Consistency Check ran successfully with 0 errors.

Fila Mame Total Number of Errors

PD_en-de.docx. bxIf 29
PD_en-de.docx, txlf

Empty Target Check

[=]

Edited Source Check

Capitalization Check 0
FMunedited Fuzzy Check 11
edited Exact Check 3
Espelling Check 16
ElTag Check 5
Elwhitespace Check 4

Repeated Words Check 0

Unedited Fuzzy Check:

G 1-6-1 | ACCESS REAL-TIME DATA ZUGRIFF ALF 75% Target contains a

A Report Summary is saved to the chosen location. Once complete, a Transcheck report finished message
displays with the number of segment errors found, if any.

A Report Summary opens in a new browser tab. Once complete, a Transcheck report finished message
displays with the number of segment errors found, if any.

Generate a segment changes report

A Segment Changes Report provides you with the history of changes to a segment. You can run a Segment
Changes Report on one or more project files.

To generate a segment changes report:



1.

In the Current Project view, select one or more project files from the list on the Project Files tab, then click
Segment Changes Report.

Project Files Project TM Project Terminology Reports Reference Files

BRw B2 [ B B BB B R

Add Translale Chain Open Source Close Save Modify  Analyze Transcheck Segment Changes
Files Folders File Files File Project Project Project Report Report

2 LB B R B R

Review Fia Chain Transcheck Bilingua Segment Changes Finish Finish All
Filez Report Export Report Review Review

IHJladZI-0M Project TM  Project Terminology 2 AR
2 2 B B E 2 B

Review File Chain  Transcheck Bilingual Segment Changes Finish Finish All
Files Report Export Report Review Review

E [ B B E 2B

Translate Chain Transcheck Bilingual Segment Changes Complete Complete
File Files Report Export Report All

-TE Al Project TM Project Terminology
St + [Ev:
Translate  Chain = Transcheck  Bilingus Segment Changes | Complete  Complete
le Files Report Export Report All

The Segment Changes Report button is removed when Hide MT as score is enabled
in the workflow for that specific phase.




2. On the Segment Changes Report dialog, select the languages or files to include in the report.

Segment Changes Report E

Project Files (1) Report Settings

1 | Project Languages/Flles | Word Count Show Columns:

¥~ EEEN->FRCA " Notes

M i TSR_5.12.0_Essentials_QRG.dood.txif 1773 J Comments
~/ Ratings

.| Post Edit Distance

+/ Segment State
~” Enable Diff Highlight

Include "State’ only change segments in report
. Show all segments (includes unmodified)

. Show latest changes in each phase

' #) Filter Phase-name(s): A

() Filter Process-name(s):

Export Cancel



Segment Changes Report x

Project Files (3) Report Settings
A ‘ Project Languages/Flies | Word Count Show Columns:

VM S B ENUS -> FRCA [ Notes

M B QRG-En-Frcaxisx.pif 1571 +/ Comments
M [ Bilingual table_fr-CA.docx.txIf 360 ~ Ratings

M [ Transcheck table_fr-CA.docx.tf 70

|| Post Edit Distance
' Segment State
/| Enable Diff Highlight
|| Include 'State’ only change segments in report
.| Show all segments (includes unmodified)
|| Show latest changes in each phase

|| Open report after export

Copyright © 2024

(®) Filter Phase-name(s): -
() Filter Process-name(s):
Custom report name: |WordfastS_SegmemcnangesRepon_ZOZSOBUBT‘l 527
Report Location=” | Browse...
Export Cancel
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Segment Changes Report

Project Files (1)

Project Languages/Files

EN -> FR CA

TSR 5.12.0 Essentials QRG.do... 1773

Report Settings

~ Word Count | *| Show Columns:

Notes

Comments

Ratings

Post Edit Distance

Segment State
Enable Diff Highlight
Include 'State' only change segments in report
Show all segments (includes unmodified)
Show latest changes in each phase

! Filter Phase-name(s):

! Filter Process-name(s):

3. Select options from the Report Settings panel.

Option

Action

Show Columns

Select the columns you want displayed by clicking the appropriate check boxes.
Comments, ratings, and notes each have their own column. Blank columns
indicate the feature you selected is not available or there is no data related to that
option for the segment.

¢ Notes, Comments, and Ratings—Translators and reviewers each have
their own notes column. Only reviewers can add comments and ratings.

¢ Post Edit Distance—Compares new target content to prior target content
and determines how different they are, down to character additions and
deletions.

e Segment State—Displays the current and previous states of the segment
across linguistic and review phases.

Enable Diff Highlight

Select to compare differences between new target content to prior target content.
Red strike-through highlights indicate deletions and green highlights indicate new
content.

Include 'State’ only
change segments in
report

Select to show segments that have state only modifications in the Target
Revisions table.




Option

Action

Show all segments
(includes unmodified)

Select to download all segments in the Segment Changes Report, regardless of
any change to the target segment.

Show latest changes in
each phase

Select to include the latest content from a specific workflow phase, regardless of
total number of revisions for that phase.

Filter Phase-name(s)

Filter content in the report by a specific workflow phase by selecting that phase
from the drop-down list. You will need to select this option or the next one prior to
export.

Filter Process-name(s)

Filter content in the report by a specific process, such as No Review or Review
from the drop-down list. This option can be inclusive, so you can select several
processes. You will need to select this option or the one previous prior to export.

Include all phases
before selected phase-
name(s)

(Optional) Select this option to include all phases prior to the selected phase
name.

Option

Action

Show Columns

Select the columns you want displayed by clicking the appropriate check boxes.
Comments, ratings, and notes each have their own column. Blank columns
indicate the feature you selected is not available or there is no data related to that
option for the segment.

¢ Notes, Comments, and Ratings—Translators and reviewers each have
their own notes column. Only reviewers can add comments and ratings.

e Post Edit Distance—Compares new target content to prior target content
and determines how different they are, down to character additions and
deletions.

e Segment State—Displays the current and previous states of the segment
across linguistic and review phases.

Enable Diff Highlight

Select to compare differences between new target content to prior target content.
Red strike-through highlights indicate deletions and green highlights indicate new
content.

Include 'State' only
change segments in
report

Select to show segments that have state only modifications in the Target
Revisions table.

Show all segments
(includes unmodified)

Select to download all segments in the Segment Changes Report, regardless of
any change to the target segment.

Show latest changes in
each phase

Select to include the latest content from a specific workflow phase, regardless of
total number of revisions for that phase.

Filter Phase-name(s)

Filter content in the report by a specific workflow phase by selecting that phase
from the drop-down list. You will need to select this option or the next one prior to
export.




Option Action

Filter Process-name(s) Filter content in the report by a specific process, such as No Review or Review
from the drop-down list. This option can be inclusive, so you can select several
processes. You will need to select this option or the one previous prior to export.

Include all phases (Optional) Select this option to include all phases prior to the selected phase
before selected phase- name.
name(s)

Custom Report Name (Optional) Enter a unique name for the report if it requires customization.

Report Location Browse and select the file location for saving the segment changes report.

4. Click Export.

5. On the Segment Changes Summary dialog, verify the names of the files you chose to include, then click OK.

Filename Segments Source segments ch... | Target segments ch...
Wordfastl_Tran... 26 0 0
PD_en-de.doox... 32 0 -
PD_en-de.docx. 32 0 6

OK

Segment Changes Summary

Filename Segmen... Source segme... Target segments c...

Sample-File_en-... 33 3 4

6. Open the Segment Changes Report in a new browser window, then close the browser window when you are
done.

Generate an export notes report

The Notes Report contains all notes added to the bilingual project files. It can be exported to HTML or MS Word.
To generate an Export Notes Report:

1. In the Current Project view, click Export Notes Report on the Project Files tab.
Project Files Project TM Project Terminology Reports Reference Files

BwE B [ B & B B B

Translale Chain Open Source Analyze Transcheck Segment Changes Export Motes
Files Folders File Files File Report Report Report



2. On the Export Notes Report dialog, select one or more project language files.

Export Notes Report x

Project Files {4 ) Report Settings
A | Project Languapes/Files | Word Count Export notes as:
i = EN-> DE Wiard
= i~ [ Po_en-de.docutdf 175 ® Himl
1% . FO_en-ded. dooctedf 14 Report Location:” CAllsers\DeskiopWF_Tesl_reports Browse...
=4 i [ PO_en-dest.doc i 214
% B PO_en-dez dooclbdf_de_notes.doc.bdf 10
Export Cancal

3. Browse and select the Report Location destination, then click Export.

4. On the Export Notes Summary dialog, click OK.

Export Notes Summany
Filename Segments Segments with Notes
Sample_1.dooxl . teml bl f 37 3
sample_3.doocbml. td f 37 1
sample_2.dooxl . teml b 37 0
OK

The notes report saves to the specified location.

Clean up a project

After you have translated project files, you can clean them and update the translation memory (TM). The Clean
Up action converts the bilingual TXLF files into translated target files with the file format of the source.

To clean up the project and update the TM:

1. In the Current Project view, click Cleanup on the Project Files tab.

Project Files Project TM Project Terminology Reports Reference Files

B ke B [ B &8 B R B R

Translate Chain Open Source | Analyze Transcheck Segment Changes Export Notes ~ Cleanup
Files Folders File Files File Report Report Report




2. On the Project Cleanup dialog, select a language or languages.

Project Cleanup x
e Project Clean Up
Select the options that you would like to use to write translated segments to TM and create translated files
Select languages fo cleanup Translated File Seftings

#*) All Language Pairs

Browse
Create subfolders by language
Add language suffix to the translated file name
Single Language Pair
TM Overwrite Options
Cwerwrite exisfing TU -
Add attribute
Add file name as attribute
Owverwrite private TUs (WFSenver TM only)
Select TM(s) io Update
Bymbolic Name Type Source Target Path
German_DE local en-Us de-DE C:\Users\[zielsdorf\Documents\So...
AdaptiveTranscheck-German local en de-DE C:\Users\lzielsdorf\Documents!So....
Clean Up Cancel
All Language Pairs Click to clean up all language pairs for the project.

Specific Language Pairs Click to clean up only the language pairs you specify from the drop-down list.

Single Language Pair Click to clean up only one language pair you select from the drop-down list.

Specify the location for the translated files from the drop-down list.

(Optional) Select Create subfolders by language.

(Optional) Select Add language suffix to the translated file name.

Select TM Overwrite Options from the drop-down list.

(Optional) Enable Add attribute, then enter that attribute in the attribute field.

(Optional) Enable Add file name as attribute to add the file name to the file attributes.

© ® N o 0 &> ®

(Optional) Enable Overwrite private TUs (WFServer TM only) if you are connected to a Wordfast Server TM
and want to overwrite the private translation units (TU).

10. Select the TM(s) to Update from the table.



11. Click Clean Up.

All the options selected for the Project Cleanup dialog settings are remembered for the current project and will
not apply to other existing projects or new projects.

12. On the Info dialog, click OK.

When the cleaned files are saved at the designated location, a message displays indicating that the cleanup
finished successfully.

Remove a file

Use these steps to remove one or more files from a project.

You can add a removed file back into a current project. Retrieve removed files from
the project folder on your computer using the Add Files action.

To remove a file from a project:

1. Inthe Current Project view, select one or more files, then click Remove File(s) on the Project Files tab.
Project Files Project TM Project Terminology Reports Reference Files

Bwe B 0 B B E F £ & B

Add Translate Chain Segment Changes Export Notes Cleanup  Recalculate Import Export Remaove
Files Folders File Files Report Report Progress Package Package File(s)

2. On the Remove dialog, choose a removal option.

*) Remove from the list only

Remaove from the list and move the following resources to Archive folder

Resources #
TXLF Files 3
Source Files 7
4 3
oK Cancel
Remove from the list only Click to remove the selected files from the file list without moving

them to an Archive folder.

Remove from the list and move the Click to remove the selected files from the file list and to move

following resources to Archive folder them into a local Archive folder. When this option is selected, a
warning displays to alert you that this option physically moves
the files from their current project folder into an Archive folder.



3. Click OK.

The files are removed from the current project.



After completing the initial steps of claiming a submission in Project Director (PD), you can open the file for
translation in PD. This action opens TransStudio Online in a browser window to the TXLF Editor view. After you
complete your translation, save the file and complete the file to return it directly to PD. This updates the translation
memory (TM).

Once the translator has completed the translation, you can review the translated file in the TXLF Editor view.
After completing the review, save the file directly to Project Director (PD). This updates the translation memory
(TM).

Once you have a project set up in Wordfast Pro, you are ready to work with the files. Access the project files
from the Current Project view. When you open a TXLF file, the view switches to the TXLF Editor view. In the
TXLF Editor view, you can translate, review, temporarily combine files by chaining them together, and work with
translation memories and terminology lists.

As you work on a file, frequently save your changes to a local folder.

As you work on a file, frequently save your changes to Project Director (PD).

Saving the file does not complete the translation.

To save a file:

1. Click the File tab, if you are not already on it, and then click the Save File as Translated, Save or Save As
button. Click the File tab, if you are not already on it, and then click the Save or Save All button. From the



Simple View, click the Save button and select an option. From the Advanced View, click the File tab, if you are
not already on it, and then click the Save or Save All button.
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Save File As Translated Select to save the translated file to a local folder.

Save

Save As

Save
Save All
Save All And Exit

Save

Select to save the .TXLF file to a local folder with the existing file name.

Select to save the .TXLF file to a local folder under a different name.

Select to save the .TXLF file to PD.
Select to save all open files to PD.

Select to save all open files to PD and exit TransStudio Review.

Select to save the .TXLF file to PD.



Save All Select to save all open files to PD.
A progress bar is displayed. After successful completion, the file is updated in a local folder.
A progress bar is displayed. After successful completion, the file is updated in Project Director.

2. (Optional) If you need to come back to the file, save it and then click Close to close the active file and the
browser window.

0 Close does not complete the file or move the file to the next workflow phase.

3. (Optional) If you need to come back to the file, save it and then, from the Advanced View, click Close to close
the active file and the browser window.

0 Close does not complete the file or move the file to the next workflow phase.

4. (Optional) Continue with your translation or review. When you have finished, it is time to complete the file.

Chain files

To combine multiple files and view them as a single file, use Chain Files. For example, if you are translating ten
files with ten segments each, you can temporarily chain them into a single file of 100 segments. Chaining files is
particularly useful when working with duplicate or similar content among files.

To combine multiple files and view them as a single file, use Chain Files. For example, if you are reviewing ten
files with ten segments each, you can temporarily chain them into a single file of 100 segments. Chaining files is
particularly useful when working with duplicate or similar content among files.

To combine multiple files and view them as a single file, use Chain Files. For example, if you are translating or
reviewing ten files with ten segments each, you can temporarily chain them into a single file of 100 segments.
Chaining files is particularly useful when working with duplicate or similar content among files.

You cannot export or save chained files as a single TXLF file.

You can open and work on a single chained file or multiple sets of chained files in the
TXLF Editor view. Each chained file displays on its own tab.

To chain files:



1.

In the Current Project view, on the Project Files tab, select a set of files, then click Chain Files.

e Use Shift+Click to select sequential files or Ctri+Click to select individual files.
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The chained file opens in the TXLF Editor.
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o To determine the related file name for a segment, hover over the segment ID.
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*Chained-5ample-Document-2-MSWORD_TXLF-de-DE#TR_VEWM#.doowodi X%

Source or Target Match Case Regex | Enter text to fiter segments... = | Filter:

1D English (United States)
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22 |Its alternate text is "Web Access Symbol".
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2. Click a segment to make it the active segment.

The file name changes from the chained name to the source file name of the active segment.
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QUICK PROCESSING TIME

CUSTOMIZE WORKFLOWS
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GlobalLink Project Director saves millions of dollars
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*Chained-LivePreview.Upload_1-MSWORD_TXLF-de-DE¥TR_VBWO#.dooutxdf 3
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1D English (United States)
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3 |STREAMLINE PROJECT MANAGEMENT
4 |INTEGRATE WITH MANY SYSTEMS

5 |WORK WITH MULTIPLE VENDORS

6 |QUICK PROCESSING TIME

3. From the Review tab in Simple View or the File tab in Advanced View, click Save.

o If you need to review the files again, the chained files will open in the same order you
saved them.

The segments are saved in the chained file and restored to their original files without the chained format. The
progress for each individual file will show on the Progress tab.



4. From the File tab, click Save.

0 If you need to review the files again, the chained files will open in the same order you
saved them.

The segments are saved in the chained file and restored to their original files without the chained format. The
progress for each individual file will show on the Progress tab.

Translate a file

This task begins in Project Director (PD), then after you open the file, a new browser window opens in
TransStudio Online (TSO).

After you open a project in TSO, access project files from the Project Files tab. If the project has numerous files,
you can chain them together into one continuous file. Refer to Chain files on page 71.

For users who interact with Captive TransStudio, the translation process is different.
For more information, review the most recent Captive TransStudio Quick Reference
Guide.

. Save your work often by clicking Save on the File tab or by pressing Ctrl+S.

To translate a file:

1. On the Project Files tab, select a file, then click Translate File or double-click the file name to open it.
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2. Select a target segment and enter the translation. If you have a translation memory (TM) added to the project,
you can leverage translations from it.

*QRG-En-FrCa.xisx *

B

Source or Target b Match Case Regex |Enter text to filter - | Fiter. | Select sp - Q }
|n] ; English (United States) French (Canada) Score Status
3 . . . N 97% oA
TransStudio Online pour TransStudio Online 5
4 Introduction Introduction 100% .
This document provides
users with essential tasks
associated with
TransStudio Online (TSO) |ReELSSIOEIReLIERGIIS)]
° land assumes you are v
already familiar with the
interface and basic
software functions. 9
S
Source or Target - Match Case Regex |Enter text to filter « | Filter: Select sp - Q }
LI English (United States) French (Canada) Score Status
3 . . . N 97% oA
TransStudio Online pour TransStudio Online 5
4 Introduction Introduction 100% .
This document provides
users with essential tasks
associated with
TransStudio Online (TSO) |ERESSIOEReLIERGESIe)]
> and assumes you are of
already familiar with the
interface and basic
software functions. 9

3. Once you are satisfied with the translation, click Next Segment or Alt + Down Arrow. This action updates
the TM and moves to the next target segment. The segment state changes to Translated. Segments that are
changed to Translated are calculated on the Progress Bar at the bottom of the window.

Segments: 24/33 | Segment (Src/TgtMax): 11/28/~ | Paragraph (Src/Tgt/Max): 29238/~ _Ieﬁ}

As you translate, you can also commit the active segment to the TM by selecting
the Next Needs Translation Segment shortcut key (CTRL + Enter), and the active




segment state will change to Translated and then moves to the next segment whose
status is set to Needs Translation.

4. When you have completed your work on the files in TSO, mark them as completed. Refer to Complete a file.

The TSO browser tab closes and a dialog indicates that the files have uploaded successfully.

Translate segments

When you convert a file to a translatable format, all complete sentences become separate segments, often
divided by formatting or punctuation. Segments may be sentences, words, or numbers, depending on the
formatting of the source file. After you save the segment translations, the application commits the segment
translations to the translation memory (TM). Leveraging the TM automatically and consistently reduces the time
and expense of future translations by translating reoccurring words and phrases.

To facilitate rapid use of language-specific quotation marks, punctuation, and white
space, select Enable Smart Quotes in Preferences > General Preferences >
Segment .

You can choose from two layout views for your TXLF Editor workspace.

e Table view — This layout view displays the source segment to the left and the target segment to the right.

e Stacked view — This layout view displays the source segment row directly above the target segmentin a
spanned row.

You can select either layout view by clicking the drop-down list for the Switch Editor Layout action on the File
tab.

0 If there are either split or merged segments, indicated in the Status column with d

or -I"I- all split or merged rows within the spanned row have the same ID column color.
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Translate all segments

The Translate All option completes the translation of all segments by leveraging content in the connected TMs.
To translate a project file using Translate All:
1. In TXLF Editor view, click in a segment.

2. On the Translation Tab, click Translate All.

Fie _Edt__Fomating |RISSRTS
E BEEBERE B B RR B
Copy Copy

Mext Previous Commit Leverage Mark All Until Unfil No Translats
Segment Segment Translated Source All Sources Fuzzy Match All

i o romuny JRISES
B B [ & & 5
Copy  Copy Uil

Until Mo Tranzlats T Commit Concordance achine
Source All Sources Fuzzy Match Al List All Search Translaticn

Translatiun Terminology Review
E B B R E: Ea B B B B[R

Next Previous ~ Commit  Leverage Mark All 7 Copy ¥ Do Not Write Lock/Unlock ~  Clear T Copy Until UntilNo | Translate
Segment  Segment Translated Source ToT™M Segment Target All Sources Fuzzy Match All

This action leverages content in the connected TM and populates the target segments with translations. When
this process is complete, the screen refreshes and displays the results in the target column. The segment
states are all changed to Translated. The progress bar at the bottom of the user interface indicates the
percentage of translation complete.

EM — DE | Segments: 2/2 | Segment (Src/TgtMax): WA | Paragraph (Src/TgtiMax): NA

View segment history

In TXLF Editor, view the record of segment changes to the open file on the Segment History tab of the Editor
pane. Changes to segments include segment updates, and lock actions.
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Committothe TM

Once you have finished translating some or all of the file segments, update the translation memory (TM) with your

translation. This requires committing some or all of the translated target segments to the TM.

To update the translation memory:



1. Inthe TXLF Editor view, choose one of the following:

e To commit a single segment to the TM, select a segment, then select Commit on the Translation tab.

e To commit all segments in the file to the TM, select Commit All on the Translation tab.

el Fomatng [RIRS
E & B B B B & & g &

Mext Previous Commit Leverage Mark All Copy Commit Concordance Machine Analyze
Segment Segment Translated Source All Search Translation
File Edit Formatting Tranzlstion [ERELOTNT Y Review Simple Vi ? A

@@DEDIDE&@;?&:%

et Previous Commit Laverags Mark All - Do Mot Writs an:lu'UnIoc:k Clear Copy T Gommit
Segment Segment Signed Odff Saun}a TaTM Sagment Tangst All Sources List Al
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2. (Optional) Verify that the updates you committed to the TM have a purple highlight.

The highlighted color can be selected in the General Preferences from the Colors
option by selecting the listed Committed into TM item.

1[]

3. (Optional) If you are updating the TM for the current segment only, continue your work and repeat as often as

necessary until you have committed all translated segments to the TM.

Copy source content

To copy source content to the target:
1. Inthe TXLF Editor view, select a source segment.

2. To copy the source content, choose one of the following:

e On the Translation tab, select Copy Source.

e As a shortcut, press Alt+S to copy the source content.



3. Select a copy action from the resultin

File Edit Formatting Translation
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g drop-down menu.
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Copy
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Option Action
Copy Source Select to copy from source all content and tags to the target.
Copy Source Text Select to copy only content from source to the target.

Copy Source and Term
Translations

Select to copy from source to target all content text and translated
concordance glossary terms.

Option Action
Copy Source Select to copy from source all content and tags to the target.
Copy Source Text Select to copy only content from source to the target.

Copy Source, Tags and Term
Translations

Select to copy from source to target all content text, its tags, and
translated concordance glossary terms.

Copy Source and Term
Translations

Select to copy from source to target all content text and translated
concordance glossary terms.

Copy Source, Tags, Source and
Target Terms

Select to copy from source to target all content text, its tags, and both
source and translated concordance glossary terms.

Copy Source with Source and
Target Terms

Select to copy all source and translated concordance glossary terms to
the target.

The specified source content is copied to the selected target.



Copy all source segments

To copy all source segments to all target segments:

1. Inthe TXLF Editor view, on the Translation tab, click Copy All Sources.
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All source segments are copied to all segments in the target column.

2. (Optional) Begin translation in the target column.

Split or merge a segment

You can split or merge an existing segment to change segmentation. This is particularly useful for certain file
types or for languages where the next segment content may need to precede the previous segment. The best
time to split or merge a segment is early in the translation process.

To split or merge a segment:

1. In the TXLF Editor view, select the segment to split or merge.



2. On the Translation tab, select Merge or Spilit.
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The segment is merged or split and the segment Status column contains either the Merge icon ﬁ or

the Split icon d. respectively. If the merge includes an entire paragraph, this is denoted with the Merge

Paragraph icon .

ID English (United States) -> French (Canada) Score Status
TSO Essentials [ Quick Reference Guide for 7n
TransStudio Onling

2 o

Rudiments de TSO EfGuide de référence rapide
pour TransStudio Online

Introduction
Introduction

This document provides users with essential tasks r
associated with TransStudio Online (TSO)

|Ce document présente aux utilisateurs les tdches

Lock a segment

You can lock a segment to prevent any further changes to that segment. The best time to lock a segment is when
the translation is complete and the reviewer has confirmed the content after proofreading it. The Commit action
still updates the translation memory (TM) with the target segment content.

To lock a segment:



1. Optionally, in the TXLF Editor view, use the table filter to filter out all unwanted segments.

2. In the TXLF Editor view, select the segment to lock.

3. On the Translation tab, select the Lock/Unlock Segment drop-down and select one of the two options:

e Lock/Unlock Segment locks or unlocks a single selected segment.

e Lock/Unlock All Segments locks or unlocks all segments. If the table filter was used to filter segments,
only the filtered segments are locked or unlocked. When Lock/Unlock All Segments is selected,

a warning dialog is displayed warning that all segments will be locked or unlocked; select Yes to
continue.

&

Lock/Unlock
Segment

Lock/Unlock Segment
|E" LockiUnlockAll Segments

The lock icon ﬂ is displayed in the segment Status column to indicate the segment or segments are locked.

Clear target segments

To clear target segments:

1. Inthe TXLF Editor view, select a target segment.



2. On the Translation tab, select Clear Target.
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3. From the drop-down menu, select one of the following options:

e To clear the selected target segment, select Clear Target.

e To clear all target segments, select Clear All Targets.
4. From the drop-down menu, select Clear Target.
5. Onthe Clear Current Segment Target dialog, select Yes to agree to the target content removal.

The target content is removed.

Do not write To TM

Translators or reviewers can use the Do Not Write To TM action to prevent a segment from being added to the
translation memory (TM).

To prevent a segment from being added to the TM:

1. Inthe TXLF Editor view, place your cursor in a translation segment..



2. On the Translation tab, select Do Not Write To TM, or press Alt + Enter.
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The TM is not updated with the target segment content.

The ch' icon is displayed in the segment Status column.

3. (Optional) To later remove the restriction so the segment can be added to the TM, select Do Not Write To TM
again.

Find and replace content

Use Find/Replace to search for and replace text in translated content.
To find and replace content in a file:

1. Inthe TXLF Editor view, click the Edit tab.



2. Click Find/Replace.
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3. On the Find/Replace dialog, click in the Find what field, then enter your search text or select it from the drop-

down list.

Find/Replace x

Q
Find what: |Iran5lati0n - |
A Y
A Reading Highlight ~  Find Next Close
Direction Options
Backward /| Ignore Case /| Search Source
*/ Forward Whole Words Only  + Search Target
Ignore NBSP /| Search Open Files
Use Regex

Find/Replace

(o]
Find what: translation
A Y
A Reading Highlight
Direction Options
' Backward " Ignore Case
*' Forward

Ignore NBSP

Use Regex

v Find Next Close

~" Search Source

Whole Words Only ~ Search Target

/| Search Open Files



4. (Optional) Click the Expand icon ¥ to expand the panel for additional options, or click the Collapse icon # to
collapse the additional options.

Search text can include regular expressions (Regex), wild card characters, and non-
breaking spaces.

5. Click Find Next to move through all instances of the content.

6. (Optional) Click Reading Highlight and select the Highlight All action from the drop-down list to highlight all
instances of the content in all open files. Click Clear Highlighting to remove the highlighting from the previous
search.

Find/Replace x

Q
Find what: translation -
A
A Find Next Close
Direction ! Highlight Al I
Backward N | Search Source
*/ Forward Whole Words Only ~ + Search Target
Ignore NBSP /| Search Open Files
Use Regex

Find/Replace
o]
Find what: ‘ translation v
A
A Reading Highlight ~ Find Next Close
Direction Highlight All
' Backward ' Search Source
*' Forward Whole Words Only~ Search Target
Ignore NBSP /' Search Open Files
Use Regex

(Optional) You can filter table segments using the Segments with find/replace highlight all table filter to see
all segments containing text highlighted by Highlight All.

7. (Optional) To replace regular expressions, wild card characters, or words, click the Replace icon ™.. For
additional options, click the down arrow on the sidebar.



8. Click in the Replace with field and enter the replacement text.

Find/Replace X

Q Find Next: [Fansiaton - |

Replace with: d
A Replace Replace Al Find Next Close
Direction Options
Backward /| Ignore Case /| Search Source
* Forward Whole Words Only  +/ Search Target
lgnore NBSP +/| Search Open Files
Use Regex
Find/Replace X
Q FindNex: | RN - |
! Replace with: -
A Replace Replace All Find Next Close
Direction Options
' Backward " Ignore Case /| Search Source
*' Forward Whole Words Only~7 Search Target
Ignore NBSP /' Search Open Files
Use Regex

9. (Optional) Select the direction of the search and any other options.

-
You cannot use the Whole Words Only search option when entering multiple words
or punctuation in either search field.

\

-

0 Select Use Regex to search on regular expressions or wild card characters.

\.

10. (Optional) Click one of the following actions: Replace, Replace All, Find Next, or Close.

The content you found has been replaced with the new content.

Edit or revert source segments

Use Edit Source or Revert Source to edit or revert content in the Source column.

Depending on configuration settings, these buttons may not be present.



When the cursor is not on the source nor on the target segment then the Edit Source
and Revert Source buttons are disabled.

To edit content in the source segments:
1. Inthe TXLF Editor view, place your cursor onto the source segment you want to edit.

2. Select the Edit tab and then select Edit Source.
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3. Make edits to the source segment.

]
Editing the source adds the Edit Source status icon f to the Status column.

4. (Optional) To revert changes to the source segment, select Revert Source.

4 ™
The Revert Source button is disabled when a source segment does not contain any
edited content.

Selecting Revert Source keeps the Edit Source status icon for the edited source and
also retains segment history of the source.

Spell check a file

You can use a spellchecker to verify translated content aligns with configured spell checking preferences. Refer to
Configure and enable spellchecker on page 291. You must verify that your Hunspell spelling dictionaries have
the latest updates. Refer to Licensure on page 10.

To spell check a file:



1. On the Review tab, click Spellcheck File.
=
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2. On the Spelling dialog, review the suggestions and select one of the options.

W Uses this pagse to check spslling.

Mot in Dictionary:

DICHTUNGSLOSE DATENBANKINTERGRATION Ignore Once

Ignore All

Add to Dictionary

Suggestions:
DATENBANKINTEGRATION Change
EINWAMNDERERGENERATION Change All
Preferences Cancel
Item Action
Ignore Once Click to disregard the suggested change for a word only once.
Ignore All Click to disregard the suggested change for all occurrences of a word in the file.

Add to Dictionary Click to add word to personal dictionary.

Change Click to accept the suggested change for a word.

Change All Click to accept the suggested change for all occurrences of a word in the file.

o If spell checking is not available for the target language, a warning message notifies
you. Click OK.

3. To view spell checking preferences, click Preferences or click Cancel to reject any changes.

4. Close the Spelling dialog.



Apply formatting

To apply formatting to the target:

1. Select text you want formatted in the target.

2. On the Formatting tab, select a formatting option or use the equivalent shortcut.

-

= s +q7 1T+ &
Formatiing Non-Formatting Hon-Breaking Left To Right Fight To Left Aftach /
Tag Mode Space Marker Marker Datach

B I U

Bold Italic Undeline
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Subscripl Supearscripl Strikethrough
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B I U Xa x? AP = — &l 1 &
Beld  Italic  Underline  Subscript  Superscript  Strikethrough  Formatting  Non-Formatting  Non-Breaking  Left To Right  Right Toleft  Attach/
Tag Mode Tag Mode Space Marker Marker Detach
Button Keyboard Shortcut Description
B Ctri+B Format the selected text as bold.
Bold
I Ctri+l Format the selected text as italic.
Italic
U Ctri+U Format the selected text as underlined.
Underline
X Ctrl+= Format the selected text as subscript.
Subscript
x1 Ctrl+Shift+= Format the selected text as superscript.
Superscript
ABC Ctrl+K Format the selected text to display as strikethrough
Sirike (deleted), without actually deleting the text.
= No shortcut Display actual formatting associated with tags for the
Tag active segment (when supported.)
Formatting
- No shortcut Display the content of the formatting tags for the
Tag active segment.
MNen-Formatting
— Ctrl+Shift+Space Insert a non-breaking space at the cursor location.
MNon-Breaking
Space
vq[ No shortcut Insert a marker to indicate left-to-right reading
Left To Right direction.

Marker




Button Keyboard Shortcut Description

LIE No shortcut Insert a marker to indicate right-to-left reading
Right To Left direction.
Marker
& No shortcutCtrl+D Attach and detach the Formatting toolbar. When
Attach | attached, the toolbar is displayed as a tab. When
Detach detached, the toolbar is displayed as a minimized
toolbar that can be moved to any area of the TXLF
Editor.

3. (Optional) Select Non-formatting Tag Mode to show formatting tags or Formatting Tag Mode to hide
formatting tags.

Leverage auto-propagation

The purpose of auto-propagation is to apply translations to duplicate segments and re-use content. Configure and
enable your auto-propagation preferences under Preferences > General Preferences > Auto-Propagation.

To leverage repetitive content:

1. Select a segment for translation in the TXLF Editor. In this example, a filtered search locates and identifies
duplicate segments.

Source or Target o Match Case Regex |Enter text lo filer segme ~ | Filter: | Duplicale segmenls - je) ,Ca' ¥ Ssor '_g

D English (United States) -> French (Canada) Score Status
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To modify how you receive PD notifications about your submission files,

refer to PD online help.
29 — - - 100+%
Pour modifier la fagon dont vous recevez des nofifications de PD
concernant vos fichiers de soumission, consultez l'aide en ligne de PD.
To modify how you receive PD notifications about your submission files,
30 refer to PD online help. 100+%

Pour modifier la fagon dont vous recevez des nofifications de PD .

S

2. Enter the translation for the first target segment.



3. To auto-propagate duplicate segments, choose one of the following actions:

o Click Next Segment or press Alt+Down to update the TM, move down one segment, and leverage the
next segment from the TM.

e Click Commit or Commit All to commit one or all of the segments to the TM.

Once you commit the target segment, this action automatically propagates the TM updates to duplicate
segments throughout the file, based on segment preferences.
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[14] English (United States) -> French (Canada) Score Status
Before working on a submission file, you must claim it.

28 100+%
Avant de travailler sur un fichier de soumission, vous devez le

demander.
To modify how you receive PD notifications about your submission files,

. refer to PD online help.
100+%
Pour modifier la fagon dont vous recevez des notifications de PD '
concernant vos fichiers de soumission, consultez 'aide en ligne de PD.

To modify how you receive PD notifications about your submission files,
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Pour modifier la fagon dont vous recevez des nofifications de PD =
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Leverage auto-suggestion

You can use auto-suggestion to propose target content based on specific source content, such as numbers,
URLs, and proper names. You can also use auto-suggestion to propose terms for the glossary, machine
translation (MT), translation memory (TM) matches, and sub-segment TM matches. Configure and enable your
autosuggestion preferences under Preferences > General Preferences > Auto-Suggestion .

Monitor maximum segment length

Based on Project Director (PD) settings, your files may have a set maximum segment length. Any violation of
a segment that exceeds the maximum characters allowed results in a change to the segment Max value in the
progress bar from black to red and is indicated by a flashing red box appearing around this value.

Users can monitor the progress bar for maximum segment length violations, and can also configure the
Transcheck Report to flag such violations.

Recalculate the progress of a file

Use Recalculate Progress to calculate and update the progress of translated files and word count, especially
files created or edited in legacy versions. When you open a legacy file, the progress bar contains the N/A flag to
denote that it will not calculate progress.



0 Refer to Chain files on page 71 to recalculate progress of multiple files.

To recalculate the progress of a file:

1. On the File tab, click Recalculate Progress.
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2. Review the progress bar for current file status.

The progress bar is updated to display the % Complete status of the file.

Get an MS Word table

You can preview and save the file you have open for translation as a bilingual table in MS Word format.
To get an MS Word table:

1. Inthe TXLF Editor view, select a file with translated content.

2. (Optionally) In the TXLF Editor view, use the table filter to filter out any unwanted segments.

3. On the File tab, select Get MS Word Table.
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4. On the Get MS Word Table dialog, select Get MS Word Table.

You can configure MS Word Table settings by clicking the hyperlink to the
Preferences location. If you want to disable the dialog, select Don’t show this




dialog anymore. If you need to re-enable the warning dialog, select Show dialog to
configure MS Word Table Preferences from General Preferences > Warnings.

Get MS Word Table x

Configure M3 Word Table in: Preferences > General > Get MS Word Table Options

Don't show this dialog anymore

Get MS Word Table Cancel

Get MS Word Table

Configure MS Word Table in: Preferences = General > MS Word Tabl
Options

Don't show this dialog anymore

Get MS Word Table Cancel

Get MS Word Table B

Caonfigure MS Word Table in: Preferences > General > Get MS Word Table Options

Don't show this dialog anymore

Get MS Word Table Cancel




5. If the segments were filtered, an Export Segments To MS Table dialog will appear. Select Continue to export
only the filtered segments to the MS Word table.

Selecting Cancel will export all the segments to the MS Word table document
regardless of any segment filter applied.

Export Segments To MS Table

Filtered segments will be exported! Click Continue to
get filtered result or Cancel to get entire document?

Continue Cancel

Export Segments To MS Table [x]

Filtered segments will be exported! Click Continue to get filtered
o result or Cancel to get entire document?

Continue Cancel

The file downloads as a Microsoft Word document containing a bilingual table of source and target segments.
The target locale code is added to the file name for the generated word document.
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6. (Optional) Review the resulting file for completeness.

Preview a file

Use Preview to display the source content in its original format, such as MS Office, HTML, and Markdown source
formats.

To preview files:
1. Open a file in the TXLF Editor view.

2. On the File tab, click Preview, then select a preview type on the drop-down list.
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The preview of the source content is displayed in its original format.

Use Live preview

Using Live Preview you can generate a dynamic preview of a translated file in its original format for the following
file types:



e MS Word .DOC and .DOCX files

e MS Word .DOCX files, converted from PDFs
e MS PowerPoint .PPT and .PPTX files

e Markdown .MD files

e JSON .JSON files

e MS Excel .XLS and .XLSX files

0 Preview is disabled for multilingual target Excel files.

Live Preview is enabled by default in the TXLF Editor view. To enable or disable automatic opening of Live
Preview, go to General Preferences > General, and select or deselect Automatically open Live Preview for
supported files.

If, when opening a live preview, the live preview action hasn't finished after a configurable time, that file is marked

as forbidden for live preview. No one will be able to initiate a live preview for the file with that name anymore.

To collapse or expand the live preview pane, click the Collapse icon or the Expand icon located on
the top-right of the TXLF Editor view.

To zoom in or out of the live preview pane, select a percentage in the zoom drop-down list | 190%
To generate a Live Preview:

1. Open afile in the TXLF Editor view.



On the File tab, select Live Preview from the Preview drop-down menu.

0 Only one preview option is possible at a time.
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(Optional) Interact with the Live Preview of the file.

For MS Word files
The live preview pane docks to the right. For docking options, click the live preview panel's Settings icon:

m. Live Preview highlights the active segment. Move to any other segment by clicking on that area of
the Live Preview.
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Excel documents display spreadsheets. Multiple sheets appear at the bottom of the live preview pane.
The live preview pane docks to the right. For docking options, click the live preview panel's Settings icon:

m. Live Preview highlights the active segment. Move to any other segment by clicking on that area of

the Live Preview.
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For MS PowerPoint files

PowerPoint files can be graphically intensive and may take time to load. The progress bar provides real-time

loading status. Select the View All Slides box to load the entire document. Click the cancel icon X to cancel

the Live Preview.

Docking—The live preview pane docks to the right. For docking options, click the live preview panel's

Settings icon: m Live Preview highlights the active segment. Move to any other segment by

clicking that area of the Live Preview.

Slide Access—Click the forward or back arrow to progress through the slide deck or type the deck

slide number in the Slide field. While in the editor, move back to the slide that correlates to the open

segment by clicking the Target icon: m
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The live preview pane docks to the right. For docking options, click the live preview panel's Settings icon:

m. Live Preview highlights the active segment. Move to any other segment by clicking on that area of
the Live Preview.



File Edit Formatting Translation Terminology Raview ? A

B R F BB B DB

Closa Close Al Recalculate Save Save All Switch Editar Complate

: P Heading level 1
S

X

Source or Targel - Match Case Regex |Enterlexito ~ | Filer | Sele §
ID | English (United States) French (Canada) Score  Status

1 |Heading level 1 + - Heading level 2
2 |Heading level 2 & |
3 |Headlng level 3 D |«
4 |Heading level 4 9 «  Headinglevel 3
5 |Heading level 5 |
6 |Heading level 6 £ |
7 |Heading level 1 9|y  Headingleveld
8 |Headlng level 2 9|
9 |Heading 1D Y] | ptigtees
10 | really like using v

Markdown, -

File Edit Formatting Translation Terminology Reuiew_ 100% -
B EE E3

Add Note Edit Note Delete Note Transcheck Transcheck
Segment All

Heading level 1

*UltimateMarkdownTestFile v2.md X

L

Source or Target - Match Case Regex Enter taxt ~  Filter; }

ID English (United St Czech (Czech Rep Score Commer Status

Heading-level- Nadpis-urovné- =
1 1 v '
Heading-level- Nadpis-urovné- . - Headmg level 2

File Edit Formatting Translation Terminology Reuiew 100% -
i Z BE|

Add Note Edit Note Delete Note Comments & Transcheck
Ratings Segment

Heading level 1

Fa

*UltimateMarkdownTestFile v2.md X

Source or Target - Match Case Regex Enter taxt ~  Filter: }
ID English (United 5t Czech (Czech Rep Score Commer Status
Heading-level- Nadpis-urovné- -

1 1 v '
Heading-level- Nadpis-urovné- - Headmg level 2




P ot omatng Taton _Temooory v _avein o -

S B B B R B £

Closa Close All Recalkculate Save Save All Switch Edifor - Compleie

. Headinglevel 1
Source or Targel = | [ImakhCase | | Regex |Entes text tc v | Fier )
ID | ? English (United States)  German (Germany) | Score Status :
1 Heading level 1 A= Heading level 2
2 Heading level 2 = o
3 | Heading level 3 . |
4 Heading level 4 - o Heading level 3
5 - -Heading level 5 < - .g?-
T -Heading level 6 - _ & @a-
| 7 | Heading level 1 | : 9l ) Heading lovel 4

For JSON files
The live preview pane docks to the right. For docking options, click the live preview panel's Settings icon:

m. Live Preview highlights the active segment. Move to any other segment by clicking on that area of
the Live Preview.
For JSON files, Live Preview shows the translatable text in bold and at a larger font size.
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(Optional) Enter the translation or leverage the TM for any segment.

(Optional) On the Translation tab, click Next Segment or press Alt+Down Arrow to update the TM, move
down one segment, and leverage the next segment from the TM.

The new translation is displayed.

(Optional) Click Sync Preview to refresh the preview.



Use Office preview

The Office Preview option allows you to generate a static preview of MS Office documents using the target
segments in your translation.

0 If the MS Office file type you select can be opened in a Live Preview, this option is
shown, if not you see only the Office Preview option.

To generate an Office Preview:
1. Open afile in the TXLF Editor view.

2. On the File tab, select Office Preview from the Preview drop-down menu.

Edit Formatting Translation Terminology Review
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3. (Optional) Interact with the newly opened Office Preview window. If you make changes to the target segments
and wish to view those changes, just select Office Preview again and a new preview is generated.

Use HTML preview
If you are working with an HTML submission, the translated document can be viewed using the HTML Preview.

To generate the HTML Preview:

1. Open an HTML file in the TXLF Editor view.



2. On the File tab, select HTML Preview from the Preview drop-down menu.
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3. A new window opens and displays target content in context. To view new changes to target segments in
a translated view, select HTML Preview again and a new window with the updated translated document
generates.



Translation memory (TM) acts as a database to provide maximum re-use of previously translated content. It also
serves to facilitate collaboration between globally distributed localization resources.

Projects connected to a translation memory (TM) leverage content matches against an existing TM. TM matches
generally fall into three categories: 100% match, fuzzy repetitions, or no match. Your organization may choose to
alter or add more fuzzy repetition categories. The typical fuzzy repetition values are for 95% to 75% matches. The
segment highlight identifies the type of TM match.

Color Code Category
Green Indicates a 100% match.
Green, Dark Indicates a context match. A context match for a segment must meet one of the
following criteria:
e The segment has a correct checksum or attribute match.
e The previous and next segments also have a 100% match.
e The 100% matched segment is a single paragraph.
Grey Indicates there is no TM match.
Pink Indicates a modified segment.

Orange, Light

Indicates the segment was a machine translation (MT) instead of a human translation.

Purple Indicates an update to the TM for a modified segment.

Purple, Light Indicates the update to the TM of a translated and committed segment automatically
updates other repetitive segments within the translation.

Yellow Indicates a fuzzy match.

Dark Grey

Indicates a 100% match to a client-installed TM.



Color Code Category

Leveraging a segment involves selecting the best possible translation from the connected translation memories
(TMs) or machine translation engines to populate target segments.

To leverage a TM:

1. In the TXLF Editor view, select the segments to leverage against the current TM.

2. On the Translation tab, select an action to leverage the current TM.

Leverage Select to leverage a single segment.
Until Fuzzy Select to leverage segment content until reaching a fuzzy match.
Until No Match Select to leverage segment content until there is no match.

Translate All Select to leverage all content in all segments.

A translation memory (TM) lookup or concordance search looks for specific source segment text in a translation
memory. To view search results for both source and target segments, use the TM Lookup tab in the Editor pane.

To conduct a TM lookup or concordance search:



1. Search for a word or phrase by entering it in the TM Lookup field. Then, to conduct a search of both source
and target, press Enter. Instances of the search term are highlighted in the Editor pane, along with its bilingual
equivalents. To conduct a more specific search, click Find Source or Find Target.

s

0 You can also select a word or phrase in the segment in the TXLF Editor view and
then click Concordance Search from the Translation tab, or press F8.

o Instances of the search term are highlighted in the Editor pane, along with its bilingual
equivalents. To conduct a more specific search, click Find Source or Find Target.

0 You can reorder the columns of the TM Lookup results. That reorganization remains,
even after you exit the software.
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2. (Optional) To refine the search, select More Options and select a check box from the drop-down list.

Option Action

Match Case Select to filter by upper and lower case.

Exact Select to filter for only those terms organized in the same sequential order.
Automatic Leverage Select to automatically update target content when moving to a new segment.
Diff Highlight Select to highlight the difference between the submitted segment and the TM

source segment.

Include Private TU (GLTMS) Select to include private segments or translation units (TUs) when searching
a remote GlobalLink TM Server TM.

The refined search results for the word or phrase you selected are listed on the TM Lookup tab of the Editor
pane. You can use the results of your search in the related target segments.

View TM leverage results



Leveraging the translation memory (TM) occurs automatically as you move through the target segments. This
provides you with the best possible segment matches from the TM and is the only search that uses scoring to

select the best match.

To view TM leverage results:



1. Inthe TXLF Editor view, click on a source or target segment.

This populates the columns on the TM Lookup tab of the Editor pane and provides a score, based on TM
leverage results.

TM Lookup Notes Segment History Metadata Transcheck (0)
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UNTERNEHMEN €@ 14:42:09
MST
3 ENTERPRISE - BERICHTERSTELLUNG FUR 99%* |German_DE 2018/02/19|(®
ENTERPRlSE_REPO UNTERNEHMEN 13:44:09
RTING @ MST
©® ©®EN- DEDE | Segments: 0/34 | Segment (Src/Tgt/Max): 20/33/- | Paragraph (Src/Tgt/Max): 20/33/- 0% Reviewed
TM Lookup Notes Review History Metadata Transcheck (0)
| - | More Options =  Find Source Find Target Clear
# | Source Target Score TM Name Last Modified Custom Attribute
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2 ®
plified Aufwand
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MST
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2. Review TM leverage results in each TM Lookup column for that segment.
Item Behavior
Source Displays source segments provided by the TM. Any difference between the submitted

segment and the TM source segment is highlighted.

Target Displays target segments already in the TM.

Score Displays a TM leverage score.

e Percent (%) — 100% and fuzzy matches
e Plus (+) — Context matches
e Asterisk (*) — Secondary TM match
¢ Red outline — TM has assessed a penalty to the segment
e Align —TM Aligner tool was used to leverage the segment
¢ Client — Client content was used to leverage the target segment
Refer to Translation memory on page 109 for more information on TM color codes.

TM Name Identifies the name of the leveraged TM. If you are leveraging multiple TMs, it lists the
TMs in order of priority: primary, then secondary TMs.

Creation Date Identifies the TM segment creation date.
Creation User Identifies the username of the segment creator.
Last Modified Identifies the date of the last segment modification.

Modification User Identifies the user who last modified the segment.

Custom Attribute  Identifies any segment custom attribute name and its associated values

Actions Acts as a button to access score breakdown information, including penalties.

®




3. (Optional) To constrain the columns within the pane, click on any column head, then deselect the names of the

columns you want to hide.
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Leverage machine translations

The machine translation (MT) feature can automatically populate target segments whenever you open a file
or when there are no translation memory (TM) segment matches. Select a project for your MT and configure
Machine Translation options under Preferences > General Preferences .

To leverage MT:

1. In TXLF Editor view, on the Translation tab, click Machine Translation to submit the source segment for MT
and populate the target segment with the results.
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2. (Optional) Verify that the quality of the translation for the source segments aligns with your requirements.
The target segments are populated with the MT for the source segments.

3. (Optional) If you are updating the current segment only, continue your work and repeat as often as necessary
until you are ready to save and commit all translated segments to the TM.



/. Terminology lists

Terminology lists provide users with the ability to standardize term usage and to control the use of terms, variants
of terms, and parts of speech allowed for terms. A terminology list includes a glossary, a specialized list of source
terms, their definitions, and their preferred translations. It also includes alternate phrases for blocklisted terms.

Segment selection highlights terms from the terminology list on the Terminology pane along with potential
translation options.

There are two possible methods for moving among terms on the Terminology pane.

e Click Next Term (Ctrl + 9) or Previous Term ( Ctrl + 8).
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The term highlight identifies the type of translation match between the source term and the terminology list.

. Use Highlight All Terms to view highlights for term matches in the open file.




Color Code Category

Green Exact term match
Yellow Fuzzy term match
Red Missing exact term match
Purple Missing fuzzy term match

You can only add terms to a remote glossary, not a local glossary. You need read and write user permissions to
add terms to a remote glossary that is not read-only.

You can add terms to both local and remote glossaries. You need read and write user permissions to add terms to
a remote glossary that is not read-only.

To add a term to a glossary:

1. On the Terminology pane, select a word in the source segment and, optionally, the translation in the target

segment, then click



2. (Optional) On the Add Term dialog, enter content in the Description field.

Required fields are marked with a red asterisk.

' Use this page to add a term to the selected glossary.

Source:* INTEGRATE WITH |
Target* INTEGRATION MIT |
Description: | |
Glossary- Doc_Termd - |

0OK Cancel

W Use this page to add a term to the selected glossary.

Source:* INTEGRATE WITH |
Target* INTEGRATION MIT |
Description: | |
Glossary: Doc_Term1 - |

OK Cancel

Add Term

Use this page to add a term to the selected glossary.

Source:® “

Description: ‘

|
Target:* ‘ ‘
|
|

Glossary: ‘Samp\eJ)mJem -

oK Cancel

3. Select the proper Glossary from the drop-down list.
4. Click OK.

The new term is added to the glossary.

Edit a term

G You can only edit terms in the local glossary.



To edit a term:

1. In the TXLF Editor view, on the Terminology pane, select a term.

+ £ X ¢ & Terminology

Search Glossaries (Source) ﬂ > -.'I:I-
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_ @
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Project Management o
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2. Click the Edit term icon 7’ .

3. On the Edit term dialog, make your edits.

W Use this page to edit a term in the selected glossary.

Source:

| project |

Target:
| projekte |

Description:

Modify Cancel

4. Click Modify.

The term is edited.

Insert a term

To insert a term into the current target segment:
1. Inthe TXLF Editor view, click the location for term insertion.

2. Select the term to insert from the Terminology pane.

3. Click + on the upper left menu bar within the Terminology pane.

The term is inserted into the target segment.



Search for a term

To search for a term:

1. On the Terminology pane, enter a term in the terminology filter field.

2. Click the Search for Term icon ~ .

The search results from the connected glossaries are displayed.

+ [ — Terminology
project - 40 X 'ﬂ'
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Copy a term

To copy a term from the glossary into the current target:

1. In the TXLF Editor view, click a segment that contains glossary terms.



2. On the Terminology tab, click Previous Term or Next Term to select a source term.
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3. Click on the target location where you want to copy to the glossary term.



4. Click Copy Term.
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The glossary term is copied to the target segment.

Copy a synonym

To copy a synonym for a term:



1. Inthe TXLF Editor view, select a source term in a segment that has a glossary term.

This highlights and adds a border around the source and target terms. Synonyms display on a temporary pop-
up pane and on the Terminology pane.
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2. Click within the target segment at the location where you want to copy the term.



3. Click the preferred target term from the Terminology pane. This copies the term to the cursor location in the

target segment.

-
An alternative is to click Copy Term. This also copies the term to the cursor location in

the target segment. An alternative is to click Copy Term. This also copies the term to
the cursor location in the target segment.
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The target synonym is copied to the target segment.

Remove a term

You can only remove terms from local glossaries, not read-only or remote glossaries.

To remove a term:

1. Inthe TXLF Editor view, go to the Terminology pane.

2. Select a term, then click x

Use the Remove Term x at the top of the Terminology pane. Do not use the Reset

Search x This clears the filter.

A warning message notifies you of the pending deletion and asks you to agree to the term removal.

3. Click Yes.

The term is removed from the local glossary.



Tags contain information related to a block of text, such as format or indentation. Tags are not translated and
come in pairs: an opening and a closing tag.

Translations must retain the same tags at the correct location within a target segment.

Unless you have disabled Remove incomplete tag pairs in Preferences> General

Preferences >Tags , a warning message results when you try to save a target

segment with a missing tag or an open tag. An open tag is part of a tag pair in the
target segment that is missing its matching close tag. The warning will give you three
choices: Fix Manually, Delete, or Always delete. Hover over a tag to view tool-tip
information.

2] 1] B_‘TRANSLATID
oo

Tags contain numerals to indicate their order in the segment.

Red

Purple

Blue

N MANAGEMENT. @

2354255#2358235 high

hiMame="Gotham Medism" hidden

260" backgroundColors="0#D80E0"

This is a tag you currently selected, such as the first tag, II in the file.

This is a tag that specifies formatting, such as

This is a tag that specifies non-formatting controls, such as (Tag 1 JG Tag 1]

Any inline tags for the following HTML entities are displayed with a specific inline tag image to show the actual
character of the entity. This is to help linguists to view the character representation of the entities directly without

hovering over the tags.

Entity Tag Image Entity Tag Image Entity Tag Image
&amp; & &ldquo; “ &ge; >

&lt; < &lsquo; ‘ &#8804; <

&gt; > &mdash; — &HATT, *
&quot; " &nbsp; 0 &plusmn; *
&#39; ! &#160; o &acute;

&apos; ' &ndash; - &micro; J
&bull; . &raquo; » &mu; J
&copy; © &rdquo; ? &middot;

&deg; i &reg; ® gordm; 0
&frac12; : &rsquo; ’ &shy; --- (soft hyphen)
&frac14; Ya &trade; ™ &sup2; 2
&frac34; % \' ' &sup3; 3




Entity Tag Image Entity Tag Image Entity Tag Image

&hellip; \" "
&laquo; « &#8805; >

The maximum length check counts HTML entities such as: &. These are real
characters and are counted as part of the overall character count (1 Character per

entity).

Copy a tag

Translated content retains the formatting of the source content, so tags are an important element in the final
translation. You can copy tags from the source to the target for formatting and indentation accuracy.

Use Preferences > General Preferences > Tags to configure tags as full name, short
name, or numbered tags.

To copy a tag:
1. Open afile.

2. In the TXLF Editor view, on the Translation tab, select a segment with tags.

When the selected segment contains tags, the first tag is automatically selected. Red
indicates selection.




3. Choose one of the following actions:

e Click a source segment tag and drag it to the corresponding location in the target segment or press Ctrl

+Alt+Down Arrow.

e Click a source segment tag, then click in the corresponding target segment location and click Copy Tag.

e Right click a source segment tag, select Copy (Ctrl+C) in the drop-down menu, click in the corresponding

target segment location, then select Paste (Ctrl+V).
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Tag Tag

The target segment, highlighted in blue, contains the copied tag at the cursor location you selected in the

target segment.

4. (Optional) Click Previous Tag or Next Tag to select another tag and repeat the process.

Copy all tags

Use Preferences > General Preferences > Tags to configure tags as full-sized or

shortened.

To copy all tags:
1. Inthe TXLF Editor view, open a file.



2. On the Edit tab, click Copy All Tags.

All copied tags display at the location of the cursor. Reorder them to mimic the source
content order using the drag-and-drop or copy-and-paste technique.
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3. Select Segment or Document from the drop-down menu.

Segment or Alt+A Select to copy only the tags for the selected segment to the target.

Document or Alt-Shift+P Select to copy all tags for the entire document.

All tags are copied to the segment or document.

Edit a tag

Most tags in your target content have specific formatting and indentation settings copied from the source. You can
modify tags to change content format in the translated file.

Do not edit tags in the source segment.

To edit a tag:
1. Open a translation file.
2. In the TXLF Editor view, select a tag in a target segment.

3. Choose one of the following actions:
e On the Translation tab, click Edit Tag. Edit tag button

B B B R EBE B BR B RBBCE
Copy

Next Previous Commit Leverage Mark All Merge Split Previous Mext Copy Edit
Segment Segment Translated Source Tag Tag Tag Tag

e Right-click the tag and select Edit Tag from the drop-down menu.



4. On the Edit Tag dialog, modify the tag.

0 Verify that all tag edits are valid. Otherwise, the file could become corrupt.

[Edit Tag x
W You can edit tag content below. Note: Adding
invalid edits can corrupt the file on cleanup.
=ffontFormai=
OK Cancel
5. Click OK.

Edits to the tag are saved.

Clear all tags

Use Preferences > General Preferences > Tags to configure tags as full-sized or
shortened.

To clear all tags:
1. Open afile.
2. In the TXLF Editor view, on the Edit tab, click Clear All Tags.
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Select Segment or Document.

Segment or Ctrl-Shift+V | Select to clear only the tags from the selected segment.

Document | Select to clear all segment tags for all target segments in the file.

A warning message asks you to agree to clear all tags from the open file.

. Click Yes.

All tags are cleared for the target segment or for all target segments in the document.

Delete a tag

You may choose to delete target tags, particularly if there are multiple copies of the same tag in the same target
segment. You can only delete target segment tags.

To delete a tag:

1.
2.
3.

Open a translation file.

In the TXLF Editor view, select a tag in a target segment.
Choose one of the following actions:

o Press Delete or Backspace.

e On the Edit tab, click Cut, then paste the tag elsewhere.
ﬂ Edit Formatting Translation Terminology Review
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0 To undo the change, click Undo or press Ctrl + Z.

The target tag is deleted.



9. Manage project notes

You can add notes that are specific to each segment during the translation and review process. If you have
chained files together, you can review all notes for all files in the chain.

There are two ways to access the Notes editor.

e Use the Notes tab on the Editor pane to view and manage project notes.

¢ Use the Notes icons on the Review tab to view and manage project notes.

View notes

The Notes tab is on the Editor pane. Notes retain the same ID as the related segment.

G Segments with notes include the Notes icon O in the Status column.

To view notes:

1. Open a translation file.



2. In the TXLF Editor view, click the Notes tab on the Editor Pane, then view note details for all file segments.

bl

TM Lookup Notes Segment History Metadata Transcheck (0)

Add Note Edit Note Delete Note

ID | Type Date Details
Translation 2018/08/27 Use Vereinfacht as the approved
16:30:54 MDT | phrase for this project.

EN-US — DE-DE | Segments: 7/33 | Segment (Src/TgtMax): 12112/ | Paragraph (Src/Tgt/Ma:

-

TM Lookup JITES g History d heck (0)
Add Note Edit Note Delete Note
o | Type Date Details

Translation | 2018/08/27 Use Vereinfacht as the approved

2 16:30:54 MDT phrase for this project.

EN-US — DE-DE| 733 | (Src/ 1212 | (Src/TgtM

TM Lookup Notes Review History Metadata Transcheck (0)

Add Note Edit Note Delete Note
ID | Type |Dd:e Details

Translation | 2018/08/27 Use Vereinfacht as the approved

2 16:30:54 MDT  phrase for this project.

EN-US — DE-DE | S8egments: 7/33 | Segment (Src/TgtMax): 1212/~ | Paragraph (Src/TghMa:

| Notes

Add Note Edit Note Delete Note

Notes for all file segments are displayed.

Add a note

To add a note:

1. Open a translation file.
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2. In the TXLF Editor view, select a segment.



3. Choose one of the following actions:

o Click the Notes tab on the Editor pane, then click Add Note. Editor pane Notes tab showing Add

Note button

TM Lookup Notes Segment History Metadata Transcheck (0) -
Add Note Edit Note Delete Note
I | CreatorlD Type Date Details
13 Submitter |Review |2018/06/04 Check for correctness. b
13:19:02 MDT
- Submitter |Question 2018/06/04 Are you treating "internal translator”
131921 MDT | as a single phrase for DE?
4 3
EN — DE-DE | 8egments: 20/33 | Segment (Src/TgbMax): 83/83/ | Par
: T™ Lookup BUIIEEE Segment History Metadata Transcheck (0) -
Add Note Edit Note Delete Note
ID | CreatorlD Type Date Details
13 Submitter |Review |2018/06/04 Check for correctness.
13:19:02 MDT
- Submitter |Question 2018/06/04 Are you treating "internal translator”
13:19:21 MDT | as a single phrase for DE?
4 3
EN — DE-DE | 8egments: 20533 | Segment (Src/TgtMax): 83/83- | Pa
TM Lookup  Motes Review History  Metadata  Transcheck (0) -
Add Note Edit Note Delete Note
ID | CreatorlD Type Date Details
13 Submitter |Review |2018/06/04 Check for correctness. M
13:19:02 MDT
13 Submitter |Question 2018/06/04 Are you treating "internal translator”
13:19:21 MDT |as a single phrase for DE?
4 3
EN — DE-DE | Segments: 29/33 | Segment (Src/TgtMax): 83/83/- | Par




TW Lookup Notes Segment History Metadata Transcheck (0)

Add Mote Edit Mote Delete Note Export Notes
ID | CreatorlD Type Date Details
Submitter Review |2018/06/04 Check for correctness. )
13:19:02 MDT

Submitter  Question 2018/06/04 Are you treating "internal translator”
131921 MDT as a single phrase for DE?

k

EN — DE-DE Segments: 2933 @ Segment (Src/TgtMax): 83/83/~ @ Par

TM Lookup I!EE Review History Metadata Transcheck (0)

Add Note Edit Note Delete Note

I.. | CreatorlD Type Date Details
! Admin Translation 2018/01/31 Use Verwaltung as the correct term for this
12:16:12 MST project.

© ®EN . DE-DE | Segments: 2/34 | Segment (Src/Tgt/Max): 23/23/- | Paragraph (Src/Tgt/Max): 23/23/- . 10% Reviewed

e On the Review tab, click Add Note, or right click on the target segment and select Add Note to open Add/
Edit Notes dialog.
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4. On the Add/Edit Notes dialog, select a Type from the drop-down list.

Add/Edit Motes

Use this pagse to add or edit a nots.

Segment 1D: 13

Source: Allow access to any vendor or internal translator
for maximum resource flexibility.

Creator” | Submitter |

Date: 2018/06/04 13:10:38 MDT |

Type: -

Review

Question

Important

Transzlation

AddiEdit Notes

@ |seo this page to add or edit a note.

Segment ID: 13

Source: Allow access fo any vendor or intemnal franslator
for maximum resource flexibility.

Creator:™ | Submitter |

Date: |2u1smﬁm4 13:10:38 MDT |

Type: ranslatio -

Review
Question
Important

Tranglation

oK Cancel
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Add/Edit Notes

’ Use this page to add or edit a note.

Segment ID: 19

Source: The translated (or localized) languages
or content.

Creator:* Admin

Date: 2021/04/05 15:22:19 MDT

Type: [rransiation -
Review
Question

Important

Translation

OK Cancel

The selected note Type is saved for the next time Wordfast is run. The selected note
Type is saved for the next time you sign in.

Type Description

Translation Select to include data for the reviewer from the translator.

Review Select to includes data for the translator from the reviewer.
Question Select to solicit a response about the segment from a user.
Important Select to flag the data for the segment as a priority for other users.

5. Enter the information in the note field.
6. Click OK.

The note is saved and associated with the segment.

Edit a note

To edit a note:
1. Open a translation file.

2. In the TXLF Editor view, select a segment with a note.



3. Choose one of the following actions:

o Click the Notes tab on the Editor pane, then click Edit Note. Editor pane Note tab showing edit note

button
TM Lookup Notes Segment History Metadata Transcheck (0) -
Add Note Edit Note Delete Note
I | CreatorlD Type Date Details
13 Submitter |Review |2018/06/04 Check for correctness. b
13:19:02 MDT
- Submitter |Question 2018/06/04 Are you treating "internal translator”
13:19:21 MDT |as a single phrase for DE?
4 3
EN — DE-DE | 8egments: 20/33 | Segment (Src/TgbMax): 83/83/ | Par
: T™ Lookup BUIIEEE Segment History Metadata Transcheck (0) -
Add Note Edit Note Delete Note
ID | CreatorlD Type Date Details
13 Submitter |Review |2018/06/04 Check for correctness.
13:19:02 MDT
- Submitter |Question 2018/06/04 Are you treating "internal translator”
13:19:21 MDT | as a single phrase for DE?
4 3
EN — DE-DE | 8egments: 20533 | Segment (Src/TgtMax): 83/83- | Pa
TM Lookup  Motes Review History  Metadata  Transcheck (0) -
Add Note Edit Note Delete Note
ID | CreatorlD Type Date Details
13 Submitter |Review |2018/06/04 Check for correctness. M
13:19:02 MDT
13 Submitter |Question 2018/06/04 Are you treating "internal translator”
13:19:21 MDT |as a single phrase for DE?
4 3
EN — DE-DE | Segments: 29/33 | Segment (Src/TgtMax): 83/83/- | Par




TW Lookup Notes Segment History Metadata Transcheck (0)

Add Mote Edit Mote Delete Note Export Notes
ID | CreatorlD Type Date Details
Submitter Review |2018/06/04 Check for correctness. )
13:19:02 MDT

Submitter  Question 2018/06/04 Are you treating "internal translator”
131921 MDT as a single phrase for DE?

3
EN — DE-DE Segments: 2933 @ Segment (Src/TgtMax): 83/83/~ @ Par

TM Lookup I!EE Review History Metadata Transcheck (0)

Add Note Edit Note Delete Note

I.. | CreatorlD Type Date Details
! Admin Translation 2018/01/31 Use Verwaltung as the correct term for this
12:16:12 MST project.

© ®EN . DE-DE | Segments: 2/34 | Segment (Src/Tgt/Max): 23/23/- | Paragraph (Src/Tgt/Max): 23/23/- . 10% Reviewed

¢ On the Review tab, click Edit Note. Edit note button

File Edit Formatting Translafion Terminology Raview

B B B

Add Naots Edit Mots Delste Mots Transcheck Transcheck
Segment All

File Edit Formatting Translation Terminology RNEYEY 2 AR

i) B ) BS

Add Note Edit Note Delete Note Transcheck Transcheck
Segment All

File Edit Formatting Translation Terminology RNEYEY Simple View ?2AX

B B B o2

Add Note Edit Note Delete Note Comments & Transcheck Transcheck
Ratings Segment All

File Edit Formatting Transglation Terminology Review _
=3 e B B B B

Spelicheck File Mark Spelling Add Note Edit Note Delete Mote Export Notes
Ermors



4. On the Add/Edit Notes dialog, edit the note.

Add/Edit Notes

Uss thiz pagse to add or sdit a nots.

Segment 1D: 13

Source: Allow access to any vendor or internal translator
for maximum resource flexibility.

for maximum resource flexibility.

Creator™ | Submitter |
Date: | 2018/06/04 15:13:14 MDT |
Type: |Tran5|a|inn - |
Check for correciness.
0K Cancel
Add/Edit Notes
W Use this page to add or adit a note.
Segment ID: 13
Source: Allow access to any vendor or infernal franglator

Creator.™ | Subritter |
Date- |2u1smﬁm4 13:19:02 MOT |
Type: |Rew'ew - |
Check for comsciness.

oK Cancel

Copyright © 2024 Confidential
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Add/Edit Notes

’ Use this page to add or edit a note.

Segment ID: 19
Source: The translated (or localized) languages
or content.
Creator:* Admin
Date: 2021/04/05 15:22:18 MDT
Type: [rarsitort -
Review
Question
Important
Translation
OK Cancel
5. Click OK.

The modified note is saved and associated with the segment.

Delete a note

To delete a note:
1. Open a translation file.

2. In the TXLF Editor view, select a segment with a note.



3. Choose one of the following actions:

e Click the Notes tab on the Editor pane, then click Delete Note. Editor pane Note tab selected

showing delete note button

TM Lookup Notes Segment History Metadata Transcheck (0) -
Add Note Edit Note Delete Note
I | CreatorlD Type Date Details
13 Submitter |Review |2018/06/04 Check for correctness. b
13:19:02 MDT
- Submitter |Question 2018/06/04 Are you treating "internal translator”
131921 MDT | as a single phrase for DE?
4 3
EN — DE-DE | 8egments: 20/33 | Segment (Src/TgbMax): 83/83/ | Par
: T™ Lookup BUIIEEE Segment History Metadata Transcheck (0) -
Add Note Edit Note Delete Note
ID | CreatorlD Type Date Details
13 Submitter |Review |2018/06/04 Check for correctness.
13:19:02 MDT
- Submitter |Question 2018/06/04 Are you treating "internal translator”
13:19:21 MDT | as a single phrase for DE?
4 3
EN — DE-DE | 8egments: 20533 | Segment (Src/TgtMax): 83/83- | Pa
TM Lookup  Motes Review History  Metadata  Transcheck (0) -
Add Note Edit Note Delete Note
ID | CreatorlD Type Date Details
13 Submitter |Review |2018/06/04 Check for correctness. M
13:19:02 MDT
13 Submitter |Question 2018/06/04 Are you treating "internal translator”
13:19:21 MDT |as a single phrase for DE?
4 3
EN — DE-DE | Segments: 29/33 | Segment (Src/TgtMax): 83/83/- | Par




TW Lookup Notes Segment History Metadata Transcheck (0)

Add Mote Edit Mote Delete Note Export Notes
ID | CreatorlD Type Date Details
Submitter Review |2018/06/04 Check for correctness. )
13:19:02 MDT

Submitter  Question 2018/06/04 Are you treating "internal translator”
131921 MDT as a single phrase for DE?

3
EN — DE-DE Segments: 2933 @ Segment (Src/TgtMax): 83/83/~ @ Par

TM Lookup I!EE Review History Metadata Transcheck (0)

Add Note Edit Note Delete Note

I.. | CreatorlD Type Date Details
! Admin Translation 2018/01/31 Use Verwaltung as the correct term for this
12:16:12 MST project.

© ®EN . DE-DE | Segments: 2/34 | Segment (Src/Tgt/Max): 23/23/- | Paragraph (Src/Tgt/Max): 23/23/- . 10% Reviewed

e On the Review tab, click Delete Note.

Fila Edit Formatting  Translation Teminology Reviaw

B B B E E

Add Nots Edit Mots Delste Mots Transcheck Tranecheck
Segment All

File Edit Formatting Translation Terminology RHEUE 2 AR

) B i) BZ

Add Note Edit Note Delete Note Transcheck Transcheck
Segment All

File Edit Formatting Translation Terminology R:ENMEW SimpleView ? A X
B B B = Eg

Add Note Edit Note Delete Note Comments & Transcheck Transcheck
Ratings Segment All

File Edit Formatting Translation Terminology Review

B e B B B B E E

Spelicheck File Mark Spelling Add Note Edit Mote Delete Note Export Notes Transcheck Transcheck
Ermrors Segment All

The note is no longer attached to the segment. If there are no other notes, the notes icon is removed from the
Status column for the segment.



Export notes

To export notes:
1. Open a translation file.

2. In TXLF Editor, choose one of the following actions:
e Click the Notes tab on the Editor pane, then click Export Note. Editor pane Notes tab showing
Export notes button

TW Lookup Motes Segment History Metadata Transcheck (0) -
Add MNote Edit Mote Delete Note Export Notes
ID | CreatorlD Type Date Details
Submitter Review |2018/06/04 Check for correctness. )
13:19:02 MDT

Submitter Question 2018/06/04 Are you treating "internal translator”
13:19:21 MDT as a single phrase for DE?

1 k

EN — DE-DE Segments: 2933 | Segment (Src/TgtMax): 83/83/~  Par

e On the Review tab, click Export Notes. Export Notes button

File Edit Formating  Translaion Terminology QSN |
[ e B B B B

Spellcheck File Mark Spelling Add MNote Edit Note Delete Mote Export Motes Transcheck Transcheck
Errars Segment All

e Right-click the segment and click Export Notes.
3. On the Export Notes dialog, browse and select a location for the exported notes file.

4. Enter a file name and click Save.

All notes for the open file are saved in the selected folder location as a table in either MS Word or HTML file
format.



10. Transcheck

You can use Transcheck to scan translated content for non-linguistic errors such as missing tags, empty targets,
numbers, and terminology within target segments.

“ is displayed in the Status column for segments with errors.

4 ™
0 To enable Transcheck and customize Transcheck options, configure in Preferences >
Current Project Preferences > Transcheck .

. If you have specific terms you want Transcheck to ignore, you can mark those
= segments for exclusion in the Transcheck Report. Taking this action, this will reduce
false positives during Transcheck error detection.

With Captive TransStudio, users can only use Transcheck and review Transcheck
Summary results. There is no option for running a Transcheck Report.

Use transcheck

After you have configured Transcheck options, you can begin using Transcheck when you translate or review a
segment and commit it to the TM. You can also use the Transcheck configuration option Transcheck segments
while translating to check for errors during the translation process.

To use Transcheck during translation:
1. In the TXLF Editor view, select a segment and complete your translation of that segment.

2. Select Next Segment or press Alt+Down Arrow to update the TM, move down one segment, and leverage
the next segment from the TM.

3. (Optional) If Transcheck identifies an error in the segment, it posts a warning message. Choose one of the
following actions:

e Select Go back to fix issue to correct the error.

e Select Continue to continue translating without changes.

If you choose to correct the error, the Error Status icon ﬂ is removed from the Status column and from the
Transcheck tab.

If you do not correct the error, the Error Status icon “ remains in the Status column and on the Transcheck
tab.

Use Transcheck All



Use Transcheck All to scan all segments of a file for non-linguistic errors in the target segments and issue
warnings for missing and incorrect text. Configure and enable your Transcheck preferences under Preferences >
Current Project Preferences > Transcheck.

Do not use Transcheck All if you want Source and Target Consistency checks. Instead, use Transcheck Report
from the Project Files tab on the Current Project view.

. Use the Transcheck All option before you complete a file.

To use Transcheck All:
1. In the TXLF Editor view, finish translation of all segments in a file.

2. Click the Review tab, then click Transcheck All.

File Edit Formatting Transalation Terminology Raview

B B R [E

Add Naots Edit Mots Delste Mots Transcheck Tranzcheck
Segment Al

B B B O

Add Note Edit Note Delete Note Comments & Transcheck Transcheck
Ratings Segment All

Edit Formatting Translation Terminology

2 o B OB B OB O E E

Spellcheck File Mark Spelling Add Mote Edit Mote Delete Note Export Motes Transcheck Transcheck
Ermors Segment All

B B B

Add Note Edit Note Delete Note Comments & Transcheck Transcheck
Ratings Segment All

In General Preferences under Warnings, if Transcheck All Warnings is selected a Transcheck All
Warning pop-up dialog appears. The "Do not warn me about this anymore" checkbox will turn off this pop-up
dialog. The Use Transcheck Report From Current Project view link will open the Project Transcheck dialog.



3. Click Continue.

Transcheck All Warning x

Source and Target Consistency check will not be reporied using Transcheck All
' aption from TXLF Editor pane.

Use Transcheck Repori From Current Project view fo get report for Source and
Target Consistency Check.

[] Do not warn me about this anymare

Transcheck All Warning

Source and Target Consistency check will not be reported using
Transcheck All option from TXLF Editor pane.

Use Transcheck Report From Current Project view to get report for
Source and Target Consistency Check.

Do not warn me about this anymore

A Transcheck report and summary results.

A Transcheck summary results.



4. (Optional) On the Transcheck Report, determine the terminology errors you want Transcheck to ignore from
highlighted terms in the Terminology Check report section.

To best optimize the Transcheck Report, you can configure Transcheck to ignore
highlighted terms you identify under conditions you specify. The terms and conditions
you select are in the Ignored Terminology Errors section of the report.

Il

Report is optimized for Google Chrome, some features might not work well in your current browser.

Project TransCheck Report
Report Summary (1 files)

File Mame Errors in file {visible highlights)

PD_en-de.docx. txdf ]

Ignored Terminology Errors:

|I mor |I Action " Condition Ill':.':u'r.-'v' I

Highlight: ] Exact Mateh B Fuzzy Mateh| ] Exaet (No Mateh) [|Fuzzy (No Mateh)

| Toggle Global Search Filters | Global search filter is OFF

Project TransCheck Report - Wordfastl - English - German
Report Summary (1 file)

TransCheck ran succassfully on 1 file and found 39 errors.

Target Consistency Check ran successfully with 0 errors.

Source Consistency Check ran successfully with 0 errors.

File Mame Total Number of Errors
PD_an-da.docx. txIf e

PD_en-de.docx. txif

Empty Target Check

=

Edited Source Check 0
Capitalization Check 0
Elunedited Fuzzy Check 11
Mledited Exact Check 3
Espeling Check 16
EITag Check 5
Elwhitespace Check 4
Repeated Words Check 0

Unedited Fuzzy Check

Block Source Target Score Comment

5] 1-6-1 | ACCESS REAL-TIME DATA ZUGRIFF AUF 75% Target contains a

5. (Optional) Click a highlighted term.



6. (Optional) On the Ignore Terminology Transcheck Error dialog, compare the source string with the target
equivalents.

7. (Optional) Select either When term is for source terms in the glossary or When target contains for target
terms.

Ignore Terminology Transcheck Error X

Source string: Sirea "
{ ¥
¢ Whemtemi o Sieamine(eine Stiomirienfor l
[StraamlinafOntimierunn) &
Py >
When Target
O Contains:
Ignore Ignore All (3) Mext

8. (Optional) Either click Ignore to disregard the single instance of a string or Ignore All to disregard every
instance of a string.

0 The number following Ignore All contains the total number of instances within that file.

Ignore Terminology Transcheck Error

Source string:

] When term is:

When Target Ubersetzungsprozess
® Contains:

Ignore All (3) Previous Next




9. (Optional) Review the terms in the Ignored Terminology Errors section of the Transcheck report.

transcheckReport5481583249647184112 html 16

Ignored Terminology Errors

Error I Action I Condition II Instances

translation process was translation process 1
ignored  (Ubersetzungsprozess)
when
term is:

enterprise was ENTERPRISE 3
ignored (BERICHTERSTELLUNG)
when
term is

VENDOR was VENDOR(ANBIETER) 1

ignored
when

term is:

Highlight: &1|Exact Match| [-1|Fuzzy Match| [F1|Exact (No Match)| [-]|Fuzzy(No Match)

Terminology Check:
transcheckReport5481583249647184112.html

' Hide this report |

Seq.| Block Source Comment

1D 1D
3 1-3-1 STREAMLINE @ EFFEKTIVES Incorrect terminology:
PROJECT PROJEKTMANAGEMENT  streamline (eine
MANAGEMENT Stromlinienform geben),
STREAMLINE

fANTTMTED ERY

10. (Optional) After closing the Transcheck report, select any remaining segments with the Error Status icon “
in the Status column.



11. (Optional) Click the Transcheck tab to examine the details of the segment error.

The total number of errors in the segment is the number in parentheses on the

Transcheck tab.

TM Lookup Notes Segment History Metadata

Previous error Next error Refresh lgnore warning
# Warning Explanation

1 | Tag Check Source contains

formatting missing in
the target.

2 | Unedited Fuzzy
Check

Target contains a
fuzzy match that has
not been modified.

3 Untranslated Text | Source text is not

Check translated in the
target.
TM Lookup Notes Review History Metadata
Previous error Next error Refresh lgnore warning
# Warning Explanation
1 | Tag Check Source contains

formatting missing in
the target.

2 | Unedited Fuzzy
Check

Target contains a
fuzzy match that has
not been modified.

Source text is not
translated in the
target.

3 Untranslated Text
Check

TM Lookup Notes Review History Metadata

Transcheck (3)

Previous error  Nexterror  Refresh Ignore warning
# | Warning T Explanation
edited.

3 Terminology Check

is not in the target.

Transcheck (3)

Cause

Source contains "1, 2,
3" which is missing in

target.

Target contains a 98%

match that has not
been modified.

"in" should be
translated in target.

Transcheck (3)

Cause

Source contains "1, 2,
3" which is missing in

target.

Target contains a 98%

match that has not
been modified.

"in" should be
translated in target.

Cause
Source text has been moditied.

Translation for the term in the source | Incorrect terminology:
TRANSLATION (UBERSETZUNG) +

»

12. (Optional) Click Next error or Previous error on the Transcheck tab to view the next or prior segment error.

-



13. Choose one of the following actions:

e Correct the error and click Refresh to complete the correction.

e Click Ignore warning to continue reviewing error warnings without making any changes.
If you correct the error, the Error Status icon ﬂ' is removed from the Status column.

If you do not correct the error, the Error Status icon 'E' remains in the Status column.



11. Leverage project TMs

A translation memory (TM) provides maximum content re-use and facilitates collaboration among localization
resources. Users can leverage reusable content using one of two different types of TMs.

Consider using a hosted service: WordFast Anywhere (WFA). WFA allows translators
= to connect to a shared server and interact with a private, remote TM and glossary.

Local TM Located on your local computer system and only you can access it.

Remote TM Located on a server that other translators can access. This allows multiple
translators to leverage the available content and update the TM with new reusable
content.

You can remove a TM from a project so it is no longer in the project TM list. When
you remove a local TM from a project, it remains in the TM folder on your computer
system. To add a removed local TM back to the project, use the Add Local action on
the Project TM tab. To add a removed remote TM to the project, use the Connect to
Remote action on the Project TM tab.

Create a local TM

Create a local translation memory (TM) for quick, local access. If it is possible you may need to share your TM
with other users, connect to a hosted service: Wordfast Anywhere (WFA). Refer to Connect to a remote glossary
on page 179.

To create a local TM:
1. In the Project List view, on the Projects tab, select a project from the projects list to open it.
2. On the Project TM tab, select Create Local.

Project Files Project TM Project Terminology Reporis Reference Files

= | .o = W . = = -
Create Add Add Connect Open Modify Copy Import Export Remove

Local Local Project Ths To Remote ™ ™ ™ ™ ™ TM




3. On the Translation Memory dialog, enter the required TM configuration.

0 Required fields are marked with a red asterisk.

Translation Memory x

W Create Translation Memory

Name:™* |

Target Language:* German -
Loc ation:* Browse...
Priority:* Secondary -
| Selected

Read-only

OK Cancel

Field Action

Name Enter a unique TM name that includes the client or organization name and the
TM's language for easy identification.

Target Language Select target languages. Target languages are limited to those languages
configured in the project.

Location Select the destination where the application saves the new TM.

Priority Set the TM sequence used during translation, using the Primary TM first,
followed by any Secondary TMs.
You can only select one TM as primary.

Selected (Optional) Select to use the current TM for the project.
Read-Only (Optional) Select to leverage the TM without updating it with the new translation.
4. Select OK.

The new TM is created and is displayed in the Project TM list.

Add a local TM to a project

You can add a local TM to your project at the time of creation or as a separate action.

You can add TMs created by Wordfast Pro 4 or 5 only. If you want to add TMs from
Wordfast Classic or Wordfast Pro 3, use the Import TM option.



To add a local TM to a project:
1. On the Projects tab, double-click a project from the projects list.
2. Select the Project TM tab, then select Add Local.

Project Files Project TM Project Terminology Reporis Reference Files

= S0 W S@ S = = 0
Create Add Add Connect Open Modify Copy Import Export Remove
Local Local Project TMs To Remote ™ TM ™ ™ ™ TM

3. On the Opening TM dialog, browse to the local TM folder and select it.
4. Select Select Folder.

The selected TM is added to the project and displayed in the Project TM list.

Add project TMs

Some projects may use multiple local and remote translation memories (TMs). In such instances, it is more
efficient to add all of the TMs for the project with a single Add Project TMs action.

To add project TMs:
1. In Project List view, on the Projects tab, double-click a project from the projects list.
2. Onthe Project TM tab, select Add Project TMs.

Project Files Project TM Project Terminology Reporis Reference Files

S o S w B = S & 0
Create Add Add Connect Open Modify Copy Import Export Remove

Lecal Local Project ThMs To Remote M M ™ ™ ™ ™



3. On the Add Project TMs dialog, enter the project TM information.

w Select a Project containing TMs you would like to
add

Select a Project:* AdaptiveTranscheck1 b
Source Language: | English

Target Language(s): German (Gemany)

List of ThMs: German_DE, Adaptive Transcheck-German
oK Cancel
Field Action
Select a Project Select a project name from the drop-down list.
Source Language Leave the auto-populated source language.
Target Language(s) Leave the auto-populated target languages.
List of TMs Review the list of TMs associated with that project.
4. Select OK.

The selected project TMs are added to the project and are displayed in the Project TM list.

Connect to a remote TM

You can connect to one or more translation memories (TMs) on other computers, including a hosted service, such
as Wordfast Anywhere (WFA).

WEFA allows translators to connect to a shared server and interact with a private,
remote TM and glossary.

To connect to a remote TM:

1. On the Projects tab, double-click a project from the projects list to open it.



2. In the Current Project view, and on the Project TM tab, click Connect To Remote.

Project Files Project TM Project Terminology
(=)

- -
"W =2 —(x]
Connect Modify Remave

To Remate ™ ™
Project Files Project TM Project Terminology Reports Reference Files
= .0 W S S = = =
Create Add Agd Connect Open Modify Copy Imnport Export Remave
Local Lacal Project TMs To Remoie TM ™ ™ ™ ™ ™
MGl Project Terminology 2 AR
= = =
w =% (]
Connect Modify Remove
To Remote ™ ™

3. On the Connect to Remote TM dialog, select the appropriate tab, based on your server options.

e TM Server
o WF Server
o WFA Server



Required fields are marked with a red asterisk.

Connect to Remote TM

4. (Optional) Add a TM Server on the TM Server tab, complete the required fields, then click OK.

’ Uss this page to connect to remote TM.

TM Server

Symbolic Name:®

— URL Ssttings

WF Server

WFA Server

| Sample_TM

URL:"

Address™

Port:

TMS Folder:™

Cluster Short Code:”

| tms: i Hm=/EN-US&usr=Sample_User&p

Test

TM Short Code:* [En-us

User:"® | Sample_User

Password:" | Sample_Password

Workgroug 1D: [0123
— TM Updats

TM Cleanup Passcode: | ABCD1234 |
Priority: | Primary - |
] selected
[ ] Read-only

OK




W Uss this page to connect to remote TM.

TM Server WF Server WFA Server

Symbolic Name:®

URL Ssttings

URL:™ example: im://address:portTMS?tm=LE{ Test
Address™

Port:

TMS Folder:™

Cluster Short Code:”

TM Short Code:"

User”

Password:”

Warkgroup 1D:

TM Update Settings

TM Cleanup Passcode:

Priority: Primary -
] Selected
Read-only
OK Cancel

Connect to Remote TM

Use this page to connect to remote TM

WF Server WFA Server

Symbolic Name:*

URL Settings

URL:* example: tm://address:port/TMS?tm=| Test
Address:*

Port:

TMS Folder:*

Cluster Short Code:*

TM Short Code:®

User:*®

Password:*

Workgroup ID:

TM Update Settings

TM Cleanup Passcode:

Priority: Primary -
M Selected
Read-only

OK Cancel



Field or Option

Action

Symbolic Name

Enter a unique name for the TM. The symbolic name can be automatically
populated from the URL String for remote TM connections.

URL

Enter the remote TM URL using the following format: t ns: / / addr ess: port/
TMS?. The remaining URL Settings automatically populate when you enter the
URL string. Click Test to validate the connection. The symbolic name can also be
automatically populated from the URL String for remote TM connections.

TM Cleanup Passcode

Enter the password to update the TM for the project.

Priority Select a priority from the drop-down list.
The priority determines the sequence of reference during translation, first
referencing the primary TM, then any secondary TMs. You can only designate
one TM as primary.

Selected (Optional) Select to use the current TM for the project.

Read-only

(Optional) Select to leverage the TM without updating it with the new translation.




5. (Optional) Add a WF Server on the WF Server tab, complete the required fields, then click OK.

Required fields are marked with a red asterisk.

Connect to Remote TM

' Use this page to connect to remote TMW.

TM Server WF Server WFA Server

Symbolic Mame:™ | Sample_TM |

— URL Sattings

URL:" |example: wiifjsmith:passwordi@address Test

Address™

Part:”

Account Password:

|
|
Account Name:” |
|
|

Workgroug 1D:

— PM and TM admin

[] Use TM (Write) Password

Priority: Primary -

| Selecied

[] Read-anly

OK Cancel




W Use this page to connect to remote TMW.

TM Server WF Server WFA Server

Symbolic Mame:™ Sample_TM
URL Ssttings
URL:" example: wiijsmith:passwordi@address Test
Address™
Part:”

Account Name:”
Account Password:

Workgroug 1D:

P and TM admin

Use T (Write) Password

Priority: Primary -
] Selected
Read-only
OK Cancel

Connect to Remote TM

Use this page to connect to remote TM

TM Server RUIESSUSg WFA Server

Symbolic Name:* ||

URL Settings

URL:* example: wr.//jsmith:password@addre Test
Address:*

Port:*

Account Name:™*

Account Password:

Workgroup ID:

PM and TM admin

Use TM (Write) Password

Priarity: Primary v
M Selected

Read-only

OK Cancel



Field or Option

Action

Symbolic Name

Enter a unique name for the TM. The symbolic name can be automatically
populated from the URL String for remote TM connections.

URL

Enter the remote TM URL using the following format: wf : / /

j smth. passwor d@ddr ess: port/ TMS?. The remaining URL Settings
automatically populate when you enter the URL string. The symbolic name can
also be automatically populated from the URL String for remote TM connections.
(Optional) The Password and Workgroup ID fields depend on server settings.
Click Test to validate the connection.

Address

Enter the address associated with the URL.

Port

Enter the port associated with the URL.

Account Name

Enter the username associated with the URL sign in.

Account Password

(Optional) Enter the password associated with the username.

Workgroup ID

(Optional) Enter the workgroup ID for the project.

Use TM (Write)
Password

Enable, if you are a PM or TM Administrator, to require a password to overwrite
the existing TM with new translations.

TM (Write) Password

If enabled, enter the password to overwrite the existing TM with new translations.

Selected

(Optional) Select to use the current TM for the project.

Read-only

(Optional) Select to leverage the TM without updating it with the new translation.




6. (Optional) Add a WFA Server on the WFA Server tab, complete the required fields, then click OK.

Required fields are marked with a red asterisk.

Use this pagse to connsct to remota TM.

TM Server WF Server WFA Server

Symbolic Name:™ Sample_TM
APl key™ Test
Priority: Primary -
V] Selected

Read-only

OK Cancel

W Use this page to connect to remote TM.

TM Server WF Server WFA Server

Symbolic Name:™ WordFast Anywhere Adaptive Test
APl key™ Test
Priority: Primary -
] Selected

Read-only

OK Cancel

Connect to Remote TM

Use this page to connect to remote TM

TM Server WF Server JRUZEISaN

Symbolic Name:* ||

AP key:* Test
Priarity: Primary v
M Selected

Read-only

0K Cancel



Field or Option

Action

Symbolic Name

Enter a unique name for the TM.

API key Enter the API key you obtain from WFA.
a. Sign in to your WFA account at ht t ps: // www. wor df ast . cont
nmyaccount .
b. Click TMs & Glossaries, then Setup.
c. Onthe TMs and glossaries management dialog, select a TM or glossary.
d. Click Manage Sharing.
e. On the TMs and glossaries shares dialog, click the API key and copy the
text string.
f. Paste the API key into the Connect to Remote TM dialog using the following
format: user name@ 234567, then click Test to validate the connection.
Priority Select a priority from the drop-down list.
The priority determines the sequence of reference during translation, first
referencing the primary TM, then any secondary TMs. You can only designate
one TM as primary.
Selected (Optional) Select to use the current TM for the project.
Read-only (Optional) Select to leverage the TM without updating it with the new translation.

The new TM is added to the project and is displayed in the project TM list.

Open and edit a local TM

You can open and edit local translation memory (TM) entries at any time after TM creation.

You cannot open a remote TM in TM Editor.

To open and edit a local TM:
1. In the Project List view, on the Projects tab, double-click a project from the projects list to open it.

2. On the Project TM tab, select a translation memory and select Open TM.

Project Files Project TM Project Terminology Reporis Reference Files

= w0 = W slm | = - .- (]
Create Add Add Connect Open Modify Copy Import Export Remove
Local Local Project Ths To Hemote ™ ™ ™ ™ ™ TM



https://www.wordfast.com/myaccount
https://www.wordfast.com/myaccount

3. On the TM Editor tab, view the translation units (TUs) for both source and target languages.

L = — ) [== I
Mo o XD B B 5 B
it Prisveous Cut I'.d:rf Pashe Dedite TU Expan
Uipdate Updiabe Filtzred
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4. (Optional) To search for source or target translation units (TUs), enter your search criteria in the appropriate
fields in the Filters sidebar, then select Find.

You can make your filtered search case-sensitive or specify an exact match, then filter
further by creator, user, and modification date.

5. (Optional) To reset your search criteria, select Clear.

6. (Optional) Use the Edit Options actions, such as Cut, Copy, and Paste to edit a TM entry.

Modify a TM

To rename, write-protect, or change the priority of a TM, use the Modify TM action.

To modify a local or remote TM:

1. In the Current Project view, click a file.

2. In the Project List view, on the Projects tab, double-click a project from the projects list to open it.

3. On the Project TM tab, click a TM.



Click Modify TM.
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5. On the Connect to Remote TM dialog, modify the details for your connection. Based on your selection, other
fields auto-populate. Refer to Connect to a remote TM on page 159.

0 You can only select one primary TM for a project.

Required fields are marked with a red asterisk.

Connect to Remote TM

Use this pags to connect to remote TMW.

TM Server  WFServer  WFA Serve
Symbslic Name:~ ' TMS Connect |
— URL Senings
URL:" | tms:1 Test
Address:® | |
| |
TMS Folder™ | Tms |
Cluster Shart Cade:™ |GRO000003 |
TM Shart Code:" | LTM000005 |
User |LTh-en-de |
Password:" | |
Workgroup ID: | |
— TM Updats Sattings
TM Cleanup Passcode: | |

Priority: Primary -]

] Selected

| | Read-only

OK Cancel




Connect to Remote TM

w Use this page to connect to remote TM.

TM Server WF Server WFA Server

Symbolic Name:* Sample_TMS_DE-de
— URL Sattings
URL:* trms: /g el Pl COM/TMS? Test
Address:” iR, i com
Port:
TMS Folder:* ™S
Cluster Short Code:* GROD00003
TM Short Code:* 'LTM000005
User:" l LTM-en-de
Password:” F-"-'-"'"' .
Workgroup 10: '
— TM Update Ssthings
TM Cleanup Passcode:

Priority: Primary -
| Selected
| Read-only
oK Cancel
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Connect to Remote TM

Use this page to connect to remote TM

LTS WF Server  WFA Server

Symbolic Name:*

URL Settings

URL:* example: tm://address port TMS?tm=1 Test
Address:*

Port:

TMS Folder:*

Cluster Short Code:*

TM Short Code:*

User:*

Password:*

Workgroup I1D:

TM Update Settings

TM Cleanup Passcode:

Priarity: Primary v
V| selected

Read-only

OK Cancel

6. (Optional) Select the TM identified in the Name field for the current project using Selected.
7. (Optional) Select Read-only to allow users to leverage the TM but not update it with new translation.

8. Click OK.

Your modifications to the TM are saved.

Copy a local T™M

Copy a TM to use an existing TM for a new project.

0 The copied TM is in the Wordfast Pro TM format, regardless of the original TM format.

To copy a local translation memory:
1. Inthe Project List view, on the Projects tab, double-click a project from the projects list to open it.

2. Onthe Project TM tab, select a translation memory and select Copy TM.

Project Files Project TM Project Terminology Reports Reference Files
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Create Add Add Connect Open Modify Copy Import Export Remove
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3. On the Copy Translation Memory dialog, enter the TM Name.

e Required fields are marked with a red asterisk.

e Create acopy of the selected transiation memory. Please enter a name for
the copy, location, and decide if you want to flip the TM languages.

Source TM: Doc_TM1

Mame:* | |

Location:* | | Browse...

Flip Languages

Copy Cancel

4. Browse and select the Location on your disk for the TM copy.
5. (Optional) Select Flip Languages, to reverse the source and target languages, then select Copy.

A copy of the translation memory is saved in the selected folder location.

Import a local TM

To use a local translation memory (TM) from another linguist, use the Import TM action.

To import a local TM:

1. Inthe Project List view, on the Projects tab, double-click a project from the projects list to open it.

2. Select Import TM on the Project TM tab.

Project Files Project Terminology Reports Reference Files
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3. On the Import Translation Memory dialog, select the import File Type from the drop-down list.

Required fields are marked with a red asterisk.
W Import Translation Memory

File Type:" TMX -

Import File:™ C\Users\Deskiop\de-DE TM\TranscheckDE tmx Browse...
Create Mew TM

#) Import Into Existing TM

Existing Th:" -

If TU already exisis” Add as a new TU -

Delete all TUs from existing T

0K Cancel

Field Action

File Type Select an action from the drop-down list.
e TMX — Translation Memory eXchange file format provides compatibility
with all translation tools.

e WF TXT TM format (.txt) — File format provides backward compatibility
for Wordfast Classic and Wordfast Pro 3.

Import File Browse to select the file for import.

Create New TM Select to import the TM into a new TM file.

Import into Existing TM Select to import the TM into an available TM file, based on selection from the
drop-down list.

Existing TM Select an available TM file from the drop-down list.
If TU already exists Select a TM option from the drop-down list to import it into an available TM file.
Delete all TUs from Select to delete the existing TM and replace it with the new TM.
existing TM
4. Select OK.

The translation memory is imported and is displayed in the Project TM list.

Export a local TM

To share a local translation memory (TM) with another linguist, use the Export TM action.

To export a local TM:



=

. In the Project List view, on the Projects tab, double-click a project from the projects list to open it.

2. Select a TM assigned to that project.
3. Select Export TM on the Project TM tab.
[WSWE ' Froject Terminology ~ Reports  Reference Files
(=]
€ 8 & & 8 8 8 8§ &8 &
Create Aad Agd Connect Open Modify Copy Import Export Remove:
Local  Local Project TMs  ToRemote  TM ™ ™ ™ ™ ™
4. On the Export Translation Memory dialog, choose a location and export type for the TM export file.
° Required fields are marked with a red asterisk.
Export Translation Memory x
- Specify existing Translation Memory for export, and
choose a location and export type for the TM
Translation EN_DE-de -
Memory:®
Export Type:" ThX b
File: Location:* Browse...
OK Cancel
Translation Memory Select a TM from the drop-down list.
Export Type Select the export file type from the drop-down list.
File Location Browse and select the folder location for the export.
5. Select OK.

The selected translation memory exports to the selected folder location.



12. Leverage project terminology lists

Terminology is a phrase used to identify two distinct groupings: the glossary and the blocklist.

¢ Glossary—A database of preferred source terms, words, and phrases paired with their target equivalents
designated as preferred and client-specific
¢ Blocklist—A database of rejected target terms prohibited from use in the translation

You can use the Project Terminology tab to modify and remove glossaries and blocklists.

Create a local glossary

To create a local glossary:
1. Inthe Project List view, on the Projects tab, double-click a project from the projects list to open it.

2. In the Current Project view, on the Project Terminology tab, click Create Local.

Project Terminology Reports Reference Files
By B OE B OB &

Create Add Connect Open Import Export Add Project
Local Local To Remote Glossary Glossary Glossary Gloszaries

3. On the Create Glossary dialog, enter the glossary information.

Create Glossary x

W Create/Modify Glossary

Name:* |

Target Language:* German -
Location:* Browse...
| Selected

Read-only

oK Cancel

a Required fields are marked with a red asterisk.

Field Action

Name Enter a unique name for the glossary.

Source Language Do nothing, since the source language auto-populates.

Target Language Select a language from the target languages available for your project in drop-

down list.




Field Action

Location Browse and select the folder location for the new glossary.

Selected (Optional) Select to use the current local glossary for the project.

Read Only (Optional) Select to leverage the glossary without updating it with new terms.
4. Click OK.

The new glossary is displayed in the project glossary.

Add a local glossary

You can only add glossaries created by Wordfast Pro 4 or 5. For glossaries from Wordfast Classic or Wordfast
Pro 3, use the Import Glossary action. Refer to Import a local glossary on page 189.

To add a local glossary:
1. Inthe Project List view, on the Projects tab, double-click a project from the projects list.
2. In the Current Project view, on the Project Terminology tab, select Add Local.

Project Files Project TM Project Terminology Reporis Reference Files
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3. On the Creating Glossary dialog, browse to a glossary folder and select it.
4. Select Select Folder.

The selected glossary is added to the project and is displayed in the project Glossaries list.

Add project glossaries

Some projects may use multiple local and remote glossaries. In such instances, you can add all of the glossaries
from a previous project with a single Add Project Glossaries action.

To add project glossaries:
1. Inthe Project List view, on the Projects tab, double-click a project from the projects list to open it.

2. In the Current Project view, on the Project Terminology tab, select Add Project Glossaries.

Project Terminology Reports Reference Files
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3. On the Add Project Glossaries dialog, enter the project glossaries information.

- Select a Project containing Glossaries you would
like to add

Select a Project:” AdaptiveTranscheck1 o
Source Language: |English

Target Language(s): German (Gemany)

List of Glossaries: de-DE-TechDoc

OK Caneel
Field Action
Select a Project Select a project name from the drop-down list.
Source Language Leave the auto-populated source language, based on the project.
Target Language(s) Leave the auto-populated target languages, based on the project.
List of Glossaries Review the list of glossaries associated with that project.

4. Select OK.

The selected project glossaries are added to the project and displayed in the project Glossaries list.

Connect to a remote glossary

You can connect to a glossary residing on another server, including a hosted service, such as Wordfast Anywhere
(WFA).

WEFA allows translators to connect to a shared server and interact with a private,
remote translation memory (TM) and glossary.

To connect to a remote glossary:
1. On the Projects tab, double-click a project from the projects list.

2. On the Project Terminology tab, click Connect To Remote.

M0 b B Om o @

Create Add Connect Open Import Export Add Project
Local Local To Remoie Glossary Glossary Glossary Gloszaries




3. On the Current Project view, and on the Project Terminology tab, click Connect To Remote.

- s L ] Project Terminology _
)] &
L\ n\ '
Caonnect To Connect To Modify Remave
\Hemote Glossary J} Remole Blocklist

O ST M Tl Project Terminology _

>
D:I.- e o
Connect To Connect To Madify Remove

Remote Glossary Remote Blocklist

4. On the Connect to Remote Glossary dialog, select the appropriate tab, based on your server options.
e TMGR Server

o WF Server
o WFA Server



5. (Optional) Add a Term Manager (TMGR) Server on the TMGR Server tab and complete the required fields.

0 Required fields are marked with a red asterisk.

Connect to Remote Glossary

TMGR Berver WF S8erver WFA Server

Mame:” | Sample_Glossary |

Target Language:™ |German (Gemnany) - |

— URL Ssttings

URL:" | tmgr.ii?pri=&usr=&pwd=password1! Test

Address" | ‘

Username:™ | ‘

Password:™

Project Short

|Exarn|:|le: ABC0000001, ABCD000002 \
Code”

] Selected
[ ] Read-only

] Create Blocklist Connection

OK Cancel




Connect to Remote Glossary

Target Language:™ | Gemman (Germany) b |

— URL Ssttings

URL:" | example: imgraddress:portimgr? Test

Address” | ‘

Username:” | ‘

Password:™ | ‘

Project Short

- |exarn ple: ABCO000001, ABC0000002 ‘
e

] Selected
[] Read-only

] Create Blocklist Conneciion

oK Cancel
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Connect to Remote Glossary

’ Connect To Remote Glossary

IS WF Server  WFA Server

Name:*

Target

_ German (Germany)
Language:*

URL Settings

URL:* example: tmgr://address:port/tm¢ Test
Address:*

Account Name:*

Account
Password:*

Project Short  [ovamnle ARCOO0OONT ARCONNO007
Code:*

| Selected
Read-only

/| Create Blocklist Connection

0K Cancel

Field or Option Action

Name Enter a unique name for the glossary. The name can be automatically populated
from the URL String for remote glossary connections.

Target Language Select a language from the drop-down list. This list is constrained by the available
target languages for your project.

URL Enter the remote glossary URL using the following format: t ngrs: //
addr ess: port/ TMGR?.
The remaining URL Settings automatically populate when you enter the URL
string. This includes the username, password, and project short code. The name
can also be automatically populated from the URL String for remote glossary
connections.
Click Test to validate the connection.

Selected (Optional) Select to use the current glossary for the project.
Read-only (Optional) Select to leverage the glossary without updating new terms.
Create Blocklist (Optional) Select to connect to an available blocklist already in TMGR.

Connection




(Optional) Add a WF Server on the WF Server tab and complete the required fields.

Required fields are marked with a red asterisk.

Connect to Remote Glossary

’ Connsct To Remote Glossary

TMGR 8erver WF Server 'WFA Server

MName:* | Sample_Glossary |

— URL Satting=

URL:™ f-fijsmith: Test

Address”

Port™

Account Password:

|

| |

| |
Account Name:" | |

| |

| |

Worlkgroup 1D:

|/ Selected

0K Cancel

W GConnect To Remote Glossary

TMGR Server WF Server 'WFA Server

MName:" | Sample_Glossary |
— URL Ssttings
URL" wi-ffjsmith; Test
Address:”
Port:™

Account Password:

|

| |

| |
Account Name:* | |

| |

| |

Workgroup 1D:

b Selected

0K Cancel




Connect to Remote Glossary

’ Connect To Remote Glossary

TMGR Server m WFA Server

Name:*

URL Settings

URL:* example: wf./jsmith:password@: Test
Address:*

Port:*

Account Name:*

Account
Password:

Workgroup 1D:

Selected

OK Cancel
Field or Option Action
Name Enter a unique name for the glossary. The name can be automatically populated

from the URL String for remote glossary connections.

URL Enter the remote glossary URL using the following format: wf : / /
j smith: passwor d@ddr ess: port/tngr?. The remaining URL Settings
automatically populate when you enter the URL string. Click Test to validate the
connection. The name can be automatically populated from the URL String for
remote glossary connections.

Address Enter the address associated with the URL.

Port Enter the port associated with the URL.

Account Name Enter the username associated with the URL sign in.
Account Password (Optional) Enter the password associated with the username.
Workgroup ID (Optional) Enter the workgroup ID for the project.

Selected (Optional) Select to use the current glossary for the project.

Read-only (Optional) Select to leverage the glossary without updating new terms.




7. (Optional) Add a WFA Server on the WFA Server tab and complete the required fields.

Connect to Remote Glossary

' Connsect To Remots Glossary

TMGR Server WF Server WFA Server

Mame:” Sample_Glozsary
Target Language:™ German (Germany) -
API KEY:™ usermamei@1234567 Test
Selected
Read-only

0K Cancel

W Connect To Remote Glossary

TMGR Server WF Server WFA Server

MName:* WaordFast Anywhere Adaptive Test
Target Language:” German (Germany) -
APIKEY:™ usemame@ 1234567 Test
Selected
W Reac-only
0K Cancel

Connect to Remote Glossary

Connect To Remote Glossary

TMGR Server  WF Server [UZSII4V1g

Name:*

Target German (Germany) -

Language:*

API KEY:* username@1234567 Test
Selected

Read-only

oK Cancel

Field or Option Action

Name Enter a unique name for the glossary.




Field or Option Action

Target Language Select a language from the drop-down list.
This list is constrained by the available target languages for your project.

API KEY Enter the API key you obtain from WFA.

a. Sign in to your WFA account at ht t ps: // www. wor df ast . cont
nyaccount .

Click on TMs & Glossaries, then Setup.

On the TMs and glossaries management dialog, select a glossary.

Click Manage Sharing.

® oo o

On the TMs and glossaries shares dialog, click on the API key and copy the
text string.

f. Paste the API key into the Connect to Remote Glossary dialog on the WFA
Server tab using the following format: user nanme@ 234567, then click Test to
validate the connection.

Selected (Optional) Select to use the current glossary for the project.
Read-only (Optional) Select to leverage the glossary without updating new terms.
8. Click OK.

The selected glossary is added to the project and is displayed in the project Glossaries list.

You can open and view remote glossary entries at any time after a glossary is connected.

You can only view the terms in a remote glossary. You cannot edit the glossary.

To open a remote glossary from the TXLF Editor view:

1. In the TXLF Editor view, click Open Glossary on the Terminology tab, or click the Open Glossary icon
on the Terminology pane.

The remote glossary will open in your default browser.

2. In the TXLF Editor view, click Terminology List on the Terminology tab.
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3. (Optional) If you are connected to multiple remote glossaries, clicking Open Glossary or the Terminology List
button (from the Terminology tab) opens the Project Glossaries dialog; do one of the following:

e Click a remote glossary location link.

e Select a remote glossary, then click Open.

Project Glossarnies x
Name Type Location Read-o... | Active
3MCO00732_en-US_de-DE http tmars://stg-tmgr1.translations.com/TM... v v
Manage Project Glossaries Open Close

4. Inthe Project Glossaries dialog; do one of the following:

e Click a remote glossary location link.

e Select a remote glossary, then click Open.

Project Glossaries X

Name Type | Location Rea... | Sele...
Glossary EN-DE Local  /home/glpd/transstudio-re... v
Manage Project Glossaries Open Close

5. (Optional) In the Current Project view, on the Project Terminology tab, do one of the following:
e Click a remote glossary location link.

e Select a remote glossary, then click Open Glossary.

The remote glossary will open in your default browser.

Open and edit a local glossary
You can open and edit local glossary entries at any time after glossary creation.

To open and edit a local glossary:

1. Inthe Project List view, on the Projects tab, double-click a project from the projects list to open it.



2. In the Current Project view, on the Project Terminology tab, select a local glossary, and select Open
Glossary.

Project Files Project TM Project Terminology Reports Reference Files
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Create Add Connect Open Import Export Add Project
Local Local To Remote Glossary Glossary Glossary Gloszaries

3. Inthe Glossary Editor, view the terms for both source and target languages. You can also filter, add, remove,
and update terms.

oS % D & & I E
Mext Prévious Cut Copy Paste Add Term Remave Impart Expar
Update Update Term Glossary  Glossary
_ ID | Source [ Target | Desoription | Creation ... Creation... Modifica... | Modificati: | T =
. TermEntrylD | en en:Status | ds 2019/0 ds 2019/08/ =
Source and target - 1 3;221 5 32_31 99
femTes 2 MDT MDT
Enter Termn Texdt 4 1 1 1
845312a1- Access Approved |ds 2019/0 ds 2019/08/
5 7719-4d4b- Protection 826 26
930a- 09:31:2 09:31:22
96f3163f07af 2 MDT MDT
4eidB1ed- Application | Approved |ds 2019/0 ds 2019/08/
5 9cfb-dfal- Support 8/26 26
aB18- 09:31:2 09:31:22
6f094b2b2f55 2 MDT MDT
68adc311- technology | Approved |ds 2019/0 | ds 2019/08/
ef95-49f4- 8/26 26
4 |9e3e- 09:31:2 09:31:22
1eadb433dbb 2 MDT MDT
2
asf7290a- Worms Approved |ds 2019/0 ds 2019/08/
89bb-446d- 8/26 28
3 | ab44- 09:31:2 09:31:22
8702c33910e 2 MDT MDT
D Find ¥ Clear 2 -

4. (Optional) To search for source or target terms, enter your search criteria in the appropriate fields in the Filters
sidebar, then select Find.

You can make your filtered search case-sensitive or specify an exact match, then filter
further by creator, user, and modification date.

5. (Optional) To reset your search criteria, select Clear.

6. (Optional) Use the Edit Options actions, such as Cut, Copy, and Paste within the source and target columns.



Import a local glossary

To exchange glossaries with other translators, save the exported glossary to a local drive, then use the Import
Glossary action to import it to your project.

To exchange glossaries among projects on your local drive, use the Add Project

Glossaries action.

To import a local glossary:

1. Inthe Project List view, on the Projects tab, double-click a project from the projects list.

2. In the Current Project view, on the Project Terminology tab, select Import Glossary.

Project Files Project TM Project Terminology Reports Reference Files
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Create Add Connect Open

0 B B

Import Export Add Project

Local Local To Remote Glossary Glossary Glossary Gloszaries

3. On the Import Glossary dialog, select the import File Type from the drop-down list.

Required fields are marked with a red asterisk.

Import Glossary

W Import Glossary

File Type:" BX] -
Import File:™ CAUsers\Documentsi\Sourcede-DE Term\de-DE_TechDo Browse...
Create a new glossary

L#) |mpart into existing glossary

Existing Glossary:” de-DE-TechDoc bl

If the term already exiziz:™ |Add as new term bl

Delete all terms from existing glossarny
oK Cancel

Field Action

File Type Select a file format for importing raw text files.

Term Base eXchange (TBX) — Use with other CAT tool glossaries




Field Action

e Tab delimited text file (TXT) — Use with Wordfast Classic and Wordfast
Pro glossaries

Import File Select Browse to locate and select an Import File.

Create a new glossary  Select to use the imported glossary to create a new glossary rather than add
terms to an existing glossary.

Import into existing Select to use the imported glossary to add to the selected glossary.

glossary

Existing Glossary Select from the drop-down list to append the imported glossary to an existing
glossary file.

If term already exists Select from the drop-down list to import the term into an existing glossary file.

e Add as a new term — Add the term to the existing glossary file.

¢ Do not overwrite — Ignore the term and retain the term already in the
glossary file.

e Overwrite existing term — Use the new term to replace the term already
in the glossary file.

Delete all terms from Select to delete the existing term and replace it with the new glossary term.
existing glossary

4. Select OK.

The glossary is imported and is displayed in the project Glossaries list.

Export a local glossary

To exchange glossaries with other translators, use the Export Glossary action and save it to a local drive, then
send it to another translator to import to their project.

To exchange glossaries among projects on your local drive, use the Add Project
Glossaries action.

To export a local glossary:
1. Inthe Project List view, on the Projects tab, double-click a project from the projects list.

2. In the Current Project view, on the Project Terminology tab, select a glossary and select Export Glossary.

Project Files Project TM Project Terminology
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Local Local To Remote Glossary Glossary Glossary Glossaries



3. On the Export Glossary dialog, select a glossary from the drop-down list.

W Export Glossary

Glossary * Doc_Term1 -

Export Type:* TBX -

File:* Browse...
oK Cancel

4. Select the file Export Type from the drop-down list.

¢ Term Base eXchange (TBX) — Use with other computer-assisted translation (CAT) tool glossaries
¢ Tab delimited text file (TXT) — Use with Wordfast Classic and Wordfast Pro 3 glossaries

5. Select Browse to locate and select the export file location, then select Save.
6. Select OK.

The glossary is exported to the specified file location.

Create a local blocklist

You can create a blocklist for your project on your local computer.
To create a local blocklist:
1. Inthe Project List view, on the Projects tab, double-click a project from the projects list.

2. In the Current Project view, on the Project Terminology tab, select Create Local in the Blocklist group.

Project Terminology Reports Reference Files
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3. On the Create Blocklist dialog, enter the required blocklist information.

0 Required fields are marked with a red asterisk.

@@ Create a New Blocklist

Mame:*
Language:* German -
Lo ation:* Browse...
" Selected
Read-only
OK Cancel
Field Action
Name Enter a unique blocklist name that includes the client or organization name and the
blocklist target language for easy identification.
Select the blocklist's target language, which is limited to languages configured in
Language .
the project.
Location Select the destination for the new blocklist.
Selected (Optional) Select to use the current blocklist for the project.
Read-Only (Optional) Select to leverage the blocklist without updating it with the new
translation.
4. Select OK.

The new blocklist is created and is displayed in the project terminology list.

Add a local blocklist

Use a local blocklist already created on your computer when you want to leverage a translation blocklist, but do
not want to collaborate with other users. You can add a local blocklist to your project at the time of creation or as a
separate action.

To add a local blocklist:



1. Inthe Project List view, on the Projects tab, double-click a project from the projects list to open it.

2. In the Current Project view, on the Project Terminology tab, select Add Local in the Blocklist group.

Pt Temie
B B B B B H B & € & & @&
Add

Create Add Connect Open Import Export Add Project Create Connect Open Impart
Leocal Local To Remotie Glossary Glossary Glossary Glossaries Leocal Local To Remote Blocklist Blocklist

3. On the Creating Blocklist dialog, browse to a blocklist file and select it.
4. Select Select Folder.

The selected blocklist is added to the project and is displayed in the project terminology list.

Connect to a remote blocklist

You can connect to one or more blocklists on another computer or server.
To connect to a remote blocklist:
1. Inthe Project List view, on the Projects tab, double-click a project from the projects list.

2. In the Current Project view, on the Project Terminology tab, click Connect To Remote.

Project Files Project TM Project Terminology Reports Reference Files

BB KR B B B B & & © © @&

Create Add Connect Open Import Export Add Project Create Connect Open Impart
Lecal Local To Remoate Glossary Glossary Glossary Glossaries Lecal Lacal To Remote Blocklist Blocklist

3. Inthe Current Project view, on the Project Terminology tab, click Connect To Remote.
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4. On the Connect to Remote Blocklist dialog, enter the required information, based on your server options.

Required fields are marked with a red asterisk.

Name:™ | Sample_Blocklist |

Target Language:™ | German {(Germany) - |

— URL Ssttings

URL:" |example: tmagr-address:porttmgr?project= Test

Address” | |

Username:” | |

Password:" | |

Project Short

| example: ABC0000001, ABC0000002 |
Code"

] Selected

oK Cancel

Connect to Term Manager

W Connect to Remote Blocklist

Name:* | |

Target Language:* | German - |

— URL Settings

URL:* example: tmgr:/addres s portfmgr ?project= Test

Address:*

Username:* |

Password:™

Project Short Code* | example: ABCO000001, ABCO000002

] Selected

oK Cancel
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Connect to Remote Blocklist

' Connect to Remote Blocklist

Name:*

Target
Language:*

URL Settings
URL:*

Address:*
Username:*
Password:*
Project Short

Code:*

v’ Selected

Field or Option

German (Germany)

example: tmgr:/faddress:port/tmgr?proje Test

example: ABC0000001, ABC0000002

oK Cancel

Action

Name

Enter a unique name for the blocklist.

Target Language

Select a target language from the drop-down list.

URL Enter the remote TMGR URL using the following format: t ngrs: //
addr ess: port/ TM5?. The remaining URL Settings automatically populate
when you enter the URL string. Click Test to validate the connection.

Address Enter the remote address.

Username Enter the username associated with the URL sign in.

Password Enter the password associated with the username.

Project Short Code Enter the short code for the project, such as ABCO000001.

Selected (Optional) Select to use the current blocklist for the project.

5. Click OK.

The new remote blocklist is displayed in the project terminology list.



Open and edit a local blocklist

You can open and edit local blocklist entries at any time after blocklist creation.

a You cannot open a remote blocklist in Wordfast Pro.

To open and edit a local blocklist:
1. Inthe Project List view, on the Projects tab, double-click a project from the projects list to open it.

2. In the Current Project view, on the Project Terminology tab, select a local blocklist, and select Open
Blocklist.

Project Terminology Reports Reference Files Help
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Export Add Project Create Connect Import
Glogsary Glossaries Local Local To Remote Elocklist Elocklist Elocklist

3. On the Blocklist Editor tab, view the blocklist terms for both source and target languages. You can also filter,
add, remove, and update terms.

(=] Wordfast Pro - Blocklist Editor - o *

Blocikdisl Editor
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Mext Pravious Cut Copy Paste Add Term Ramawe Tarm Imgpart Export
Updiata Update Blocklist  Blockdst
A N -

1 | Please click Click

Searnch; |

Farbidden - | ) ) )
2 | Organisation Organization

Term Text

Enber Term Tex)

E’ 3 | Waming popup Warning message

%

1L
Ti+

A

O Find ¥ Chear .

4. (Optional) To search for source or target blocklist terms, enter your search criteria in the appropriate fields in
the Filters sidebar, then select Find.

You can make your filtered search case-sensitive or specify an exact match, then filter
further by creator, user, and modification date.




5. (Optional) To reset your search criteria, select Clear.

6. (Optional) Use the Edit Options actions, such as Cut, Copy, and Paste to edit entries within the forbidden

and suggested term columns.

Import a local blocklist

To use a local blocklist from another source, use the Import Blocklist action.

To import a local blocklist:

1.
2.

3.

In the Project List view, on the Projects tab, double-click a project from the projects list.

In the Current Project view, on the Project Terminology tab, select Import Blocklist.

Project Terminology Reporis Reference Files
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On the Import Blocklist dialog, select the import File Type from the drop-down list.

Required fields are marked with a red asterisk.

Import Blocklist x
W Import Blocklist
File Type:® Txt -
Import File:™ ChAlsers'\Documents\Source'de-DE Termide-DE_Te Browse...

#) Create a new blocklist

OK Cancel

Field Action

File Type Select TXT as the file format for importing raw text files.

Import File Select Browse to locate and select an Import File.




Field Action

Create a new blocklist  Select to use the imported blocklist to create a new blocklist, rather than add
terms to an existing blocklist.

Import into existing Select to use the imported blocklist to add to the selected blocklist.

blocklist

Existing Blocklist Select from the drop-down list to append the imported blocklist to an existing
blocklist file.

If term already exists Select from the drop-down list to import the term into an existing blocklist file.

e Add as a new term — Add the term to the existing blocklist file.

¢ Do not overwrite — Ignore the term and retain the term already in the
blocklist file.

e Overwrite existing term — Use the new term to replace the term already
in the blocklist file.

Delete all terms from Select to delete the existing term and replace it with the new blocklist term.
existing Blocklist

4. Select OK.

The blocklist is imported and displayed in the project Blocklist.

Export a local blocklist

To share a local blocklist with another linguist, use the Export Blocklist action.

To export a local blocklist:

1. Inthe Project List view, on the Projects tab, double-click a project from the projects list.

2. In the Current Project view, on the Project Terminology tab, select a blocklist from the project Blocklist.

3. Select Export Blocklist on the Project Terminology tab.
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4. On the Export Blocklist dialog, choose a blocklist name, export type, and folder location for the blocklist
export file.

0 Required fields are marked with a red asterisk.

Export Blocklist x

& Export a blocklist
Blockhst:* Blocklrst -
Export Type:” Txd v
File Locaton:” Browse...
oK Cancel
Blocklist Select a blocklist from the drop-down list.
Export Type Select the export file type from the drop-down list.
File Location Browse and select the folder location for the export file.
5. Select OK.

The selected blocklist exports to the selected folder location.

Modify a glossary or blocklist

To modify a glossary or blocklist:
1. Inthe Project List view, on the Projects tab, double-click a project from the projects list.
2. In the Current Project view, on the Project Terminology tab, select a glossary or blockilist.

3. On the Current Project view, on the Project Terminology tab, select a glossary or blocklist.



4. Select Modify.
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5. On the Connect to Remote Glossary or Connect to Remote Blocklist dialog, modify the details as required.
Based on your selection, other fields auto-populate. Refer to Connect to a remote glossary on page 179 or
Connect to a remote blocklist on page 194 for more details.

Required fields are marked with a red asterisk.

Connect to Remote Glossary
’ Connect To Remots Glossary

TMGR Server WF Serve WFA Serve

Mame:™ TMGR Connect DE

— URL Ssttings
URL:" | tmigrs g T B comTMGE Test
Address | B il Bbird. com/ TMGR |
Username:” |III - ‘
PﬂSSWDrd:‘ [EETTTE R T ‘
Project Short | DOC000003 ‘
Code:"

] Selected

] Read-only

0OK Cancel




Connect to Remote Glossary

' Connect To Remote Glossary

(e WF Server  WFA Server

Name:*

Target

, German (Germany) v
Language:*®

URL Settings
URL:* example: tmgr://address:port/tmc¢ Test

Address:*

Account Name:*

Account
Password:*

Project Short example: ABC0000001, ABC0000002
Code:*

| Selected
Read-only

v’ Create Blocklist Connection

OK Cancel



Name:" TMGR Connect DE

URL Senings

URL:" tmigrs/Ells Er " .com/TMGE Test
Address:” [N L i cOMITMGR

Username:” DOCOo00003

Password:"

Project Short
Code:"

DOCO000003

W] Selected

oK Cancel

Connect to Remote Blocklist

Connect to Remote Blocklist

Name:* |

Target

Language:* German (Germany) -

URL Settings

URL:* example: tmgr.//faddress:port/tmgr?proje Test
Address:*

Username:*

Password:*

Project Short

, example: ABC0000001, ABC0000002
Code:*

v/ Selected

oK Cancel



Name Modify the name of the current glossary or blocklist.

Selected (Optional) Select to use the current glossary or blocklist for modification.

Read Only (Optional) Select to leverage the glossary or blocklist without updating it with the new
translation.

Create Blocklist (Optional) Select to link the selected glossary to a blocklist.

Connection

6. On the Create Glossary dialog, modify the details as required. Based on your selection, other fields auto-
populate.

0 Required fields are marked with a red asterisk.

Modify Glossary x
W Modify Glossary

Name:* [Geman Glossan;

| Selected

Read-only
OK Cancel
Name Modify the name of the current glossary or blocklist.
Selected (Optional) Select to use the current glossary or blocklist for modification.
Read Only (Optional) Select to leverage the glossary or blocklist without updating it with the new
translation.
7. Select OK.

Your modifications are saved.

Remove a glossary or blocklist

When you remove a glossary or blocklist from a project, the glossary or blocklist file remains in the glossary or
blocklist folder on your computer. You can add it again with the Add Local or Connect to Remote action.

To remove a glossary or blocklist:

1. In the Project List view, on the Projects tab, double-click a project from the projects list.



2. In the Current Project view, on the Project Terminology tab, select a glossary or blocklist.

3. Select Remove.

Project Files  Project TM [ZWVECSEUTLETIE Reports  ReferenceFiles g ~ X
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Create Connect Open Impart Export Modhfy Remove
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A warning message asks you to agree to the removal.
4. Select Yes.

The selected glossary or blocklist is removed from the project terminology list.



13. Monitor reports

Use the Reports tab to open and to export auto-generated analysis and cleanup reports to .CSV, .HTML, .XLS,
and .PDF formats.

[+ Wordfast Pro - ad >

ocres [T e
B B

Femove Export
Report
Report Hame Location > I
~- i EN -> DE
=@ Cleanup

; I Cean Up Reporiz.mt C:\UsersWordfastPro\projacts\Wondf .. 2019/09/13 14:01:19 MDT
-~ [ Clean Up ReportLmt C:\UsersWordfastPro\projects\Wordf . 2019/09/13 14:00:35 MDT
i [ Clean Up Report.rpt C:\UsersWordfastPro\projects\Wordf . 2019/09/13 13:59:45 MOT

f
)

I

R

<

EN — DE - 23% Translated

Open a report
Use the Open Report action to open and view an auto-generated report.

To open a report:

1. Inthe Current Project view, on the Reports tab, select a report.



2. Double-click the report file name.

FY

Primary TM: tms://stg-supportl.com/TMS?
tm=DOC000003/MARDDD003&usr=Mar-en-
Secondary TM:
file://C:\Users\Laks\Desktop \LNK\WF\WF
testingDoc_TM1

H summary
Match Types Segments Words Percent Tags
Leveraged 70 372 99 &
Repetitions 2 2 1 0
TM Matches
Context & &0 16 5]
100% 54 312 83 0
95%-99% 0 0 0 0
85%-94% 0 0 0 0
75%-84% 0 0 0 0
50%-74% 0 0 0 0
No Match 2 2 1 0
Ignored 0 0 0 0
Total 74 376 100 B
Chars/Word 6.46
Chars Total 2430

H c:\Users\Laks\Wordfast4\ projects\Document
ation2\ de\txIf\Sample_1.docx1.txml.txIf

H c:\Users\ Laks\Wordfast4\ projects\Document
ation2\ de\ xlf\Sample_3.docx.baml.txlf

0K

3. Review the report, then select OK to close the dialog.

Export a report

You can export an auto-generated report to a CSV, HTML, XLS, or PDF file format before you view it.
To export a report:
1. On the Reports tab, select a report.

2. Select a format from the Export drop-down list.

Project Files

Project TM Project Terminology

3. Browse to the location for the report, enter a file name, and select Save.

The report is saved to the designated location.



14. Manage project reference files

You can include reference files in a project to provide context. Typical reference files are additional instructions,
illustrations, workflow diagrams, certifications, or any file that might aid translators and reviewers. Reference files
remain untranslated.

0 Users cannot modify reference files once you attach them to the project.

Project Files Project TM Project Terminology Reporis Reference Files
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Add Open Remave
Files File Filz(z)

ﬁ File Mame File Type Location | [ T
n AdaptiveTranschec. .. reference-files C:\Users\Public\WFP\AdaptiveTranscheck.dood. bolf.doox
n BiLingual-Table.doc reference-files C:\Users\Public\WFP\BiLingual-Table.doc
n Sample_File_Trans... reference-files C:\Users\Public\WFP\5ample_File_Transcheck.doo:.bdf.docx
n uniques-Glossaryl.t..  reference-files C:\Users\Public\WFP\uniques-Glossary 1.bd. b f

I

-
EN — DE . 7% Translated

Add reference files

To add reference files:

=

In the Project List view, on the Projects tab, double-click a project from the projects list to open it.

2. In the Current Project view, on the Reference Files tab, select Add Files.
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3. On the Open dialog, browse and select the reference file. To select multiple reference files, press Ctrl and
select them.

4. Select Open.

The files are added to the reference files list for the project.



Open a reference file

To open a reference file:
1. Inthe Project List view, on the Projects tab, double-click a project from the projects list to open it.
2. In the Current Project view, on the Reference Files tab, select a reference file from the list.

3. Select Open File.

Project Files  Project TM  Project Terminology ~ Reports i oz
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Add Open Show Remaovs

Fil=s File Instructions File(=]

The selected file is opened.

View submission instructions

A translation submission created in Project Director (PD) may include specific instructions related to the
submission, depending on the project configuration.

Submitters can include instructions as part of the Package files imported into Wordfast Pro.
To view instructions:

1. Open a file in the TXLF Editor view.

2. On the Projects tab, double-click a project from the projects list to open it.

3. On the Reference Files tab, select Show Instructions.
Project Files Project TM Project Terminology Reports Reference Files
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4. On the Files tab, select Show Instructions.

File Edit Formatting Translation Terminology Review Help SimpleView 7 A X

Bk FER B m B B E &

Close Close All Recalculale Save Save All Switch El:iitcrr‘r Finish | GetMSWord Download Download Show
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5. On the Instructions dialog, review the instructions on the first Instructions tab, then select the Background
Instructions tab for any project-related or more general information and instructions.

6. Select OK.

The Instructions dialog is closed.

Remove a reference file

You can remove a reference file from a project, but the file remains on your local computer.

To add a removed reference file, use the Add Files action on the Reference Files
tab.

To remove a reference file:
1. Inthe Project List view, on the Projects tab, double-click a project from the projects list to open it.
2. In the Current Project view, on the Reference Files tab, select the files you want to remove.

3. Select Remove File(s).
Project Files Project TM Project Terminology Reports Reference Files
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4. On the Remove dialog, select one of the available buttons.

*) Remove from the list only

Remaove from the list and move the following resources to Archive folder

Resources

Reference Files

oK Cancel

Remove from the list only

Remove from the list and move the following
resources to Archive folder

5. Select OK.

Removes the reference file from the files list, but
retains the reference files resources in the project
folder on your computer

Removes the reference file from the files list and
moves them to the archive folder inside the project
folder on your local computer



15. Use quick tools

You can use Quick Tools to create and work with files outside of projects. Typically, Project Managers use Quick
Tools before cleaning up and sending files to translation.

{ )
0 ¢ When you first open Quick Tools, the default is the Analysis tab. Once you
access Quick Tools, the default Quick Tools tab is the last one you used.

* You can choose to run many Quick Tools actions in the background and

continue your work. This is useful when processing large numbers of files.
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Analysis

You can use actions on the Analysis tab to create TXLF files or assess potential translation memory (TM)
matches and repetitions for selected source files.



Analyze without using the TM panel is a quick way to obtain the word count of the files before TM leveraging.

0 e Selected languages are not required when using Analyze without a TM.

You can pre-translate target segments using your TM and machine translation on No Match. You can also select
Maintain existing target (if present) to pre-translate only blank target segments and preserve any existing
translations in TXLF target segments with no TM match.

To analyze files:
1. Select the Wordfast Pro drop-down menu, then select Quick Tools.

2. Select the Analysis tab, if it is not already selected.
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3. On the Files panel, choose one of the following actions:

To search the File Name column for a particular string, enter the search string in the

available search field next to ~ on the Files panel.

Add Files
Add Folder

Remove Files

Select to browse and select a file from a folder.
Select to browse and select a folder and all its files.

Select to remove a folder and all its files or all selected files from the list.

4. (Optional) On the Translation Memories panel, select one or more TMs from the list of available TMs, then
choose one of the following actions:

4 ™
0 e To search the TM Name column for a particular string, enter the search string in
the available search field next to *~' on the Translation Memories panel.
e If you do not select a TM, the analysis report displays the word count without
TM leverage and the Language Selection option is not available.
\ J
Item Action

Create Local

Select to open the Create TM dialog and create a local TM for quick, local
access. Refer to Create a local TM on page 156.

Add Local TM

Select, then select a local TM or a project TM from the project list from the drop-
down list. Refer to Add a local TM to a project on page 157 and Add project TMs
on page 158.

Connect to Remote

Select to open the Connect to Remote TM dialog and complete the appropriate
information to connect to a remote TM for the project. Refer to Connect to a
remote TM on page 159 for entering information into the TM Server and WF
Server tabs. The symbolic name can be automatically populated from the URL
String for remote TM connections.

Import TM

Select to open the Import Translation Memory dialog and complete the
appropriate information to import a TM for the project. Refer to Import a local TM
on page 174.

Open TM

Select to open and edit the selected TM. Refer to Open and edit a local TM on
page 168.

Modify TM

Depending on the TM you select, select to open either the Modify a Local

TM dialog or the Modify a Remote TM dialog, then complete the appropriate
information to rename, write-protect, or change the priority of a TM for the project.
Refer to Connect to a remote glossary on page 179.

Remove TM

Select to remove the selected TM from the project list.

5. (Optional) On the Analysis Options panel, select the method for bilingual source file creation from the Create
TXLF files drop-down list, such as InDesign or MS Word files.



6. For Analyze without TM, select the appropriate languages from the Source Languages and Target

Languages drop-down list.

The options are not available for TXLF source files, or for non-TXLF source files when
you also select a TM.

7. (Optional) Complete Pretranslation Options.

a) Select Pretranslate, then set the baseline match percentage for the TM leverage with the type of match

from the drop-down list.

Item

Action

Copy Source (clears
existing target)

When there is no matching target content, select to insert source content in its
place.

Copy Tags (clears
existing target)

When there is no matching target content, select to insert source tags in its place.

Primary MT (if available,
clears existing target)

Select to leverage machine translation (MT) matches for all segments that do not
have a TM match.

If you have TM matches, but do not select the TM before you select Analyze, the
MT overwrites all target segments.

Maintain existing target
(if present)

When there is existing target content, retain it. Otherwise, insert source content in
its place.

Clear existing target
content

Overwrite target content with source content.

b) Select any of the following actions:

Item

Action

Lock leveraged 100%
matches

Write-protect all leveraged matches that are 100% matches.

Lock leveraged context
matches

Write-protect all leveraged matches that are contextual matches.

Ignore locked segments
from report

Do not consider locked target segments identified in the Analysis report.

Ignore translated
segments from report

Do not consider target segments identified in the Analysis report.

Ignore translated exact
segments from report

Do not consider only exact match target segments identified in the Analysis
report.

8. For the Report Settings, choose from the following actions:

Item

Action

Calculate analysis report percentage by: Select Words or Segments as the means of

calculating analysis percentages from the drop-down
list.




10.

11.

12.

Item Action

Calculate internal fuzzy matches e (Optional) Select according to the match
percentage you set or select an alternate

percentage.

e (Optional) Select Include internal fuzzy
matches as TM matches.

e (Optional) Select Include whitespace in total
character count (excludes CJK languages).
This is useful for including space counts in the
character count.

Report type Select a report type from the drop-down list.

Report location Select one of the following actions:

¢ Next to source

e Custom location, then browse to and select
an alternate location for the report on your local
computer.

. Select Analyze Files.

(Optional) On the Progress bar dialog, you can select Always run in background to preserve the
background batch action for future analysis actions, then select Run in Background.

Analyzing documentis)

79% completed...

Always run in background

Run in Background m

If you chose to run Analyze Files in the background, you can monitor its progress.

Background Actions ° :'

0 If you choose to run more than one batch action in the background, each action will
have its own progress bar.

After successful completion, view the report, then close the report browser window.

The Analysis Report is saved to your computer at the specified location.

Extract unigues

You can use actions on the Extract Uniques tab to remove frequently occurring segments, control exclusions for
matches, and create a .TXLF file of these unique segments before sending it out for translation. It uses the action
for each file you selected in the TXLF Files panel.



You can set the number of occurrences of a segment to be extracted to two or higher to create a file containing
only repeated segments. If you exclude context TM matches, 100% TM matches, and locked segments from the
extract, it further reduces the number of extracted segments.

To extract unique segments:

1. Inthe Quick Tools view, select the Extract Uniques tab, if it is not already selected.
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2. On the TXLF Files panel, choose one of the following actions:

To search the File Name column for a particular string, enter the search string in the

available search field nextto ' on the TXLF Files panel.

Add Files Select to browse and select a file from a folder.
Add Folder Select to browse and select a folder and all its files.
Remove Files Select to remove a folder and all its files or all selected files from the list.

3. (Optional) On the Extract Unique Segments Options panel, select an Extract option:

Make one uniques file Select to create a separate TXLF file for each selected file in the TXLF Files
per TXLF panel.



New uniques file after # Select to split a TXLF file into smaller files, based on the number of unique
segments segments you specified. The default value is 250. For example, this option would
split a file with 1000 unique segments into four files of 250 segments each.

. (Optional) Select an Extract Location, by choosing one of the following actions:
e Select Place unique segments next to TXLF.

e Select Place in subfolder, then browse to and select a location on your computer, then use the default
uniques prefix or create your own.

0 If you changed the uniques prefix, it will have the prefix you designate at the location
you select.

. (Optional) Select the type of segments you want to exclude in the Extract Uniques Options panel and the
minimum frequency of occurrence.

o Exclude context TM matches

e Exclude 100% TM matches

e Exclude locked segments

. (Optional) In the Report Options panel, add a report name prefix or use the default uniques-extracted.

. In the Report Options panel, select a Report Location, by choosing one of the following actions:
e Select Next to Original TXLF. This is the default Report location.
e Select Custom Location, then browse to and select the report location on your computer.

. Select Extract Uniques.

. (Optional) On the Progress bar dialog, you can select Always run in background to preserve the
background batch action for future analysis actions, then select Run in Background.

e

Analyzing documentis)

79% completed...

Always run in background

Run in Background m



10. If you chose to run Extract Uniques in the background, you can monitor its progress.

-
Background Actions “::-

o If you choose to run more than one batch action in the background, each action will
have its own progress bar.

After successful completion, the TXLF files containing unique segments are saved to your computer at the

selected location with a dialog box listing the number of extracted segments. If a file did not have any unique
segments, no file is created.

0 Extracted 33 segments out of 33 total extractable segmenis.

MNote: Unigue files are not created when unigue segmenis are not

found in the files.

Populate unigques

You can use actions on the Populate Uniques tab to add the target translation from the translated uniques file
back into the original TXLF file. After the uniques population, it creates a Populate Unique Segments report that

identifies all related segment errors. This is helpful when determining why certain target segments did not properly
populate.

To populate unique segments:



1. Inthe Quick Tools view, select the Populate Uniques tab, if it is not already selected.
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2. On the Uniques Files and Original TXLF Files panels, choose one of the following actions to select a file or
files to receive unique segments that have a high frequency of occurrence as an import from the original TXLF

files you selected.

-
0 e To search the File Name column for a particular string, enter the search string
in the available search field nextto ' on the Uniques Files and Original
TXLF Files panels.
¢ If you do not choose a new folder for this action, the populated files are placed
in a separate folder.
\. J
Add Files Select to browse and select a file from a folder.
Add Folder Select to browse and select a folder and all its files.
Remove Files Select to remove a folder and all its files or all selected files from the list.

3. (Optional) Select from the following Populate Unique Segments Options:

o Populate TXLF in new folder
e Only report non-populated segments

4. (Optional) Add a report name prefix or use the default uniques-populated prefix you used for the Extract
Uniques report.



5. Select a Report Location, by choosing one of the following actions:

e Select Next to Original TXLF.

e Select Custom Location, then browse to and select the report location on your computer.
6. Select Populate Uniques.

The uniques from the translated uniques file are populated into the original .TXLF file.

7. After successful completion of the action, view any errors that occur in the Populate Unique Segments report
that have to do with the population of segments into the original TXLF file, then close the report browser
window.

The Populate Unique Segments report is saved to your computer at the selected location.

You can use Transcheck to scan translated content for non-linguistic errors such as missing tags, empty targets,
numbers, and terminology within target segments. Using the Quick Tools Transcheck action is best for running
on groups of files as a bulk batch.

If you have specific terms you want Transcheck to ignore, you can mark those
= segments for exclusion to reduce false positives during Transcheck error detection.

To run Quick Tools Transcheck:



1. In the Quick Tools view, select the Transcheck tab, if it is not already selected.
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2. Onthe TXLF Files panel, choose one of the following actions:

e To search the File Name column for a particular string, select the search icon D on
the TXLF Files panel and enter the search string in the available search field.

Add Files Select to browse and select a file from a folder.
Add Folder Select to browse and select a folder and all its files.
Remove Files Select to remove a folder and all its files or all selected files from the list.

3. Select an action for the Glossary or Blocklist tabs.

To search the Glossary Name or Blocklist Name column for a particular string,

select the search icon ' on the Glossary or Blocklist panel and enter the search
string in the available search field.

Option Action

Create Local Select to create a new glossary or blocklist and add it to the list of available ones.




Option

Action

Add Local

Select and choose from the drop-down list to add to a local or project glossary or
blocklist.

Connect to Remote

Select to connect a remote glossary or blocklist to the project. Refer to Connect
to a remote glossary on page 179 for entering information into the TMGR Server
and WF Server tabs. The symbolic name can be automatically populated from the
URL String for remote glossary connections.

Import Glossary or
Import Blocklist

Select to import .TBX or tab-delimited files to a glossary or blocklist assigned to
the project.

Open Select to open a glossary or blocklist in the Editor view.
Modify Select to modify a glossary or blocklist assigned to the project.
Remove Select to remove a glossary or blocklist assigned to the project.

4. On the Transcheck Options panel, select items within any of the major categories.

r

.

0 e To search for an option, enter text in the search field above the options column
list. To select all, select the checkbox, and to clear all options, deselect the
checkbox. Use the Up or Down Arrow keys to move among the options, then
the Spacebar to enable or disable.

e The Sub-options panel to the right of the Transcheck Options panel contains
any sub-options related to the selected category. Use the Tab key to enter and
move among sub-options, then the Spacebar to enable or disable. To enter the
Sub-options panel, press Tab. To exit the Sub-options panel, press Shift + Tab.

a) Select items for the Segment Content Checks category.

Option

Action

Capitalization

Select to identify any capitalization issues for translated segments in the edited
file.

Source Consistency

Select for consistency of source content across a single file or multiple edited
files.

Target Consistency

Select for consistency of target content across a single file or multiple edited files.

Copied Source

Select to identify any target segments that are identical to the source segment in
the edited file.

Empty Target Select to identify any empty target segments that do not contain a translation in
the edited file.
Note Select to identify any target segments in the edited file with related notes.

Number Difference

Select to compare numerical values in source and target segments in the edited
file, then identify any discrepancies.

Punctuation

Select to compare punctuation in source and target segments in the edited file,
then identify any discrepancies.




Option

Action

Repeated Word

Select to identify any repetitions of words or subwords in target segments within
the edited file. Repeated subwords are found using a regular expression.

Segment Length

Select to compare source and target segment length in the edited file, then
identify any discrepancies.

Smart Punctuation

Select to confirm the punctuation in the target segment is correct for that
language.

Tag

Select to identify any target segments in the edited file with missing tags.

Whitespace

Select to compare source and target segment white space usage in the edited
file, then identify any discrepancies.

b) Select items for the Segment Status Checks category.

Option

Action

Edited Context Match

Select to identify any changes to the context matches for translated segments in
the edited file.

Edited Exact Match

Select to identify any changes to exact matches for translated segments in the
edited file.

Edited Source

Select to identify any updates to the original segment content in the edited file.

Do Not Write to TM
Segment

Select to identify any translated segments marked as unconfirmed in the edited
file, so not committed to the translation memory.

Unedited Exact Match

Select to identify any unedited or overlooked exact match segments in the edited
file.

Unedited Fuzzy Match

Select to identify any unedited or overlooked fuzzy match segments in the edited
file.

c) Select items for the Reference Checks category.

Option

Action

Blocklist

Select to cross-reference the available blocklist with the edited file.

Forbidden Character

Select to identify any provided forbidden characters remaining within the edited
file.

Mistranslated Text

Select to identify any mistranslated or inaccurate translation in segments within
the edited file.

Spelling

Select to identify any misspellings in translated segments within the edited file.

Terminology

Select to identify any overlooked terminology matches for translated segments in
the edited file.

Untranslatable Text

Select to identify all target segments that contain content that cannot be
translated in the edited file.

Untranslated MT

Select to identify all target segments that contain untranslated machine
translation (MT) content in the edited file.




5. Create your Report Settings.
a) (Optional) Use the default transcheck prefix or create an alternate prefix for the report.
b) Select Next to TXLF to create the Transcheck Report next to the existing TXLF file location, or browse and
select an alternate Report Location on your local computer.

6. Select Transcheck Files.

7. (Optional) On the Progress bar dialog, you can select Always run in background to preserve the
background batch action for future analysis actions, then select Run in Background.

b= ]

Analyzing document(s)

79% completed...

Always run in background

Run in Background m

8. If you chose to run Transcheck in the background, you can monitor its progress.

Background Actions = :'

0 If you choose to run more than one batch action in the background, each action will
have its own progress bar.

9. After successful completion, view the report, then close the report browser window.

The Project Transcheck Report is saved to your computer at the selected location.

TM update

To clean up and convert bilingual .TXLF files to their original source format in the target language, use TM
Update. Refer to Translate segments on page 77.

TM Update actions overwrite the translation memory (TM).

To use TM Update:

1. Select the Wordfast Pro drop-down menu, then select Quick Tools.



2. Select the TM Update tab, if it is not already selected.
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3. On the TXLF Files panel, choose one of the following actions:

To search the File Name column for a particular string, enter the search string in the

available search field next to *~ on the TXLF Files panel.

Add Files Select to browse and select a file from a folder.
Add Folder Select to browse and select a folder and all its files.
Remove Files Select to remove a folder and all its files or all selected files from the list.

4. On the Translation Memory panel, choose a TM or several TMs from the list, then choose one of the
following actions:

0 e To search the TM Name column for a particular string, enter the search string in

the available search field next to /- on the Translation Memory panel.




e To better understand context matches or the TM, refer to Leverage project TMs

on page 156.

Item

Action

Create Local

Select to create a new TM and add it to the list of available TMs.

Add Local TM or Add
Project TMs

Select and choose from the drop-down list to add to a local TM or to a project
TM.

If you choose a project TM, you can only add a TM to a locale already
assigned to the project.

Connect to Remote

Select to connect a remote TM to the project. Refer to Connect to a remote
TM on page 159 for entering information into the TM Server and WF Server
tabs. The symbolic name can be automatically populated from the URL String
for remote TM connections.

Import TM Select to import . TMX or .TXT files to a TM assigned to the project.
Open TM Select to open a TM in the TM Editor view.

Modify TM Select to modify a TM assigned to the project.

Remove TM Select to remove a TM assigned to the project.

5. (Optional) Configure the TM Update Options:

Use the search field next to a TM action to search that column above the search field

location.

Item

Action

Update Option

Select one of the TM update options from the drop-down menu:
e Append
e Do notaddtoTM
e Do not overwrite TU to retain existing TUs
e Overwrite existing TU to overwrite existing translation units (TUs)

e Overwrite if attributes are identical

Add attribute

Select to add an attribute to write to the TM for cleaned up segments.

Add file name as an
attribute

Select to add the TXLF file name as an attribute to write to the TM for
cleaned up segments.

Overwrite private TUs
(WFServer TM only)

Select to replace existing private TUs with new ones. This requires a Cleanup
password.

Write 'unedited fuzzy' to TM

Select to write fuzzy matches to the TM without user modification.

Write 'unedited
autopropagated fuzzy' to
™

Select to write automatically inserted fuzzy matches to the TM without user
modification.




Item Action

Write 'context' matches to  Select to write context matches to the TM without user modification.
™

Write 'exact' matches to TM Select to write exact matches to the TM without user modification.

Write 'unedited MT' to TM Select to write machine translation to the TM without user modification.

6. Select a Translated File Settings option for translation file creation from the drop-down list.

Item Action

Next to source with target  Select to save translated files in the same location as the source TXLF files,

language suffix in original format, after appending the target language code to the file name
as a suffix.

Inside subfolder and Select to save translated files in the same location as your TXLF files, but in a

maintain folder structure for subfolder that retains the source folder hierarchy.

folders

Do not create translated Select to prevent the creation of translated files and retain the source TXLF

files files.

7. Choose one of the following actions, when enabled for the options you selected:

Item Action

Update & Create Select to update the TM and create a translated TXLF file.
Create Translated Files Select to create a translated TXLF file without updating the TM.
Update TM Select to update the TM without creating a translated TXLF file.

8. (Optional) On the Progress Bar dialog, you can select Always run in the background to preserve the
background batch action for future analysis actions, then select Run in Background.

Analyzing document(s)

79% completed...

Always run in background

Run in Background =

9. If you chose to run Update & Create in the background, you can monitor its progress.

Background Actions °

0 If you choose to run more than one batch action in the background, each action will
have its own progress bar.

The bilingual TXLF file is converted to its original source format in the target language.



Pseudo translation

Pseudo-translation simulates the entire translation process. This is particularly useful for several situations.

¢ Use to verify successful completion of the extraction, translation, and creation of a translated file.
¢ Use to identify any text expansion issues that might occur during translation.

¢ Use to identify any font issues during creation of the translation file.

¢ Use to identify any formatting or missing content issues.

You can copy the source content to the target content to preview translatable content for target languages and the
complexity of associated formatting. This preview is particularly useful when content has accented characters and
when the content is likely to expand during translation.

{ ™
0 e Pseudo-translation requires source files in a supported file format, such
as .DOC or .TXT files.
¢ If you use Wordfast Pro in Demo Mode, the limit on processing pseudo
translation is 20 files. To simultaneously pseudo-translate more than 20 files,

obtain a Wordfast Pro license.
\. J

To pseudo-translate files:

1. In the Quick Tools view, select the Pseudo Translation tab, if it is not already selected.
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2. On the TXLF Files panel, choose one of the following actions:

To search the File Name column for a particular string, enter the search string in the

available search field next to the Search icon - on the TXLF Files panel.

Add Files Select to browse and select a file from a folder.
Add Folder Select to browse and select a folder and all its files.
Remove File(s) Select to remove a folder and all its files or all selected files from the list.

3. Select a Source Language and Target Language for the Language Selection section.

4. (Optional) In the Pseudo Translation Options section, select either or both options for creating a target file
and adding a suffix to the target filename, then select an option to either place it next to the source file or to
browse and select an alternate location.

5. Select Pseudotranslate Files.

6. (Optional) On the Progress bar dialog, you can select Always run in background to preserve the
background batch action for future analysis actions, then select Run in Background.

e ]

Analyzing document(s)

79% completed...

Always run in background

Run in Background m

7. If you chose to run Pseudotranslate Files in the background, you can monitor its progress.

-

Background Actions ° E

o If you choose to run more than one batch action in the background, each action will
have its own progress bar.

The pseudo-translation is created and a successful completion message is displayed.

Quick tools bilingual export

Use Bilingual Export to export the TXLF file with highlighted glossary terms to a .DOC or .DOCX format for edit
and translation of the content using Microsoft Word (Word).

You must not edit the exported table format. This includes merging or expanding
segments and adding text outside of the target or notes column. Editing the exported
table format will result in errors during bilingual import.

To conduct a Quick Tools bilingual export:



1. Inthe Quick Tools view, select the Bilingual Export tab, if not already selected.
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2. On the TXLF Files panel, choose one of the following actions:

To search the File Name column for a particular string, enter the search string in the

available search field next to ©~ on the TXLF Files panel.

Add Files Select to browse and select a file from a folder.
Add Folder Select to browse and select a folder and all its files.
Remove Files Select to remove a folder and all its files, or all selected files from the list.

To search the File Name column for a particular string, enter the search string in the

available search field next to ©~ on the Glossaries panel.

3. On the Glossaries panel, choose one of the following actions:

Item Action

Create Local Create a glossary on your local computer.

Add Local or Add Select and choose from the drop-down list to add to a local glossary or to a
Project Glossaries project glossary.

If you choose a project glossary, you can only add a glossary to a locale already
assigned to the project.

Import Glossary Select to import .TBX or tab-delimited files to a glossary assigned to the project.

Connect to Remote Select to connect a remote glossary to the project. Refer to Connect to a remote
glossary on page 179.

Open Select to open a glossary in the Glossary Editor view.




Item Action

Modify Select to modify a glossary assigned to the project.

Remove Select to remove a glossary assigned to the project.

4. On the Bilingual Export Options panel, choose your export options.

Option

Action

Select export type from drop-
down

Select an export type option from the drop-down list:

¢ Bilingual Review Export — Creates a bilingual Word document.

e WFC Bilingual Export (Export only) — Creates a Wordfast
Classic compatible document solely for export.

e MS-Word Table — Creates a Word document with the source
and target in a two-column table.

¢ Bilingual Review Export - WFC (allows import) — Creates a
bilingual Word document for import by Wordfast Classic users.

Open report after export

Select to automatically display the Export Report after action
completion.

Exclude the notes column

Select to remove the Notes column from the exported Word document.
Instead, the export includes the notes from the TXLF file as Comments
in the Word document.

Track changes

Select to track changes in the exported Word document.

Protect document (Word 2003+)

Select to only allow content edits in the available table space.
This helps avoid any import errors.

Export as DOCX

Select to export bilingual file to a .DOCX Word file format.

Export all TXLF files as one
bilingual file

Select to export all converted TXLF files into a single bilingual Word
document.

(Optional) Either browse to and select a Custom instructions text file, or choose any of the following options

to include in the file, using default instructions:

e App Name
e Instructions
e legend

e This document

7. Select Export Bilingual Files.

. Choose to either use the original file location, or browse and select an alternate location.



8. (Optional) On the Progress bar dialog, you can select Always run in background to preserve the
background batch action for future analysis actions, then select Run in Background.

e ]
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9. If you chose to run Export Bilingual Files in the background, you can monitor its progress.

Background Actions = E

If you choose to run more than one batch action in the background, each action will
have its own progress bar.

Each exported document is saved to the specified folder on your local computer. The example does not
include any custom content.
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3 Thiz document| provides users with Ce document| présente aux utilisatenrs les 100% H OmT:Gla &
eszential tazks associated with taches ezzentielles aszociées a TransStudio From: Glossary
TransStudio Cnline (T50) and assumes COmline (TSC) et suppose que vous Source: submission
vou are already familiar with the interface | connaissez déja l'interface ef les fonchons E;Ei:;?%:ﬁ;"
and basic software fimctions. de base du logiciel. ’
6 Uze the online help| for more details. }i,TuhSI:z I'aide en ligne| pour obtenir plus de | 100% OFRT-Glo -
étails
7 _ - — {0 ORRT:Glo -
Claim a Submission Demander une soumission 5 OFRT-Glo -
- - - - - T OFRT:-Glo -
8 Before you can access and work on your | Avant de pouvolr accéder 3 vos fichiers| et 100%
files| you must log into Project les traiter, vous devez vous connecter a OFRT:Glo ¥
Director| (PD) and use the FD Project Director | (FDY) et utilizer le tablean OFRT:Glo -
das]]]ma:d|. de bord| de PD. OFRT-Glo -

10. (Optional) View the bilingual files at the location you specified on your computer.

Quick tools bilingual import

Use Bilingual Import to re-import your translated or edited Microsoft Word (Word) bilingual export document.



Bilingual Import options allow you to open a report, accept tracked changes, and create a merged file from a
translated Word document.

You must upload both the translated or edited bilingual Word document and the
source TXLF file you used during export.

Since imports overwrite content from the export, create a backup of the original TXLF

= file for reference.
\. J

( )

0 e For bilingual files, the first number in the Counter column indicates the count of
TXLF files in the bilingual file that are paired with the added files in the TXLF
Files panel. The second number indicates the total count of TXLF files that were
used during bilingual export.

e For TXLF Files, when the bilingual Word document and the corresponding TXLF

file are paired, L is displayed. If the files are not paired, ﬂ is displayed.

\ J

To conduct a Quick Tools bilingual import:

1. Inthe Quick Tools view, select the Bilingual Import tab, if not already selected.

[#] Wordfast Pro - Quick Teols —

[m} X
'( nigues  Transcheck TMUpdate  Pseudo Transiation  Bilingual Export [EGTIWIEIUNGGN  Segment Changes  Advanced g ~ X

Bilingual Files (1/1 Selected) Bilingual Import Options
? — Optiona

:_ - D

F‘:} = ~* Open regort after import
* ~1 | File Name File Type BizE ~* Accept Tracked Changes

~1 [ Bilingual_PO_en-de. M5 Word Document (*.dac) 16KB B

~ Create merged file
- THLF files locafion: Browse...
Imiport Bilingual Files

bt

1L
Tl'!'

A



2. On the Bilingual Files panel, choose one of the following actions:

To search the File Name column for a particular string, enter the search string in the

available search field next to &’ on the Bilingual Files panel.

Add Files Select to browse and select a TXLF file from a bilingual export folder, such as
Sanpl e. txI f. doc, and add it to the Bilingual Files list.
You must select the correct file format from the drop-down list. Select MS
Word Document when uploading the bilingual Word document and WF TXLF
Document when uploading the TXLF file.

Add Folder Select to browse and select a folder and all its files from a bilingual export folder
to add to the available TXLF Files list.

Remove Files Select to remove a folder and all its files or all selected files from the list.

3. On the Bilingual Import Options panel, choose your import options.

Open report after import  Select to automatically open a report after bilingual import.
Accept Tracked Changes Select to accept tracked changes in a bilingual Word document.

Create merged file Select to create a single merged file as a bilingual Word document.

4. Browse to and select a TXLF files import location.

5. Select Import Bilingual Files.

0 Files excluded during export are ignored during import.

(o]

. (Optional) On the Progress bar dialog, you can select Always run in background to preserve the
background batch action for future analysis actions, then select Run in Background.

==

Analyzing document(s)

79% completed...

Always run in background

Run in Background m



7. If you chose to run Import Bilingual Files in the background, you can monitor its progress.

-
Background Actions '*::-

0 If you choose to run more than one batch action in the background, each action will
have its own progress bar.

The translations and edits in the bilingual export Word document are imported into the specified TXLF file on
your local computer.

The import overwrites the TXLF file content with the imported bilingual Word document
content.

Segment changes

You can run a Segment Changes Report on one or more project files to view the history of changes to a segment.
The report includes the segment ID, TM score, source and target content with the highlighted changes, username,
time stamp, and translator notes. This is particularly useful in workflows that involve multiple people.

To generate a segment changes report:

1. Inthe Quick Tools view, select the Segment Changes tab, if it is not already selected.

(] Wordfast Pro - Quick Tocls — 0 ®
| | (Iniques  Transcheck  TMUpdale  Pseudo Transiation  Bilingual Export  Bilingual Import [EECVUENITCIEINEREN  Advanced ) ~ X _|

TXLF Files (11 Selected) Segment Changes Report Options

- Dpticns

E?.? E E:Q D Bhow Columns
* ~ | File Name File Type Source Lang... | Tergel Lang... | Size Mates

~] - PD_. WFTXLFDo.. English German 3. 2 Comments

~| Ralings

. Post Edit Distance

k| Enable Difierance highlighting
nf Show all segments (including unmaodiied)

Show latest changes in each phase

Open report after export

* *) Filter Phase-name{s): -

Filter Process-names{s):
— Include all phases before selecied phase-Nameq{s)
Report name prefoc | segmentchanges
Report Location:
*) Next to Original TXLF

Custom location Browse

<4




2. On the TXLF Files panel, choose one of the following actions:

To search the File Name column for a particular string, enter the search string in the

available search field next to /- on the TXLF Files panel.

Add Files Select to browse and select a file from a folder.
Add Folder Select to browse and select a folder and all its files.
Remove Files Select to remove a folder and all its files, or all selected files from the list.

3. Select one or more files for the Segment Changes Report.

4. On the Segment Changes Report Options pane, choose from the following options:

e Show Columns option—Select any of the column options. The report does not include any columns you
do not select with this option.

e Enable Difference highlighting

e Show all segments (including unmodified)
e Show latest changes in each phase

e Open report after export

o Filter Phase-name(s)—Select a phase name from the drop-down list to filter by the project's workflow
phases.

e Filter Process-name(s)—Select a process name from the drop-down list to filter by the project's
processes.

¢ Include all phases before selected phase-Name(s)
5. (Optional) Use the default prefix of segmentchanges or enter a custom prefix.

6. Choose one of the following actions:

e Select Next to Original TXLF to save the segment changes report next to the original TXLF file.
e Browse and select the Custom location folder where you want to save the segment changes report.
7. Select Run Segment Changes.

The Segment Changes Summary is displayed.

Segment Changes Summary x
Filename Segments Segments with changes
Sample_1.dood.teml bdf 37 3
Sample_2.dood.teml bdf 37 0
Doc_Term1.xdsx.bdf 29 1
oK

8. After review, select OK.



9. (Optional) Go to the designated location and view the Segment Changes Report.

Segment Changes Report

; MT Total ed  Estin
Weighted Edit Distance Tiia8
Words? Segments Words Segments 3 j
FE-1 0.00% 669 57 742 73 0.00% 0| 00:00:00
Proof-1 1.99% 669 5 742 13 15.07% 11| 00:07:57
PostEdit-1 20.21% 642 53 742 73 72.60% 53| 00:06:37

'Weighted Edit Distance = Average PED (Post Edit Distance) of all MT segments

2 MT word count = All MT Segments including modified and un-modified
J0nly includes time actively spent on modifying segments, (Note: does not include time spent in open segments which are not modified)

Time spent reading segments if the segment was not opened in the Editor is not included.
Time spent researching concepts or topics is not included, this is known and taken into account.

File Summary

Total Segments Modified Estimated

Total

ments Words Segments  Mod Segments Time*

EH Quality Month Mailer v4 Bilingual-
MS Word_TXLF-es-
US#PR_BHMXVS # .docx. txIf

1 MT Total 1ents Modified [
Weighted Edit Distance Time?
Words? Segments Words Segments Modified %  Segments :
FE-1 0.00% 669 57 742 73 0.00% 0| 00:00:00
Proof-1 1.99% 669 a7 742 73 15.07% 11] 00:07:57
20.21% 642 53 742 713 72.60% 53] 00:06:37

PostEdit-1




16. Advanced quick tools

The Advanced tab gives you access to several advanced features, each with its own independent action or set of

actions.

Lock or unlock segments

You can quickly lock or unlock segments in the .TXLF files you select. You can lock 100% or context matches to
prevent translators or editors from making changes to them.

To lock or unlock segments:

1. Inthe Quick Tools view, select the Advanced tab, if it is not already selected.

{ Populate Uniques Transcheck TM Upedaie Peewdo Translation

TXLF Files (11 Selected)

o 6 2
~" | File Name Sourca Languags Target Language
L[5 wordfastw..  Enghish (United States)  German (Germany)

o

Size

Bilingual Export
Advanced Options
— LocioUnlock Sagmants

R Lock 100°% malches

b Lok cortext matches

— Svaap soune and targes
Chear tanget

Ramove nobas

EplitTenge THLF

Bilingual Import Begment Changes

Advanced [REEEES 4

Spii TYLF in new folder

*| Place splil files in the cdginal filas kocation

Choose location for the spi files

Solit File Options:
®| Spi after |2
Spit 1o 2
Spif atter | 2
Kerge File Oplions:

Original files location:

Update axigting fils

Chilsers\Public\Documents:

= | TUs (appro.)
= | parts (apprax)

= | words: {appron.)

Browse...

= Creale naw marpad fla

*) Merge TXLF in new falder

Choose location for the menged files

Browse...

2. On the TXLF Files panel, choose one of the following actions:

To search the File Name column for a particular string, enter the search string in the

available search field next to 2 on the TXLF Files panel.

Add Files

Select to browse and select a file from a folder.




Add Folder Select to browse and select a folder and all its files.

Remove Files Select to remove a folder and all its files, or all selected files from the list.

3. On the Lock/Unlock Segments area, select one or both of the Lock/Unlock Segments options:
e Lock 100% matches

o Lock context matches
4. Select either Unlock Segments or Lock Segments.

The segments you selected are locked or unlocked.

Swap the source and target

You can swap the source and target in translation files to create a back translation that validates the translated
content.

To swap the source and target:

1. Inthe Quick Tools view, select the Advanced tab, if it is not already selected.

{ Populate Unigques Transcheck TM Upeiate Pzewdo Translation Bilingual Export Bilingual Impost Begment Changes Advanced [N 4

TXLF Files (11 Selected) Advanced Options
- — LasiUnicek Sagmants
- = p
I:{H} ~d] E% ] Lock 100% maiches
~" | File Name Source Language Target Languape Size Lock context malches

+7 L[5 Wordfastw. . Engish (United States)  German [Germany) 4.,

— Svaap scuce and targes
kA Chear target

Remove nobes

SpditTdengs THLF
Splf THLF in new folder

8| Place tpll files in tha adginal filas kocation

Choose kocation for the spi files

Split File Options:

®| Spit after |2 = | Tus {appeo.)
Spif o 2 2 | parts (apprax)
Spiit atter |2 = | words: {appeo.)

Merge File Options:

Dﬁwﬂ files lacation: | Chllsars\PubliciDocuments Browse...
Update exsting file
s Creale FE\'-'I"'HTDEU fia

*) Merge TXHLF in new faldar

Choose location for the menged files Browse...




2. On the TXLF Files panel, choose one of the following actions:

To search the File Name column for a particular string, enter the search string in the

available search field next to the Search icon - on the TXLF Files panel.
Add Files Select to browse and select a file from a folder.
Add Folder Select to browse and select a folder and all its files.
Remove Files Select to remove a folder and all its files, or all selected files from the list.

3. On the Advanced Options panel in the Swap source and target area, select Swap.

4. (Optional) Select either or both of the following options before selecting Swap.

Clear target Select to clear target language when Swap is selected. For example, swapping
an English to German translation, German will be the source language and the
target language column will be empty.

Remove notes Select to remove all notes from each segment when Swap is selected.

The source and target content is swapped.

You can split files to break a large file into smaller files. You can set a specific number of translation units (TUs),
parts, or words the translated content for each file. For example, you can break a file of 1,000 TUs into four files of
250 TUs each. If there is a remainder, the last file contains the remnant.

You can use a file merge to either update the original file or create a new merged file.
With either option, you designate a specific location to split or merge the files to.

To split or merge a TXLF file:



1.

In the Quick Tools view, select the Advanced tab, if it is not already selected.

TMUpdate  Pseudo Translation  Bilingual Export  Bilingual Import  Segment Changes [ Lo

E TXLF Files (111 Selected) Advanced Options
= — keskiUnkek Segments
= = D
EE': F'G E—@ Lock 100% matches
ﬁ =" | File Name Source Language | Targel Language Size Lock context malches
~* | sample-Fi..  English German 3.

=

— Swap source and target

Ciaar targat

ﬁ Remove notas
R

SphMerps TXLF

Split TXLF in new fokder

oy
== Place sgi files in the anginal files location
*) Choose localion for the spiit fles CilisersiPul]  Browse..
Spiit File Opfions:
Split atter |2 - | TUs (appron}
=) Split to 5 - | parts (approx.)
Split afer |2 - | words (approx.)

Marge File Options:
Original files location: | Cillsers\Public\Documents | Browse...
Update existing file
=) Creale new merged file
Merpe TXLF in new folder

*) Choose location for the merged files | CMUIsersiPublic Browse..

¢ s

2. On the TXLF Files panel, choose one of the following actions:

To search the File Name column for a particular string, enter the search string in the

available search field nextto /~ on the TXLF Files panel.

Add Files Select to browse and select a file from a folder.
Add Folder Select to browse and select a folder and all its files.
Remove Files Select to remove a folder and all its files, or all selected files from the list.

3. On the Advanced Options panel in the Split/Merge TXLF area, select one of the following:

o Split TXLF in new folder
e Place split files in the original files location

e To Choose location for the split files, select Browse... to select a folder.



4. Select one of the following Split File Options:
e Split after x TUs (approx.)

e Split to x parts (approx.)
e Split after x words (approx.)

5. If you have already split files, you can merge them back into a single TXLF file. To do so, on the TXLF Files
panel, Add Files to be merged, then choose one of the following Merge File Options:
Original files location: Select Browse... to select the folder the original files are in.
Update existing file Select to browse and select a folder and all its files.
Create new merged file The new file will be created in the original file location.

Merge TXLF in new The merge TXLF file will be in a new folder in the original files location.
folder

Choose location for the Select Browse... to select a folder you want the merged file to be create.
merged files

6. Select either Split TXLF or Merge TXLF.

The files you selected are split into multiple . TXLF files or are merged into a single .TXLF file format.



17. Configure preferences

Preference options control the functions available to you in the user interface. Configure preferences at either the
project level or the file level.

o General Preferences

Use these to configure the user interface and TXLF Editor view preferences.

e Current Project Preferences

Use these to control settings unique to individual projects. Either you or your Project Manager can set
project preferences.

0 New Project Preferences displays if a project is not opened in the Project List view.

e User Preferences

Use these to manage your user preferences, including restoring them to the default state and exporting or
importing them.

Configure color settings

The Colors preferences control color customization for specific types of content in TXLF Editor view.

When you change preferences from the default options, select OK to activate your
selection. If you wish to return to the defaults, select Restore Defaults in Advanced
Settings.

To configure colors used in the translation table:

—

1. On the Sidebar, select the Preferences icon 2.



2. On the Preferences dialog, select Colors under General Preferences.

Preferences

General Preferences
Colors

General

Warnings

Tags
Auto-Propagation
Auto-Suggestion

Spelichecker

Current Project Preferences
Translation Memory
Terminology
Penaltles

Transcheck

' Customize the colors used in the translation table

Colors

— e

Active Segment
Auto-Propagated
Committed into TM
Context Match

Exact TM Match

Exact Term Match

Fuzzy TM Match

Fuzzy Term Match
Machine Translated
Missing Exact Term Match
Missing Fuzzy Term Match
Modified Target

Mo TM Match

Selected Term

Editor View

Editor View

Editor View

Editor View

Editar View

Editor View

Editor View

Editor View

Editor View

Editor View

Editor View

Editor View

Editar View

Editor View

P BOCRRCO0OCONDEmE

0K

Preferences

General Preferences

Customize the colors used in the translation table

Colors
General Colors
I =
Layout Active Segment Editor View [ ]
Segment Auto-Propagated Editor View |:|
Shortcuts Committed into TM Editor View 0
Warnings Context Match Editor View B
Tags Exact TM Match Editor View ]
Auta-Propagation Exact Term Match Editor View [ ]
Auto-Suggestion Fuzzy TM Match Editor View [ ]
Spellehecker Fuzzy Term Match Editor View l:l
Machine Translation
Machine Translated Editor View l:l
. Missing Exact Term Match Editor View M
Current Project Preferences
Tranelation Memory Missing Fuzzy Term Match Editor View l:l
Terminology Modified Target Editor View ]
Penaltles Mo T Match Editor View l:l
Transcheck Selacted Term Editor View ||
oK Cancel
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Preferences

General Preferences Customize the colors used in the translation table

Colors
General Colors
Item Name T - View = Color
lcons
-~
Active Segment Editor View ]
Layout
Aligned Editor View
Segment ) i
Auto-Propagated Editor View
shorteuts Client-Provided - Score 0 Editor View
Warnings Client-Provided - Score 100 Editor View
Tags Client-Provided - Score 75 Editor View
Auto-Propagation Cammitted inta TM Editor View
Auto-Suggestion Context Match Editor View
Exact TM Match Editor View
Spellchecker
Exact Term Match Editor View
Machine Translation
Fuzzy TM Match Editor View
Current Project Fuzzy Term Match Editor View
Preferences Machine Translated Editor View
Translation Memory Mizging Fvart Tarm hMatch Editar Wisw e

Cancel

Cancel
General Preferences W Customize the colors used in the translation table

Colors
General Colors
Fonts ftem Name T View Color
lcons Active Segment Editor View [ |
Layout Auto-Propagated Editor View
Segment Committed into TM Editor View
Shorteuls Context Match Editor View
Warnings Exact TM Match Editor View
Tags
0 Exact Term Match Editor View
Auto-Propagation
Fuzzy TM Match Editor View [ 1]
Auto-Suggestion
Fuzzy Term Match Editor View
Spelichecker
Machine Transated Editor View
Machine Translation
Missing Exact Term Match Editor View
- Missing Fuzzy Term Match Editor View
Mew Project Preferences
Modified Target Editor View
Replacement
TM M. 1
Translation Memory Mo TH Hatch Editor View | |
Terminology Selected Term Editor View -



Preferences

General Preferences ' Customize the colors used in the translation table
Colors
General Colors
Icons Item Name View Color
Layout Active Segment Editor View
Segment Aligned Editor View
Shorteuts Auto-Propagated Editor View
) Client-Provided - Score 0 Editor View
Warnings
Client-Provided - Score 100 Editor View
Tags
Client-Provided - Score 75 Editor View
Auto-Propagation
pag Committed into TM Editor View
Auto-Suggestion Context Match Editor View
Spellchecker Exact TM Match Editor View
Exact Term Match Editor View
Current Project ) :
Preferencesj Fuzzy TM Match Editor View
Translation Memory Fuzzy Term Match Editor View
Terminology Machine Translated Editor View
Miccing Evart Tarm Mateh Celiter Wiow M
Penalties

QK Cancel

3. Select the color box for any Iltem Name, then select another color from the color palette on the Color Picker
dialog.

4. Select OK to close the dialog.
5. Select OK.

Configure general settings

General preferences link a specific username to project-related content changes.

To customize general settings:

—

1. On the Sidebar, select the Preferences icon 2.



2. On the Preferences dialog, select General under General Preferences.

General Preferences

Colors

General

lcons

Layout

Segment
Shortcuts
Warnings

Tags
Auto-Propagation
Auto-Suggestion
Spelichecker

Machine Translation

Current Project Preferences

Translation Memory
Terminology
Penaltles

Transcheck

Preferences

General Preferences

Colors

General

Icans

Layout

Segment
Shortcuts
Warnings

Tags
Auto-Propagation
Auto-Suggestion
Spellchecker
Machine Translation

Current Project
Preferences

Translation Memory

Change general settings

Get MS Word Table Options
Show Columns: ] Segment ID
] Source

] Score

Set tag mode to: how supporied text formatfing -

Bilingual Review Export

Select Bilingual Review Expaort Options:

| Open report after export
] Exclude the notes column
] Track changes
Protect document (Word 2003+)

Export as Docx
Live Preview
W Automatically open Live preview for supported files
Remote TM

0K

Change general settings

Get MS Word Table Options

Show Columns: ! Segment ID
Source

" Score

Set tag mode to: supported text formattingile

Bilingual Review Export
Select Bilingual Review Export Optlons:
~" Open report after export
" Exclude the notes column
~ Track changes
Protect document (Ward 2003+)

Export a5 Docx
Live Preview
~" Autamatically open Live preview for supported files

Remote TM

Search Depth for WFServer TM: 200 %

Cancel



Preferences

General Preferences
Colors
General
lcons
Layout
Segment
Shortcuts
Warnings
Tags
Auto-Propagation
Auto-Suggestion
Spelichecker

Machine Translation

Current Project Preferences
Translatlon Memory
Terminology
Penaltles

Transcheck

’ Change general settings

Get MS Word Table Options
Show Columns: ] Segment ID
] Source

W1 Score

Set tag mode to: Shc:w supporied text formatiing -

Bilingual Review Export
Select Bilingual Review Expaort Options:
/1 Open report after export
| Exclude the notes column
[/ Track changes
[] Protect document (Word 2003+)
[ Export as Docx

Live Preview

] Automatically open Live preview for supported files

Remote TM

0K

Preferences

General Preferences WChange general settings
Colors
General User Name
Fonts User Name: Sample User
lcons Disclaimer
Selected user name will be placed for Notes, TM and Segment changes. For this change to take effect,
Layout please reopen your project(s) to re-establish connections.
Segment
Project Source file options
Shortcuts
() Copy Source or TXLF Files into Project Folder Structure
Warnings
() Create TXLF File with language suffix next to the Source File
Tags () Create Folder with language suffix next to the Source File where TXLF file will be stored
Auto-Propagation Disclaimer
Auto-Su rprajm Source file options will not be applied when working with Quick Projects
Spelichecker Quick Project Options
Machine Translation /! Show Open TXLF choices dialog when opening TXLF
Get MS Word Table Options
New Project Preferences op
e Show Columns: ! Segment 1D
! Source
Translation Memory
! Score
Terminology
Fisibien - Set tag mode to: | Show supported text formatting - -
oK Cancel
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Preferences

General Preferences

' Change general settings

Colors
General Get MS Word Table Options
lcons Show Columns: v Segment ID
Source
Layout
/| Score
Segment Set tag mode to: | Show supported text formatting
Shortcuts - .
Bilingual Review Export
Warnings
Select Bilingual Review Export Options:
Tags

/| Open report after export

Auto-Propagation | Exclude the notes column

i | Track changes
Auto-Suggestion
Protect document (Word 2003+)

Spellchecker Export as Docx

Current Project Preferences Live Preview
Terminolo
By +/| Automatically open Live preview for supported files
Penalties
Remote TM
Transcheck

Search Depth for WFServer TM:

200

oK Cancel

3. Enter the User Name for user identification on notes, TM, and segment changes.

4. Select one of the source file locations.

0 If the source file is a TXLF file, a copy is saved.

Option

Action

Copy Source or TXLF Files into Project Folder
Structure

Select to create a sub-folder within the project
language folder for storing source files.

Create TXLF File with language suffix next to the
Source File

Select to create a TXLF copy of the source file at the
same location with the target language code as a
suffix.

Create Folder with language suffix next to the
Source File where TXLF file will be stored

Select to create a TXLF copy of the source file in a
source file sub-folder using the target language code
as a suffix.

5. Select the Quick Project Options to show the Open TXLF choices dialog during the process of creating a

Quick Project. Refer to Open a TXLF file on page 30.



6. Select columns to include in the Get MS Word Table Options, then set the tag mode.

Option Action

Segment ID Select to include the Segment ID column in the MS
Word table.

Source Select to include the Source column in the MS Word
table.

Score Select to include the Score column in the MS Word

table.

Set Tag mode to:

Select the tag mode from the drop-down list.
e Show supported text formatting
e Show formatting as Tags

e Do not show Tags

7. Select the Bilingual Review Export options to export a file with highlighted glossary terms in a Microsoft

Word .DOC or .DOCX format.

Option

Action

Open report after export

Select to automatically open the Bilingual Report after
the export completes.

Exclude the notes column

Select to exclude the notes column from the exported
MS Word document.

Track changes

Select to enable track changes in the exported MS
Word document.

Protect document (Word 2003+)

Select to write-protect the document. This allows
users to edit only the target segment content and add
notes.

Export as Docx

Select to export the bilingual report in the
Word .DOCX file format.

Export all TXLF files as one bilingual file

Select to export all submission files as a single
bilingual file.

Option

Action

Open report after export

Select to automatically open the Bilingual Report after
the export completes.

Exclude the notes column

Select to exclude the notes column from the exported
MS Word document.

Track changes

Select to enable track changes in the exported MS
Word document.

Protect document (Word 2003+)

Select to write-protect the document. This allows
users to edit only the target segment content and add
notes.




10.

11.

12.

Option Action

Export as Docx Select to export the bilingual report in the
Word .DOCX file format.

. Select the option to display the dialog for running Quick Tools analysis and cleanup as batch actions that run

in the background.

. To automatically provide a live preview of the translated file when working in the TXLF Editor enable the Live

Preview option. This option supports MS Word .DOC and .DOCX or MS Powerpoint .PPT and .PPTX source
file formats.

Set the search depth when using the remote TM for your connected TM server type. The search depth is the
number of segment results that can be viewed for a particular search within a remote TM.

To automatically provide a live preview of the translated file when working in the TXLF Editor, enable the
Live Preview option. This option supports MS Word .DOC and .DOCX, MS Powerpoint .PPT and .PPTX, and
Markdown .MD source file formats.

Set the search depth when using the remote TM for your connected TM server type. The search depth is the
number of segment results that can be viewed for a particular search within a remote TM.

Fonts preferences control customization of font type and size for application-wide functions, such as notes.

To configure fonts:

1.

—

On the Sidebar, select the Preferences icon =i=.



2. Select Fonts under General Preferences.

wral Profarence . -
Ganaral Preferences Wcmm iz the fonts used throughout the application
Colors
Genaral Fonls
Fonts a . . .
Hem Mame Font Size Changa
leans | 1
TALF Editor Font Arial 12 -
Layout T Lookup Font arial 12
Bagment Term Lockup Font Arial 12
Shoriculs Blacklist Editor Fort Arial -
Warmifigs Preview:
Tags
Autto-Propagation The quick brown fox jumpe over the lazy dog
Auto-Suggestion
Spealichecker
Larguags Spacific Fort
Machine Tranalation v o
Hem Hams Font Sirs Add
Current Projecl Prelerences Forean Batang 1 - Hemee
T .
Replacement S B = Change
Plarvaijo Times New Roman Navajo 14 =
Translation Memory
Terminclogy Craclaimiar

Language Speciic Font seleched applias for Edior cnly

Panalties
Fant Styles (Typelace on O5SK) are nol supported by the edibes

Transcheck

Sagmentalion

Select an application-specific font and size for an item name, such as Segment History Font.

d ow

Select Change. A sample of the selected font displays in the Preview: pane.

m

Select a language-specific font.
6. Add, remove, or change the language-specific font

7. Select OK.

Configure icon settings

Icons preferences control the relative size of the icon and include or exclude the icon title.

To configure icon settings:

—
1. On the Sidebar, select the Preferences icon .



2. On the Preferences dialog, select Icons under General Preferences.

Preferences X
General Preferences | @ Customize the appearance of the icons the application ribbon

Colors |

General Icons

Fonls Seticons size:

prp— _) Large icons

(&) Medium icons

Layout Small icons

Segment | Display text
Shortcuts

Warnings

Tags

Auto-Propagation

Auto-Suggestion

Spelichecker

Machine Translation

New Project Preferences
Replacement
Translation Memory

Terminology

Preferences

General Preferences Customize the appearence of the icons the application ribbon

—————
Colors )

General Icons

lcons Set icons size:

Layout ) Large icons

Medium icons
) small icons
1 Display text

Segment
Shortcuts
Warnings

Tags
Auto-Propagation
Auto-Suggestion

Machine Translation

Current Project Preferences
Terminology
Penalties

Transcheck

0K Cancel
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Preferences

General Preferences Customize the appearance of the icons the application ribbon

Colors
lcons

General

Set icons size:
lcons Large icons

*' Medium icons
Layout e
Small icons

Segment

" Display text
Shortcuts
Warnings
Tags

Auto-Propagation

Auto-Suggestion

Spellchecker

Machine Translation

Current Project
Preferences

Translation Memory

-

General Preferences Customize the appearence of the icons the application ribbon
Colors
General Icons
" Set icons size:
Layout Large icons
*) Medium icons

Segment

g Small icons
Shortcuts ] Display text
Wamings
Tags
Auto-Propagation
Auto-Suggestion

Current Project Preferences
Terminology
Penalties

Transcheck

0K Cancel



Preferences

General Preferences

Colors

General

Icons

Layout

Segment
Shortcuts
Warnings

Tags
Auto-Propagation

Auto-Suggestion

Current Project Preferences

Terminology
Penalties

Transcheck

' Customize the appearance of the icons the application ribbon

Icons

Set icons size:
Large icons
*) Medium icons

Small icons

| Display text

3. Select a size for application icons.

4. (Optional) Clear Display text to exclude icon description text.

5. Select OK.

Configure layout options

Layout preferences control the arrangement of user interface views.

To configure layout options:

—_—

1. On the Sidebar, select the Preferences icon 2=,



2. Select Layout under General Preferences.

General Preferences

Colors

General

lcons

Layout

Segment
Shortcuts
‘Warnings

Tags
Auto-Propagation
Auto-Suggestion
Spellchecker

Machine Translatlon

Current Project Preferences

Translation Memory
Terminology
Penaltles

Transcheck

Preferences

General Preferences

Colors

General

Icons

Layout

Segment
Shortcuts
Warnings

Tags
Auto-Propagation
Auto-Suggestion
Spellchecker
Machine Translation

Current Project
Preferences

Translation Memory

Change the layout and appearancs of the application

Editor

Table View:
Hide ID Column

Hide Score Column

Hide Table Header

Score Column Position:
Before Target
®) After Target

Diff Highlight for TM Lookup/Segment History by:
*) Words

Characters

Dizclaimar

For Chinese, Japanese and Korean prejects diff highlight defaults to characters based highlight

Change the layout and appearance of the application

Editor

Table View:
Hide ID Column

Hide Score Column

Hide Table Header

score Column Position:

Before Target

=) After Target

Diff Highlight for TM Lockup/Segment History by:
= Words

Characters

Disclaimer
For Chinese, Japanese and Korean projects diff highlight defaults to characters based highlight

o | o |



General Preferences
Colors
General
lcons
Layout
Begment
Bhortcuts
Warnings
Tags
Auto-Propagation
Auto-Suggestion

Spelichecker

Current Project Preferences

Translation Memory
Terminology
Penaltles

Transcheck

Editor

Change the layout and appearance of the application

Table View:
[] Hide ID Column

[] Hide Score Column

["] Hide Table Header

Score Column Pesition:

Before Target

After Target

Diff Highlight for TM Lookup/Segment History by:

() Characters

Digclaimar

rFor Chinese, Japanese and Korean projects diff highlight defaults to characters based highlight

General Preferences
Colors
General
Fonts
Icons
Layout
Segment
Shortcuts
Warnings
Tags
Auto-Propagation
Auto-Suggestion
Spelichecker

Machine Translation

Current Project Preferences
Replacement
Translation Memory

Terminology

W Change the layout and appearance of the application

Editor

Current Project

Table View:
[] Hide ID Golumn
[] Hide Score Column

[] Hide Table Header

Score Column Position:

() Betore Target
After Target

Diff Highlight for TM Lockup/Segment History by:

Words
Characters

Dizclaimar
rFor Chinese, Japanese and Korean projects diff highlight defaults to characters bazed highlight

| Display Language Codes in Current Project View
[] Digplay Full Language Mame in the Current Project View

S o
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Preferences

General Preferences ' Change the layout and appearance of the application

Colors
General Editor
lcons Table View:

Hide ID Column
Layout Hide Score Column
Segment Hide Table Header
Shortcuts Score Column Position:

Before Target

Warnings *) After Target
Tags

Diff Highlight for TM Lookup/Segment History by:

Auto-Propagation * Words

Characters

Auto-Suggestion
Disclaimer

spellchecker For Chinese, Japanese and Korean projects diff highlight defaults to characters based highlight

Current Project Preferences

Terminology
Penalties

Transcheck

0K Cancel

3. Modify the Table View layout to hide or show columns and headers. The default setting has none of these
items selected.

4. Modify the TM Score Column Position layout for before or after the target column. The default setting is After
Target.

5. Modify the TM Difference Highlight to highlight differences in TM Lookup and Segment History tabs
based on words or characters. The default setting is Words except for CIK languages where the default is
Characters.

6. Modify the Current Project layout to include the target language name or use a language code in the view.

7. Modify the Status Bar Representation layout in the Current Project view.

Language Codes Select to include language codes on the Status Bar.
Full Language Name Select to include the complete language name on the Status Bar.
8. Select OK.

Configure segment actions

Segment Actions preferences control segment action behaviors, such as Smart Quotes or Smart Punctuation.

To configure segment actions:

—

1. On the Sidebar, select the Preferences icon =i=.



2. On the Preferences dialog, select Segment under General Preferences.

Preferences

General Preferences Configure how segment will work in the text editor

Colors
General Segment actions
Icons . . .
| Next/Previous Segment action leverages next/previous segment

Layout :

vo ~| Commit changes the segment state to Translated

nt :

Segme: ~| Open the last edited segment when opening a file
Shortcut )

orteuts | Leverage the first opened segment on click
Warnl

rmings /| Capitalize the first letter of the target segment (Except Asian languages)
T :

ags +/| Enable Smart Quotes
Auto-Propagatlo )
' atien | Copy source with number conversion
Auto-Suggestion )
| Skip locked segments
Spelichecker .
.| Skip Unedited 100% Matches

Machine Translation

| Skip Unedited Context Matches

| Commit changes the state of empty segments to Translated

Current Project Preferences ) .
Cursor position on segment opening:

Translation Memory (+ Start

Terminclogy . End

Penaltles

Transcheck | Number conversion character selection (overrides default):



Preferences

General Preferences ' Configure how segment will work in the text editor
Colors
Segment actions
General &
/' Next/Previous Segment action leverages next/previous segment
Icons
/' Commit changes the segment state to Translated
Layout
y " Open the last edited segment when opening a file
Segment Leverage the first opened segment on click
Shortcuts /' Capitalize the first letter of the target segment (Except Asian languages)
. /| Enable Smart Quotes
Warnings Q
Copy source with number conversion
Tags

Skip locked segments
Auto-Propagation

Skip Unedited 100% Matches
Auto-Suggestion Skip Unedited Context Matches
Spellchecker Commit changes the state of empty segments to Translated

. . Cursor position on segment opening:
Machine Translation

* Start
End
Current Project
Preferences Number conversion character selection (overrides default):
Translation Memory
v
< > v




Preferences

General Preferences

Colors

General

Icons

Layout

Segment
Shortcuts
Warnings

Tags
Auto-Propagation
Auto-Suggestion

Spelichecker

Current Project Preferences

Translatlon Memory
Terminology
Penaltles

Transcheck

Configure how segment will work in the text editor

Segment actions
| Mark segment signed off and move to next segment without commit
| Next/Previous Segment action leverages next/previous segment
/| Open the last edited segment when opening a file
| Leverage the first opened segment on click
/| Capitalize the first letter of the target segment (Except Asian languages)
/| Enable Smart Quotes
| Copy source with number conversion
| Skip locked segments
| Skip Unedited 100% Matches
.| Skip Unedited Context Matches
Cursor position on segment opening:
(*) Start
) End

.| Number conversion character selection (overrides default):



- ; ._
General Preferences Wmnﬂgure how segment will work in the text editor
Colors
General Segment actions
Fi .
oms M Mext/Previous Segment action leverages next/previous segment
feens & Commit changes the segment state to Translated
¥ & Open the last edited segment when opening a file
Segme | | Leverage the first opened segment on click
Shoreuts & Capitalize the first letter of the target segment (Except Asian languages)
Warnings  Enable Smart Quotes
Tags || Copy source with number conversion
Aune-Propag Skip locked segments
Auto-Suggestl .
ereuggestion || Skip Unedited 100% Matches
lchecker z
ope || Skip Unedited Context Matches
Machine Translatlon . .
| | Commit changes the state of emply segments to Translated
Cursor position on segment opening:
New Project Preferences « Start
Replacement " End
Translatlon Memory
[] Mumber conversion character selection (overrides default):
Terminclogy
Penaltles
Transcheck
Segmentation
Fllters e
+ I ¢
‘. Cancel
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Preferences

General Preferences ' Configure how segment will work in the text editor
Colors
Segment actions
General &
/| Mark segment signed off and move to next segment without commit
Icons
Next/Previous Segment action leverages next/previous segment
Layout ,
v ~/| Open the last edited segment when opening a file
Segment Leverage the first opened segment on click
Shortcuts /| Capitalize the first letter of the target segment (Except Asian languages)
. | Enable Smart Quotes
Warnings Q
Copy source with number conversion
Tags

Skip locked segments

Auto-Propagation

Skip Unedited 100% Matches

Auto-Suggestion Skip Unedited Context Matches

Spellchecker
*! Start

Current Project Preferences End

Translation Memory

Terminology

Penalties

Transcheck

3. Select a segment option.

Option

Cursor position on segment opening:

Number conversion character selection (overrides default):

W

Action

Next/Previous Segment action
leverages next/previous segment

Select to automatically leverage the TM for the segment as you
make the segment active.

Commit changes the segment state
to Translated

Select to change the segment state to Translated when you select
Commit. You can toggle back to Needs Translation by selecting
the segment state.

Open the last edited segment when
opening a file

Select to go to the last segment edited after reopening a file.

Leverage the first opened segment
on click

Select to automatically leverage the TM for the first open segment
you click after opening a file for translation.

Capitalize the first letter of the target
segment (Except Asian Languages)

Select to convert translated segments to sentence case. Not
applicable for Asian languages.

Enable Smart Quotes

Select to activate both Smart Quote and Smart Punctuation
features.



Option

Action

e Smart Quotes: Changes the quotation marks to smart
quotes, depending on the target language.

e Smart Punctuation: Changes white space and punctuation
mark elements to those appropriate for the target language,
with the exception of Chinese, Japanese, and Korean (CJK)
languages and those that read from right-to-left (RTL), such
as Arabic, Hebrew, Persian, and Urdu.

The white space group includes spaces, non-breaking spaces, and
white space representations: the middot and overring. The white
space group also includes cases where an exclamation point or
question mark exists in isolation at the beginning of the segment,
sentence, or paragraph.

Copy source with number
conversions

Select to enable suggesting the correct number conversion as the
top suggestion and copy source numbers into the target with the
correctly converted numbers for the language.

Skip locked segments

Select to enable skipping locked segments when the next segment
or previous segment action is used.

Skip Unedited 100% Matches

Select to ignore 100% matched segments.

Skip Unedited Context Matches

Select to ignore segments with context matches.

Commit changes of the state of
empty segments to Translated

Select to have all empty segments in the source show as
Translated

Cursor position on segment opening

Select to place the cursor at the beginning or end of the active
segment.

e Start: The default places the cursor at the beginning of the
segment on segment selection.

¢ End: Places the cursor at the end of the segment on
segment selection.

Number conversion character
selection (overrides default):

Select to override the default number conversion character for all
languages in the project.

¢ Digit Grouping Character: Space, Period, Comma, Non-
breaking Space, Apostrophe, or Blank

e Decimal Character: Period, or Comma

¢ Enabile digit grouping for numbers having less than five
digits: will not group numbers less than five digits, for
example: 9999.00 instead of 9,999.00

Option

Action

Mark segment signed off and move to
next segment without commit

Select to automatically mark the segment as signed off and move to
the next segment (without commit) by pressing Ctrl + Down Arrow.

Next/Previous Segment action
leverages next/previous segment

Select to automatically leverage the TM for the segment as you
make the segment active.




Option

Action

Open the last edited segment when
opening a file

Select to go to the last segment edited after reopening a file.

Leverage the first opened segment
on click

Select to automatically leverage the TM for the first open segment
you click after opening a file for translation.

Capitalize the first letter of the target
segment (Except Asian Languages)

Select to convert translated segments to sentence case. Not
applicable for Asian languages.

Enable Smart Quotes

Select to activate both Smart Quote and Smart Punctuation
features.

e Smart Quotes: Changes the quotation marks to smart
quotes, depending on the target language.

e Smart Punctuation: Changes white space and punctuation
mark elements to those appropriate for the target language,
with the exception of Chinese, Japanese, and Korean (CJK)
languages and those that read from right-to-left (RTL), such
as Arabic, Hebrew, Persian, and Urdu.

The white space group includes spaces, non-breaking spaces, and
white space representations: the middot and overring. The white
space group also includes cases where an exclamation point or
question mark exists in isolation at the beginning of the segment,
sentence, or paragraph.

Copy source with number
conversions

Select to enable suggesting the correct number conversion as the
top suggestion and copy source numbers into the target with the
correctly converted numbers for the language.

Skip locked segments

Select to enable skipping locked segments when the next segment
or previous segment action is used.

Skip Unedited 100% Matches

Select to ignore 100% matched segments.

Skip Unedited Context Matches

Select to ignore segments with context matches.

Cursor position on segment opening

Select to place the cursor at the beginning or end of the active
segment.

e Start: The default places the cursor at the beginning of the
segment on segment selection.

e End: Places the cursor at the end of the segment on
segment selection.

Number conversion character
selection (overrides default):

Select to override the default number conversion character for all
languages in the project.

¢ Digit Grouping Character: Space, Period, Comma, Non-
breaking Space, Apostrophe, or Blank
e Decimal Character: Period, or Comma



Option Action

e Enable digit grouping for numbers having less than five
digits: will not group numbers less than five digits, for
example 9999.00 instead of 9,999.00

Shortcuts preferences control keyboard shortcuts for the commands that you frequently use.

To customize keyboard shortcuts:

—

1. On the Sidebar, select the Preferences icon 2i=.



2. On the Preferences dialog, select Shortcuts under General Preferences.

General Preferences

' Customize and define your keyboard shoricuts for the application

Colors
General Shortcuts
lcons Scheme: Wordfast Pro style -
Layout
¥ ] Include Unbound Commands
Segment
Search:
Shortcuts
Select command by single clicking to assign new key combination
Warnings Commands Shortcut View
Tags About Choose Binding Editar, Project ~
Auto-Propagation Add Mote Alt+Shift+N Editor
Auto-Suggestion Add Term Ctri4+-F11 Editar
Attach/Detach Toolbar Choose Binding Editar
Machine Ti lati
chine franstation Bilingual Export Choose Binding Project
Bold Ctrl+B Editar
Current Project Preferences Chain Files Choose Binding Project
Terminology Clear Target Document Choose Binding Editor
Clear Target Segment Choose Binding Editor
Penalties
Clear all tags (Document) Choose Binding Editor (V]
Transcheck Clear all tans (Seament) il Chiftahs Editar
Description:
0K Cancel

Preferences
General Preferences Custamize and define your keyboard shortcuts for the application
Colors
General Shortcuts
Scheme: -
lcons
~! Include Unbound Commands
Layout
Search:
Segment
Select command by single clicking to assign new key combination
Shortcuts )
Commands 1 = Shortcut View -
1 -~
Warnings Add Note AltsShifteN Editor
Tags Add Term Crrl+F11 Editor
Auto-Propagation Attach/Detach Toolbar Choase Binding Editor
Auto-Suggestion Bilingual Export Choaose Binding Project
spellchecker Chain Files Choose Binding Project
_ . Clear All Tags (Document) Choose Binding Editor
Machine Translation
Clear All Tags (Segment) Crrli+Shift+v Editor o
Current Project Description:
Preferences
Translation Memory
W
< >




Preferences

General Preferences Customize and define your keyboard shertcuts for the application .
Colors
General Shortcuts
Icons Scheme: | Wordfast Pro style - |
Layout 7 Include Unbound Commands
Segment
Search: |
Shortcuts
Select command by single clicking to assign new key combination
Warmings Shortcut View
Tags About Choose Binding Editar, Project ~
Auto-Propagation Add Mote Alt+Shift+N Editor
Suggesti Add Term Ctrl+F11 Editar
Attach/Detach Toolbar Choose Binding Editor
Bilingual Export Choose Binding Project
Bold cr+B Editor
Current Project Preferences Chain Files Choose Binding Project
Terminology Clear Target Document Choose Binding Editor
Clear Target Segment Choose Binding Editor
Penalties
Clear all tags (Document) Choose Binding Editor (V]
Transcheck ear all fans [Saament) CErlShifrass Editar
Description:
0K Cancel

- e o e . -
General Preferences W Customize and define your keyboard shortcuts for the application
Colors
Genersl Shortouts
Fonts Scheme: Wordfazt Pro sty
lcons ! Include Unbound Commands
Layout
Search: |
Segment
Select command by single clicking to assign new key combination
— ot e =
Warnings Add Blacklist Alt+C Project -
Tags Add Blacklist Term Choose Binding Blacklist Editor .
Add Files Choose Binding Quick Tools, Project
Auto-Propagation
Add Folder Choose Binding Quick Tools, Project
Auto-Suggestion Add Glossary Ht+0 Quick Tools, Project
Spelichecker Add Neote Alt+Shift+N Editor
Machine Translation Add Project Ctri+Shift+A Home
Add Project Glossaries Choose Binding Quick Tools, Project
_ Add Project TMs Ctrl+5hift+B Quick Tools, Project
New Project Preferences Add Reference Files Choose Binding Project
Replacement L add T CHLN Cuiirk Toole Broiact
Translation Memory Description:
Terminology
oK Cancel
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Preferences

General Preferences

' Customize and define your keyboard shortcuts for the application

Colors
General Shortcuts
! Include Unbound Commands
Layout
Search
Segment Select command by single clicking to assign new key combination
Slimianis Commands T Shortcut View
Warnings Add Note Alt+Shift+N Editor
Tags Add Term Ctrl+F11 Editor
Auto-Propagation Attach/Detach Toolbar Choose Binding Editor
Auto-Suggestion Bilingual Export Choose Binding Project
Chain Files Choose Binding Project
Current Project Preferences Clear All Tags (Document) Choose Binding Editor
Terminology Clear All Tags (Segment) Ctrl+Shift+v Editor -
Penalties Description:
Transcheck
oK Cancel

3. Select a style Scheme from the drop-down list.

4. Select a Command from the command list and enter a new sequence of keys in the Shortcut column, then
select OK.

0 You cannot change the standard Windows keyboard shortcuts such as copy,
paste, bold, or italic. When changing or creating new shortcut key sequences, the
sequence must either begin with a Ctrl, Alt, or Shift, must use a function key, or use a
combination of these.

5. (Optional) If you choose a shortcut key sequence already in use, a warning message notifies you that it will
override the prior key sequence. Click Yes to save the new shortcut for a command.

The new shortcut key sequence is saved.

Configure warning messages

Warnings preferences control the type of warning notifications you receive.

To configure warning messages:

—_—

1. On the Sidebar, select the Preferences icon 2.



2. On the Preferences dialog, select Warnings under General Preferences.

General Preferences W Configure which wamning messages you want to see in the application
Colors
General Warnings
Fonts | Welcome message
fcons &7 No TM available waming
Layout 1 Transcheck wamings
Segment 17 Overwrite target warning
Shortcuts & Copy all sources warning
Warnings &/ End of document waming
Tags i Remove segment tags warming
Auto-Propagation 7 Remove all tags warning
furto-Suggestion &/ Remove Target waming
Spelichecker &/ Remave all target waming
Machine Translation

4 TM, glossary, blocklist Iocation change warning

| Remove Term warning

New Project Preferences /| Show duplicate shortcuts waming

Replacement _
&7 Show target with tags waming
Translation Memory
- W Terminology highlighting info message
Termi
o Y b Transcheck All Warnings
Penalties )
&/ Remove TM warning
Transcheck )
&/ Remove glossary warming
Segmentation
& Remove blocklist warning
Filters

&/ Segment unlock warning
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Preferences

General Preferences
Colors
General
lcons
Layout
Begment
Shortcuts
Warnings
Tags
Auto-Propagation

Auto-Buggestion

Current Project Preferences
Tranglation Memory
Terminology
Penalties

Transcheck

’ Configure which warning messages you want to sse in the application

Warnings
| Transcheck warnings
| Overwrite target warming
| Copy all sources waming
| End of document waming
E Remcwve segment tags warning
i Remove all tags warning
i Remowve Target warning
| Remove all target warning
| Show duplicate shortouts warning
| Show target with tags waming
| Terminclogy highlighting info message
| Transcheck All Warnings
i Remove TM warning
] Remove glossary waming
i Remove blacklist waming
b Segment unlock warning

k| Show dialog to configure Get MS Word Table Preferences
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Preferences

General Preferences

Colors

General

Icons

Layout

Segment
Shortcuts
Warnings

Tags
Auto-Propagation
Auto-Suggestion
Spellchecker

Machine Translation

Current Project
Preferences

Translation Memory

Warnings

" Transcheck warnings

" Overwrite TRFE-F"I‘ warning

" Comy re ing
Copy all sources warning

End of document warn ng

Remowve segment tags warning

" Remove all tags warning

" Remove Target warning

" Remove all tareet waming

" Show target with tags warn

Show duplicate shortouts warning

" Terminology highlighting in

o

" Transcheck All Warnings

" Remaove TM warning

Remowve glossary warning

" Remove blocklist warning

Segment unlock warning

Serment lnck/unlock all wa

ing

fa message

Frine




General Preferences
Colors
General
lcons
Layout
Segment
Shortcuts
Warnings
Tags
Auto-Propagation

Auto-Suggestion

Current Project Preferences
Terminology
Penalties

Transcheck

' Configure which warning messages you want to see in the application

Warnings
[ Transcheck warnings
[ Overwrite target warning
b Copy all sources waming
| End of document waming
| Remove segment tags warning
| Remove all tags warning
| Remove Target warning
| Remove all target warning
[ Show duplicate shortcuts warning
| Show target with tags waming
| Terminclogy highlighting info message
/| Transcheck All Warnings
| Remove TM warning
| Remove glossary waming
| Remove blacklist wamning
| Segment unlock warning

" Show dialog to configure Get MS Word Table Preferences
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Preferences
General Preferences
Colors

General

Icons

Layout

Segment
Shortcuts
Warnings

Tags
Auto-Propagation

Auto-Suggestion

Current Project Preferences

Terminology
Penalties

Transcheck

' Configure which warning messages you want to see in the application

Warnings

/| Transcheck warnings

/| Overwrite target warning

/| Copy all sources warning

/| End of document warning

/| Remove segment tags warning

/| Remove all tags warning

/| Remove Target warning

/| Remove all target warning

/| Show duplicate shortcuts warning

/| Show target with tags warning

/| Terminology highlighting info message
/| Transcheck All Warnings

/| Remove TM warning

/| Remove glossary warning

/| Remove blacklist warning

v Segment unlock warning

/| Show dialog to configure Get MS Word Table Preferences

/| Show missing spellcheck dictionary warning

3. Select your warning notifications.

4. Select OK.

Configure tags and formatting

Tags and Formatting preferences control the tag mode, representation, and font size in the TXLF Editor view.

Projects created with GlobalLink Projects (GLP) in Project Director (PD) may not
support formatting tags.

To configure tag and formatting options:

—

1. On the Sidebar, select the Preferences icon =i=.



2. On the Preferences dialog, select Tags under General Preferences.

Preferences

General Preferences ' Configure how tags and formatting are viewed and worked with in the editor

Colors
General -
Tags and Formatting
lcons Text Formatting:
Layout * Show supported text formatting
Segment ) Show formatting as Tags
Shorteuts Preview:
Warnings This is the Formatting mode.
Tags
Tag Naming:
Auto-Propagation .
! Full Name
Auto-Suggestion [ | Short Name
Spelichecker (=) Numbered Tags

Machine Translation
/| Remove incomplete tag pairs

/| Apply source segment formatting to target segment
Current Project Preferences

Translation Memory
Terminclogy
Penaltles

Transcheck



Preferences
General Preferences
Colors
General
Icons
Layout
Segment
Shortcuts
Warnings
Tags
Auto-Propagation
Auto-Suggestion
Spellchecker
Machine Translation

Current Project
Preferences

Translation Memory

' Configure how tags and formatting are viewed and worked with in the editor

Tags and Formatting

Text Formatting:

' Show supported text formatting

Show formatting as Tags

Preview:

This is the Formatting mode.

Tag Naming:
Full Name

Short Name

*' Numbered Tags

/| Remove incomplete tag pairs

| Apply source segment formatting to target segment




Preferences

e
General Preferences Configure how tags and formatting are viewed and worked with in the editor
Colors
General Tags and Formatting
lcons Text Formatting:
Layout *! Show supported text formatting
Segment ) Show formatting as Tags
Shortcuts Preview:
Warnings This is the Formatting mode.
Tags
Tag Naming:

Auto-Propagatlon -

' Full Name
Auto-Suggestion i Short Name
Spelichecker (=) Numbered Tags

/| Remove incomplete tag pairs
Current Project Preferences
Translation Memory /| Apply source segment formatting to target segment
Terminology
Penaltles

Transcheck



General Preferences

Colors

General

Fonts

lcons

Layout

Segment
SBhortcuts
Warnings

Tags
Auto-Propagation
Auto-Suggestion
Spelichecker

Machine Translation

New Project Preferences

Replacement
Translation Memory

Terminology

3

Tags and Formatting

Text Formatting:

(#) Show supported text formatting

(_) Show formatting as Tags

Preview:

This is the Formatting mode.

Tag Naming:

| Remove incomplete tag pairs

| Apply source segment formatting to target segment

WOonﬁgure heow tags and formatting are viewed and worked with in the editor

OK
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Preferences

General Preferences ' Configure how tags and formatting are viewed and worked with in the editor
Colors
General Tags and Formatting
Text Formatting:
Icons *! Show supported text formatting
Layout Show formatting as Tags
Preview:
Segment
This is the Formatting mode.
Shortcuts
Tag Naming:
Warnings Full Name
Tags Short Name

* Numbered Tags
Auto-Propagation

Auto-Suggestion | Remove incomplete tag pairs

| Apply source segment formatting to target segment
Spellchecker

Current Project Preferences
Translation Memory

Terminology

Penalties

Transcheck

3. Modify Text Formatting options.

Option Action

Show supported text Select to display formatted content in the TXLF Editor view, along with a
formatting sample of the formatted content in Preview.

Show formatting as Tags Select to display content with formatting tags in the TXLF Editor view,

along with a sample of the formatted content and tags in Preview.

4. Modify Tag Naming options.

Option Action

Full Name Select to view the tag's full name, for example Font .
Short Name Select to view the tag's short name, for example F.
Numbered Tags Select to view the tag's number, for example 3.

Remove incomplete tag pairs  Select to delete incomplete or incorrect tags from the file.

Apply source segment Select to apply segment formatting within a tag from the source segment
formatting to target segment to the target segment.




Configure auto-propagation

Auto-Propagation preferences control the automatic update of TXLF segments with specific segment status and
scores.

To configure auto-propagation:

—

1. On the Sidebar, select the Preferences icon 2=,



2. On the Preferences dialog, select Auto-Propagation under General Preferences.

General Preferences ’ Configure how Auto-Propagation options will populate segments

Colors
General Auto-Propagation
lcons
/| Enable Auto-Propagation for repefitions
Layout Enabling Auto-Propagation will update all empty target segments for the entire file.
Segment [ "] Enable Auto-Propagation across all open files
Shortcuts Use Auto-Propagation to overwrite segments containing:
Warnings [] Context matches
Tags [/ 100% matches
Auto-Propagation M Fuzzy matches
Auto-Sug on b Mo match
spellc . & Auto-propagated matches

Aiachine Trane! [ ] Edited segments
[ Machine translated segments

Current Project Preferences (] Commitied segments

Translation Memory
Terminology

Penaltles

0K Cancel




Preferences

General Preferences ' Configure how Auto-Propagation options will populate segments

Colors
Auto-Propagation
General Pag
lcons | Enable Auto-Propagation for repetitions
Enabling Aute-Propagation will update all empty target segments for the entire file.
Layout
Enable Auta-Propagation across all open files
Segment
Use Auto-Propagation to overwrite segments containing:

Shortouts Context matches

) ~" 100% matches
Warnings

~" Fuzzy matches

Tags

¢ Mo match

Auto-Propagation " duto-propagated matches
Auto-Suggestion Edited segments
spellchecker " Machine translated segments

. . Committed segments
Machine Translation

Current Project
Preferences

Translation Memory

Co e




—
General Preferences Configure how Auto-Propagation options will populate segments
Colors
General Auto-Propagation
lcons
4| Enable Auto-Propagation for repetitions
Layout Enabling Auto-Propagation will update all empty target segments for the entire file.
Segment
g [] Enable Auto-Propagation across all open files
Shortcut:
s | Auto-Propagate Comments and Ratings
Warnings Use Auto-Propagation to overwrite segments containing:
Tags [ ] Context matches
Auto-Propagation b 1009 matches
Auto-Suggestion | Fuzzy matches
Spellchecker M No match
| Auto-propagated matches
Current Project Preferences || Edited segments
Translation Memory i Machine translated segments
Terminology [] Committed segments
“—
Preferences x
General Preferences WConﬁgure how Auto-Propagation options will populate segments.
Colors
General Auto-Propagation
Fonts | Enable Auto-Propagation for repetitions
lcons Enabling Auto-Propagation will update all empty target segments for the entire file.
1 t ["] Enable Auto-Propagation across all open files
Segment Use Auto-Propagation to overwrite segments containing:
[] Context matches
Shortcuts
b 100% matches
Warnings
b Fuzzy matches
Tags
b Mo match
Auto-P ti
repagation ] Auto-propagated matches
Auto-Suggesti
Hogestion [] Edited segments
Spellchecker [ Machine translated segments
Machine Translation [] Committed segments
New Project Preferences
Replacement
Translation Memory
Terminology
KEN —
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Preferences

General Preferences ' Configure how Auto-Propagation options will populate segments

Colors
General Auto-Propagation
Icons 1 Enable Auto-Propagation for repetitions
Enabling Auto-Propagation will update all empty target segments for the entire file.
Layout g Pag: F pty targ g
Enable Auto-Propagation across all open files
Segment
Auto-Propagate Comments and Ratings
Shortcuts Use Auto-Propagation to overwrite segments containing:
Context matches
Warnings o
& 100% matches
Tags Fuzzy matches

. 7 No match
Auto-Propagation

? Auto-propagated matches
Auto-Suggestion Edited segments
Spellchecker Machine translated segments
Committed segments
Current Project Preferences

Terminology
Penalties

Transcheck

Cancel

. Select Enable Auto-Propagation for repetitions to activate additional auto-propagation options (default).

. Select Enable Auto-Propagation across all open files to allow the user to apply the proposed propagation
to all files that are open.

. Select Auto-Propagate Comments and Ratings to populate all repeated segment comments and ratings.

. Select any of the Auto-Propagation overwrite options.

Option

Action

Context matches

Select to auto-propagate unedited context match segments that are leveraged
from the translation memory (TM).

100% matches

Select to auto-propagate unedited 100% match segments that are leveraged from
the translation memory (TM). Enabled by default.

Fuzzy matches

Select to auto-propagate unedited partial match segments that are leveraged
from the translation memory (TM). Enabled by default.

No match

Select to auto-propagate the target segment for segments that have no match.
Enabled by default.

Auto-propagated
matches

Select to auto-propagate all auto-propagated matches. Enabled by default.
If there are multiple segments with the same content, editing a segment auto-
propagates the change to all matching segments.

Edited segments

Select to auto-propagate edited segments.

Machine translated
segments

Select to auto-propagate machine translated segments. Enabled by default.

Committed segments

Select to auto-propagate all translated segments that are committed to the TM.




Configure auto-suggestion

Auto-Suggestion preferences control automatic recommendations for source content, such as numbers, URLs,
and proper names. It can also recommend terms for the glossary, Translation Memory (TM) matches, and
machine translation (MT) matches.

To configure auto-suggestion:

—

1. On the Sidebar, select the Preferences icon =i=.



2. On the Preferences dialog, select Auto-Suggestion under General Preferences.

——
General Preferences Configure how features will work in the text editor

Colors )

General Auto-Suggestion

lcons ] Enable Auto-Suggestion

Layout Enable suggestions for:

Segment ] Capitalized source words

Shortcuts ] Glossary terms

Warnings ™

Tags "] TM sub-segments

Auto-Propagation [ MT

Auto-Suggestion

Spelichecker

Machine Translation

Current Project Preferences

Tranglation Memory
Terminology
Penaltles

Transcheck

oK Cancel




Preferences

Icons ' Configure how features will work in the text editor

Layout
Auto-Suggestion

Segment

” Enable Auto-Suggestion
Shortcuts

Enable suggestions for:

Warnings ! Capitalized source words
Tags /| Glossary terms

. Th
Auto-Propagation

TM sub-segments
Auto-Suggestion

MT
Spellchecker
Machine Translation

Current Project
Preferences

Translation Memory
Terminology
Penalties

Transcheck



General Preferences Configure how features will work in the text editor
Colors
General Auto-Suggestion
lcons ] Enable Auto-Suggestion
Layout Enable suggestions for:
Segment ] Capitalized source words
Shortcuts ] Glossary terms
Warnings D ™
Tags "] TM sub-segments
Auto-Propagation [ MT
Auto-Suggestion
Spelichecker

Current Project Preferences

Translation Memory

Terminology

Penaltles

oK Cancel

General Preferences W&mﬁgﬁe how features will work in the text editor
Colors
General Auto-Suggestion
Fonts | Enable Auto-Suggestion
lcons Enable suggestions for:
Layout | Capitalized source words
Segment | Glossary terms
Shortcuts [JT™
Warnings ] T™M sub-segments
Tags [IMT
Auto-Fropagation
Auto-Suggestion
Spelichecker
Machine Translation

New Project Preferences
Replacement
Translation Memory

Terminology

Copyright © 2024 Confidential Page 290 of 362



Preferences

General Preferences ' Configure how features will work in the text editor

Colors
General Auto-Suggestion
Icons /| Enable Auto-Suggestion

Enable suggestions for:
Layout

/| Capitalized source words
Segment v/ Glossary terms
Shortcuts ™

TM sub-segments
Warnings
g MT

Tags

Auto-Propagation
Auto-Suggestion

Spellchecker

Current Project Preferences

Terminology
Penalties

Transcheck

3. Select the Enable Auto-Suggestion check box and suggestion options, then select OK.

Option Action

Capitalized source Select for source segment suggestions: numbers and capitalized words only.
words

Glossary terms Select for glossary suggestions, based on the project.

™ Select for translation suggestions from the TM.

TM sub-segments Select for sub-segment translation suggestions from the TM.

MT Select for machine translation (MT) translation suggestions.

Configure and enable spellchecker

Spellchecker preferences control the interaction between the application and Microsoft Office, Hunspell, or Bing.
The Hunspell option requires software installation on your computer.

To configure and enable Spellchecker:

—

1. On the Sidebar, select the Preferences icon 2.



2. Select Spellchecker in the General Preferences group.
General Preferences wconfigum how spelichecking will work in the editor

Colors
General Spelichecking
Fonts " Enable Spelichecking
leans Check for spelling errors as you type
Layout

Choose spelichecker
Segment Microsoft Office (PC-only and if installed)
Shortcuts * Hunspell

Bing

Warnings
Tags

Auto-Propagation

Disclaimer for Bing Spell Gheck

Auto-Suggestion
age Target segments are submitted to Microsoft Bing Spell Check. Make sure this is

Spelichecker compatible with your confidentiality requirements. Bing Spell Check API goes through

constant changes and sometimes results are inconsistent.
Machine Translation

New Project Preferences
Replacement
Translation Memory

Terminology

[ T —

oK Cancel

3. Select Enable Spellchecking to activate the spellchecker in TXLF Editor. This option is selected by default,
and makes the Spellcheck File option available on the Review tab in TXLF Editor. You need to configure
the spelichecker for Microsoft Office, Hunspell, or Bing language engines. Hunspell is selected by default, and
comes with several languages already preset: English, German, French, and Spanish.

Clear Enable Spelichecking to disable the spellchecker. Disabling the spellchecker
clears all spellchecker preferences. You must reconfigure your preferences the next
time you enable Spellchecker.

e Bing requires a paid subscription.

(@ W] _
on the Sidebar, then select

To install additional Hunspell languages, select
Update Wordfast Pro. Select Check For Updates. Select the languages to update,
then select Update. You will then need to restart the application. Hunspell is available
for the following languages.

Language Code Language Code

Arabic AR Korean (South Korea) KO-KR




Language Code Language Code
Basque (Basque) EU-ES Latvian (Latvia) LV-LV
Bosnian (Bosnia) BS-BA Lithuanian (Lithuania) LT-LT
Bulgarian (Bulgaria) BG-BG Malaysian (Malaysia) MS-MY
Catalan (Catalan) CA-ES Norwegian (Bokmal Norway) NB-NO
Croatian (Croatia) HR-HR Norwegian (Nynorsk Norway) NN-NO
Czech (Czech Republic) CS-Cz Polish (Poland) PL-PL
Danish (Denmark) DA-DK Portuguese (Brazil) PT-BR
Dutch (Netherlands) NL-NL Portuguese (Portugal) PT-PT
English (Canada) EN-CA Romanian (Romania) RO-RO
English (United Kingdom) EN-GB Russian (Russia) RU-RU
English (United States) EN-US Scottish Gaelic (United Kingdom) GD-GB
Estonian (Estonia) ET-EE Serbian (Serbia) SR-RS
Farsi (Iran) FA-IR Slovak (Slovakia) SK-SK
Finnish (Finland) FI-FI Slovenian (Slovenia) SL-SI
French (Canada) FR-CA Spanish (Mexico) ES-MX
French (France) FR-FR Spanish (Spain) ES-ES
Galician (Spain) GL-ES Swedish (Sweden) SV-SE
German (Germany) DE-DE Swahili (Kenya) SW-KE
Greek (Greece) EL-GR Tagalog (Philippines) TL-PH
Hebrew (Israel) HB-IL Thai (Thailand) TH-TH
Hindi (India) HI-IN Turkish (Turkey) TR-TR
Hungarian (Hungary) HU-HU Ukrainian (Ukraine) UK-UA
Indonesian (Indonesia) ID-1D Urdu UR
Irish (Ireland) GA-IE Vietnamese (Vietnam) VI-VN
Italian (ltaly) IT-IT Welsh (United Kingdom) CY-GB
Japanese (Japan) JA-JP Zulu (South Africa) ZU-ZA
Kazakh (Kazakhstan) KK-KZ

4. Select Check for spelling errors as you type to auto-check text as you type it into TXLF Editor.

5. Select OK to save your spellchecker configuration.

Machine Translation (MT) preferences control automatic population of target segments with translations that
have no translation memory (TM) segment matches using a machine translation engine.



To configure machine translation:

—

1. On the Sidebar, select the Preferences icon 2=,



2. On the Preferences dialog, select Machine Translation under General Preferences.

General Preferences
Colors
General
lcons
Layout
Segment
Shortcuts
Warnings
Tags
Auto-Propagation
Auto-Suggestion
Spelichecker

Machine Translation

Current Project Preferences
Transiatlon Memory
Terminology

Penaltles

— =
’ Configure how machine translation engines work while you are translating

Machine Translation

— Machine Translation Behavior

(®) Show MT results in TM Lookup when there is no TM match
() Always show MT results in TM Lookup

[] Allow all unedited segments in active document to be leveraged with MT

["] Remove MT score from score column when a segment is edited

["] Enable DeepL Pro

["] Enable Google Translator

["] Enable Microsoft Translator

[] Enable SYSTRAM Pure Neural Server
["] Enable WorldLingo

["] Enable Custom MT

Disclaimer for public providers
Source segments are submitted to Machine Translation providers. Make sure this is compatible with your
confidentiality requirements. Mote that target segments (your translation) are not fed into MT providers,
they remain confidential.

0K Cancel




Preferences

lcons
Layout

Segment

Shortouts

warnings

Tags
Auto-Propagation
Auto-5ugeestion
Spellchecker
Machine Translation

Current Project
Preferences

Translation Memaory
Terminology
Penalties

Transcheck

' Configure how machine translation engines work while you are translating

Machine Translation

Machine Translation Behawiar
®' Show MT results in TM Lookup when there is no Th match

f"\.|w1_-,-\ shoay BT results in TM Loakup
Allows 2l unedited segments in active document to be levergged with M1

Femave MT score from score column when a segment is edited

Enahle Deepl Pra

Enable Gooagle Translatos

Enable Microsoft Translator

Enable SYSTHAMN Pure Meural Server
Enable WorldLingo

Enable Custom MT

Disclaimer for public providers

Source segments are submitted to Machine Translation providers. Make sure this is compatible with your
confidentiality requirements. Mote that target segments (your translation) are not fed inte MT providers,
they remain confidential



General Preferences w Configure how machine translation engines work while you are transiating

Colors
General Machine Translation
Fonts Machine Translation Behavior
lcons (®) Show MT results in TM Lookup when there is no TM match
Always show MT results in TM Lookup

Layout

Allow all unedited segments in active document to be leveraged with MT
Segment

Remowve MT score from score column when a segment is edited
Shortcuts
Warnings

Enable Deepl Fro

Tags

Enable Google Translator
Auto-Propagation
Enable Microsoft Translator

Auto-Suggestion
Enable SYSTRAM Pure Meural Server

Spelichecker
Enable WorldLingo

Machine Translation
Enable Custom MT

Disclaimer for public providers
New Project Preferences Source segments are submitted to Machine Translation providers. Make sure this is compatible with your
confidentiality requirements. Note that target segments (your translation) are not fed into MT providers,

Replacement _ )
P they remain confidential.

Translation Memory

oK Cancel

Select one of the following:
e Show MT results in TM Lookup when there is no TM match, to show machine translated content without
local or remote TM matches.

o Always show MT results in TM Lookup, to show machine translated content with leveraged segments.
TM matches display in TM Lookup with the MT matches.

Select check boxes to allow All unedited segments in active document to be leveraged with MT, and to
Remove MT score from score column when a segment is edited.

Select Enable DeepL Pro, Enable Google Translator, Enable Microsoft Translator, Enable SYSTRAN
Pure Neural Server,Enable WorldLingo or, Enable Custom MT as the primary machine translator. You can
enable all five, but you can only designate one as the primary machine translator.

Select MT options for each machine translator, then perform the designated setup tasks associated with each
machine translator.

{ )

0 WorldLingo has a limited set of source languages for MT.

e Arabic e French e Korean

e Chinese Simplified e German e Portuguese
e Chinese Traditional e Greek e Russian

e Dutch e |[talian e Spanish




English e Japanese e Swedish

Translator

Options

Enable DeepL Pro

Enable Deepl Pro
“

You nead to subscribe to Deepl Pro in order fo wse this machine translation service, After subscribing, enter your AP
key below (i l2ft blank, Deepl Pro will be disabled).

API

Farrmality: Default -

" Usa Deapl Pro as primary Test

To subscribe, please go to the Despl. Pro website,
For the list of available languages and other FAQ, pleasa check out Despls FAQ.,

Enable Google
Translator

/! Enable Google Translator

Google Translator is a paid senice, you need 1o register for it and get an API key 1o enter below (if left blank, Google
engine will be disabled).

AP| :
Use Google Premium Edition (using Neural MT for limited language pairs)
Use Google Translator as primary Test
To register, please check Google Translate API.

To access and enable Google Premium edition please check Google Translate Premium Edition AP
Premium Edition using Meural MT is only available for limited language pairs listed below. If unsupported languages
are used with Premium, Google might provide you with standard edition translations.

Available language for Google Translate
Available language for Premium Google Translate

Enable Microsoft
Tra nslator

| Enable Microsoft Translator

Micrasoft Translator API iz now available in the Azure porial under the Cognitive Services category. You nesd to
subscribe to the new service and enter the new key in the fisld below (if I2ft blank, MS Translator will be disabled).
Also, you can broaden your search by entering a category as one of the parameters.

Key: | |

4] Category Name : | |

Region: |GlobaI[Non-RegionaI] -

] Use Microsoft Translator as primary Test

Ta register, follow the link below. The free option still exists; howewver, a credit card is now required for identification.
How to sign up for Microsoft Translator on Azurs
Available language for Azure Search Service BEST API

Default option: Global (Mon-Regional)
Other options are: United States, Europe, Asia Pacific




Translator Options

Enable SYSTRAN
Pure Neural Server

] Enable SYSTRAN Pure Neural Server

You need a SYSTRAN Pure Neural Server enterprise account to use this machine translation service. Enter your
Gateway URL and API key provided by SYSTRAN below (if left blank, SYSTRAN Pure Neural Server will be
disabled).

Gateway URL :
API -

] Use SYSTRAN Pure Meural Server as primary Test

To subscribe, please go to the SYSTRAN Pure Neural Server
List of available languages

Enable WOI'|d|-in90 Enable WorldLingo

Use WorldLingo as primary Test

WorldLingo MT has a limited source language set.

Enable Custom MT

Use Custom MT for unlistec MT providers. Please refer to the MT providers API documentation for constructing the
URL and JSON Key.
URL:

JSON Key:

Header:

] Use Custom MT as pimary

If your remote Machine Translation provider is not listed as a provider tab, use the
Custom MT to create a custom connector. A Custom MT is only possible if the API of
your MT provider uses a REST standard, and returns results in JSON or similar format.
That is the case with major MT providers currently available with WFP, for example,
Google, Microsoft, WorldLingo, deeplL, etc..

Note: This section is Do-It-Yourself. Our hotline cannot assist with the customization of
an MT engine because that requires knowledge of the remote provider specifications.
Public discussion groups may offer help.

7. Select Test to validate the connection to the external machine translation provider.
8. Read the disclaimer and select OK.

Your machine translation preferences are configured.

Configure replacement

Replacement preferences allow you to select certain types of content in the source translation units (TUs) that
will be replaced with the correct target language format in the translation memory (TM). These replacements
provide better TM matches when the files are analyzed.

To enable replacements:



. -k
1. On the Sidebar, select the Preferences icon .

2. Select Replacement in the Current Project Preferences group.

Preferences x
F
General Preferences W Configure how translation memaories ars used in your projsct
Colors
General Replaceables
Fonts 4 Enable replacement of detected text in TM results for higher TM matches
lcons b Mumber replacement
Layout | URL replacement
Segment | Punctuation replacement
Shortcuts @ Email address replacement
Warnings
Tags

Auto-Propagation
Auto-Suggestion
Spelichecker

Machine Translation

Current Project Preferences
Replacement
Transglation Memory

Terminology

KN -

3. Select Enable replacement of detected text in TM results for higher TM matches, then enable specific
content type replacement options. You can select one or more options. All options are selected by default.

Options include:

e Number replacement
¢ URL replacement
e Punctuation replacement

e Email address replacement

4. Select OK.

Configure a translation memory

Translation Memory (TM) preferences control project-level TM behaviors.



To configure a translation memory:

—

1. On the Sidebar, select the Preferences icon 2=,



2. Select Translation Memory in the Current Project Preferences group.

W Configure how translation memories are used in your project

Segment state

Preferences

3EY

Shortcuts
Warnings

Tags
Auto-Propagation
Auto-Suggestion
Spelichecker

Machine Translation

Current Project Preferences
Replacement
Translation Memory
Terminology
Penalties
Transcheck
Begmentation

Filters

User Preferences

Advanced Settings

A

/| Set segments to Translated with leveraged Context Matches
/| Set segments to Translated with leveraged 100% Matches

/| Set segments to Translated for Auto-propagated segments

Translation Memory

[ ] Write 'context matches to TM
[ ] Write 'exact’ matches to TM

[] Write 'unedited MT" to TM

[] Write 'unedited fuzzy' to TM

[ ] Copy Seurce to Target en no match

Set Fuzzy TM match threshold (3):

Rsport Settings

75

Calculate analysis report percentage by:

(s) Words
) Segments

/] Calculate internal fuzzy matches and set threshold to (%) |75 2

oK
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Preferences

———

General Preferences Configure how translation memories ars used in your project

Colors

General Segment state

lcons | Set segments to Translated with leveraged Context Maiches
Layout | Set segments to Translated with leveraged 100% Matches
Segment [ Set segments to Translated for Auto-propagated segments
Shortcuts

Warnings Translation Memory

Tags [] Write 'context’ matches to TM

Auto-Propagation [] Write 'exact' matches to TM

Auto-Suggestion [] Write ‘'unedited MT" to TM

Spelichecker [] Write 'unedited fuzzy' to TM

Machine Translation

[] Copy Source to Target on no match

Current Project Preferences
Translation Memory

Terminology

oK Cancel
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Preferences

lcons
Layout

Segment
Shortcuts
Warnings

Tags
Auto-Propagation
Auto-Suggestion
Spellichecker

Machine Translation

Current Project
Preferences

Translation Memory
Terminoclogy
Penalties

Transcheck

’ Configure how translation memories are used in your project

Segment state

# Set segments to Translated with leveraged Context Matches
| Set segments to Tranczlated with leveraged 100% Matches

| Sel segments o Translated for Aulo-propagated segments

Translation Memory

Write 'context’ matches to Th
Write 'exact’ matches to TM
wWrite ‘unedived MT' to Th

Write 'unedited fuzzy' to TM

! Oy Source to arget an ng match



General Preferences ' Configure how translation memories are used in your project

Colors

General Translation Memory

lcons Write 'context’ matches to TM
Layout Write 'exact’ matches to TM
Segment Write 'unedited MT" to T
Shortcuts Write 'unedited fuzzy' to TM
Warnings

Tags

Auto-Propagation
Auto-Suggestlon

Spellchecker

Current Project Preferences

Translatlon Memory
Terminology

Penaltles

oK Cancel

3. Configure how TMs are used in your project. After all segment and TM options are selected, select OK to
activate them.

Option Action

Segment State Use these options to tell TXLF Editor how to handle segments that have high
leverage from the TM. The default setting has the following options selected.

Set segments to Translated with leveraged Context Matches — When
a translated segment has a context match from the TM, this option sets the
segment state to Translated.

Set segments to Translated with leveraged 100% Matches — When a
translated segment has a 100% Match from the TM, this option sets the segment
state to Translated.

Set segments to Translated for Auto-propagated segments — When
segment is auto-propagated, this option sets the segment state to Translated.

Translation Memory Use these options to determine TM behavior during translation in TXLF Editor.

Write 'context' matches to TM — Automatically add context matched segments
to the TM. This action changes the segment state to Translated.

Write 'exact’ matches to TM — Automatically add exact matched segments to
the TM. This action changes the segment state to Translated.




Option

Action

Write 'unedited MT' to TM — Automatically add unedited machine translated
segments to the TM. This action changes the segment state to Translated.

Write 'unedited fuzzy' to TM — Automatically add unedited fuzzy matched
segments to the TM. This action changes the segment state to Translated.

Write 'unedited autopropagated fuzzy' to TM — Automatically add unedited
autopropagated fuzzy matched segments to the TM. This option is only available
when the Write 'unedited fuzzy' to TM option is selected.

Copy source to Target on no match — Automatically copy the source content
into the target translation field when there is no matching from the TM. This
option allows the translators to replace the source text as they translate in the
target language.
Select an option from the drop-down list to specify which elements from the
source segments will be copied to the target fields:

e Copy Source

e Copy Source Text

e Copy Source, Tags And Term Translations

e Copy Source And Term Translations

e Copy Source, Tags, Source And Target Terms

e Copy Source with Source And Target Terms

Set Fuzzy match threshold (%): — Select or type the baseline percentage for
fuzzy TM matches in the percentage box. The default is 75%. This percentage
specifies the TM leverage limit for a fuzzy match. For example, with a threshold
of 75%, all segment translations between 75 to 99% match with the TM are
considered Fuzzy Match segments. Any segment matches below 75% are
considered No Match segments.

Report Settings — The settings in this box are used for narrowing the
calculations in TM analysis reports.

e Calculate analysis report percentage by: — Select either Words or
Segments. Words is the default setting.

e Calculate internal fuzzy matches and set threshold to (%) — Use this
option to calculate internal fuzzy matches in the analysis report. Internal
fuzzy matches are segments that are translated in the current project but
not yet incorporated into the TM. Select or type the threshold percentage
for internal fuzzy matches in the percentage box. The default is 75%. They
will be included in a separate report category unless the next option is
selected as well.

¢ Include internal fuzzy matches as TM matches — Select this option
to include internal fuzzy matches as fuzzy matches in the project TM
analysis. This option is only available when the previous option is
selection. Internal fuzzy matches will be included in the fuzzy match
percentage instead of broken out into a separate category.




Option

Action

When Updating an existing TU — The settings in the box determine how you
want the TM to behave when editing an existing translation unit (TU).

e Add to TM by overwriting the existing TU — This option overwrites the
previous translation in the TM.

e Add to TM; overwrite the existing TU if attributes are identical
(default) — If all attributes of the TU are identical, this option overwrites
the previous translation in the TM.

¢ Add new segments to TM; do not overwrite the existing TU — This
option adds edited segments to the TM as new segments instead of
overwriting the previously translated segment.

e Add to TM; do not overwrite the existing TU — This option adds the
translation to the TM without overwriting the existing translation. Instead of
creating a new segment, the translation will be offered as another possible
translation of the same source segment.

e Do not add to TM — Edits to existing TUs are not committed to the TM.
The segment state will remain as Needs Translation.

TM Lookup Settings — Select or type the total number of TUs to be shown in
the TM Lookup pane during translation.

Option

Action

Segment State

Use these options to tell TXLF Editor how to handle segments that have high
leverage from the TM. The default setting has the following options selected.

Set segments to Translated with leveraged Context Matches — When
a translated segment has a context match from the TM, this option sets the
segment state to Translated.

Set segments to Translated with leveraged 100% Matches — When a
translated segment has a 100% Match from the TM, this option sets the segment
state to Translated.

Set segments to Translated for Auto-propagated segments — When
segment is auto-propagated, this option sets the segment state to Translated.

Translation Memory

Use these options to determine TM behavior during translation in TXLF Editor.

Write 'context' matches to TM — Automatically add context matched segments
to the TM. This action changes the segment state to Translated.

Write 'exact' matches to TM — Automatically add exact matched segments to
the TM. This action changes the segment state to Translated.

Write 'unedited MT' to TM — Automatically add unedited machine translated
segments to the TM. This action changes the segment state to Translated.

Write 'unedited fuzzy' to TM — Automatically add unedited fuzzy matched
segments to the TM. This action changes the segment state to Translated.




Option Action

Write 'unedited autopropagated fuzzy' to TM — Automatically add unedited
autopropagated fuzzy matched segments to the TM. This option is only available
when the Write 'unedited fuzzy' to TM option is selected.

Copy source to Target on no match — Automatically copy the source content
into the target translation field when there is no matching from the TM. This
option allows the translators to replace the source text as they translate in the
target language.
Select an option from the drop-down list to specify which elements from the
source segments will be copied to the target fields:

e Copy Source

e Copy Source Text

e Copy Source, Tags And Term Translations

e Copy Source And Term Translations

e Copy Source, Tags, Source And Target Terms

e Copy Source with Source And Target Terms

Option Action

Translation Memory Use these options to determine TM behavior during translation in TXLF Editor.

Write 'context' matches to TM — Automatically add context matched segments
to the TM. This action changes the segment state to Translated.

Write 'exact’ matches to TM — Automatically add exact matched segments to
the TM. This action changes the segment state to Translated.

Write 'unedited MT' to TM — Automatically add unedited machine translated
segments to the TM. This action changes the segment state to Translated.

Write 'unedited fuzzy' to TM — Automatically add unedited fuzzy matched
segments to the TM. This action changes the segment state to Translated.

Write 'unedited autopropagated fuzzy' to TM — Automatically add unedited
autopropagated fuzzy matched segments to the TM. This option is only available
when the Write 'unedited fuzzy' to TM option is selected.

Terminology preferences control terminology lists for leveraging previously translated content.

To select terminology options:

—

1. On the Sidebar, select the Preferences icon =i=.



2. Select Terminology under Current Project Preferences. All options are enabled by default.

Preferences

General preferences Configure how glossaries are used in your project
Colors
General Terminology
lcons — Term Highlight Ssttings
Layout | Enable fuzzy term recognition
Segment E Enable term highlighting when typing terms
Shorlcuts [/ Ignore case for term highlighting
Warnings — Term Lockup Settings
Tags Mumber of terms shown in the Term Lockup pane: I:I
Auto-Propagation
Auto-Suggestion
Spellchecker

Machine Translation

Current Project Preferences
Translation Memory
Terminology
Penaltles

Transcheck

0K Cancel




Preferences

lcans ) ., , .
Configure how glossaries are used in your project

Layout
Terminology
Segment
Term Highlight Settings
shortcuts " Enable fuzzy term recognition
Warnings + Enable term highlighting when typing terms
<+ |gnnre case for term highlighting
Tags

. Term Lockup Settings
Auto-Propagation m -

Number of terms shown in the Term Lookup pane:
Auto-Suggestion
spellchecker
Machine Translation

Current Project
Preferences

Translation Memory

Terminology
Penalties
Transcheck
W
£ >
Preferences. X
General Preferences Configure how glossaries ars used in your project
Colors
General Terminology
Icons Term Highlight Settings
Layout 7| Enable fuzzy term recognition
Segment | Enable term highlighting when typing terms
shortcuts 7 Ignors case for term highlighting
Warnings. Term Lockup Setings
Tags Number of terms shown in the Term Lookup pane: | = |

Auto-Propagation
Auto-Suggestion

spelichecker

Current Project Preferences
Translation Memory
Terminology
Penalties

Transcheck

0K Cancel




-
Shortcuts W Configure how glossaries are used in your project

Warnings
Tags Terminology
Auto-Propagation erm Highlight Ssttings

| Enable fuzzy term recognition
Auto-Suggestion

i Enable term highlighting when typing terms
Spelichecker

W Ignore case for term highlighting

Machine Translation

Tearm Lockup Settings
Current Project Preferences Mumber of terms shown in the Term Lookup pane:
Replacement
Translation Memory
Terminology
Penalties
Transcheck
Segmentation

Filters

User Preferences

Advanced Setiings

0K Cancel

Preferences

General Preferences Configure how glossaries are used in your project

Colors
General Terminology
lcons Term Highlight Settings
1 Enable fuzzy term recognition
Layout +/| Enable term highlighting when typing terms
Segment 1 Ignore case for term highlighting
Shortcuts Term Lookup Settings
Number of terms shown in the Term Lookup pane:
Warnings
Tags

Auto-Propagation

Auto-Suggestion

Current Project Preferences

Terminology
Penalties

Transcheck

0K Cancel



3. Select Enable fuzzy term recognition to view fuzzy matches.

4. Select Enable term highlighting when typing terms to indicate terminology matches by highlight when
entered in the translation.

5. Select Ignore case for term highlighting to ignore case difference in terminology matches.

6. Select the number of matches you can view, then select OK.

Penalties preferences help maintain a high quality of content leveraged from a translation memory (TM). This

involves assessing a penalty to TM matches to provide a relative score for those TM matches. You can assign
a relative value to each penalty type when calculating the translation score. This score helps users differentiate
between 100% match, fuzzy match, and no match content.

To configure penalties for TM matches:

—

1. On the Sidebar, select the Preferences icon 2i=.



2. On the Preferences dialog, select Penalties under Current Project PreferencesNew Project Preferences.

General Preferences
Colors
General
lcons
Layout
Segment
Shortcuts
Warnings
Tags
Auto-Propagation
Auto-5Suggestion

Machine Translation

Current Project Preferences
Translation Memory
Terminology
Penalties

Transcheck

Preferences
Icons
Layout

Segment

Shortcuts

Warnings

Tags
Auto-Propagation
Auto-Suggestion
Spellchecker
Machine Translation

Current Project
Preferences

Translation Memory
Terminology
Penalties

Transcheck

' Configure how translation memory matches are penalized

Penalties

/| Case
] Mon Literal
] Tag
Whitespace
T Align
| Machine Transiation
Multiple Translation
Local TM
Remote TM
Private TU
FPublic TU
Secondary TM

1 Attribute

Value:

1 =
0.5 =
05 =
3 =
15 =
1 =

Iin:

L1

L1

Configure how translation memory matches are penalized

Penalties

' Case
" Mon Literal
1 Tag
Whitespace
~1 Align
» Machine Translation
Multiple Translation
Local TM
Remote TM
Private TU
Pulblic TU
Secondary TM
1 Attribute

If attribute is not

Value:

(1
08 3
0 B
3 s
15 v
1 =

Min:

L1

L1

0K Cancel
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Preferences

Replacement
Translation Memory
Terminology
Penalties
Transcheck
Begmentation

Filters

User Preferences

Advanced Settings

1

1 Machine Translation
[] Multiple Translation
[] Local TM
[] Remote TM

[] Private TU

[] Public TU
[] Secondary TM

] Attribute

General Preferences Configure how translation memory matches are penalized A
Colors
General Penalties
lcons Value: Min: Maz:
o o cae o
sogmn 1 o i TR
Shortcuts
1 Tag s =] [ 2]
Warnings
[ ] Whitespace 0 0 0
Tags
Auto-Propagation z Align =
Auto-Suggestion {1 Machine Translation 15 =
["] Multiple Translation 0
[ ] Local TM 0
Current Project Preferences
Translation Memory D Remote T ‘
Terminology [ ] Private TU 0
Penalties ["] Public TU 0
Transcheck D Secondary TM 0
1 v o v
oK Cancel
Preferences
SEY i R D e
Shortcuts WConﬁgure how translation memory matches are penalized
‘Warnings
Tags Penalties
Auto-Propagation Value: Min M
Auto-Suggestion i Cass
Spelichecker /] Mon Literal |1 2] [0 2]
Machine Translation ] Tag | 1 - | | 10 - |
] Whitespace 0.5 5
New Project Preferences
2 e

0K
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Preferences

Colors
General
lcons
Layout
Segment
Shortcuts
Warnings

Tags

Auto-Propagation

Auto-Suggestion

General Preferences

Penalties
Value: Min: Max:
| Case
] Non Literal s 5 1 = 10 =
v Tag 05 3 1 - 10 v
v Whitespace 05 = 1 = 10 =
Align
| Machine Translation 15 -

Multiple Translation

Local TM

Remote TM

Current Project Preferences

Terminology

Penalties

Transcheck

%]
i

" Private TU

Public TU

Secondary TM

Artribute

OK Cancel

3. Select a penalty, supply a threshold, then select OK.

Penalty Action

Case Select to consider differences in case.

Non Literal Select to consider differences in special characters, including
punctuation, space, apostrophe, dash, and quote.

Tag Select to consider differences in tagging.

Whitespace Select to consider differences in blank spacing.

Align Select to consider differences in translation units (TUs) with
alignment attributes.

Machine Select to consider differences in TUs based on machine

Translation translation (MT).

Multiple Select to consider differences in TUs based on duplicates within

Translation the TM with different translations.

Local TM Select to consider differences in TUs from the local desktop

copy.
TransStudio Online cannot access a local TM.

TransStudio Review cannot access a local TM.

Remote TM

Select to consider differences in TUs from a remote TM.




Penalty Action

Private TU Select to consider differences in work-group TUs from a remote
TM.

Public TU Select to consider differences in non-work-group TUs from a
remote TM.

Secondary TM Select to indicate that the translation leverages a secondary TM.

Attribute Select to consider differences in attributes.

If attribute is not Select for when a custom attribute in a TU does not match the
text box attribute.

If filename Select for when the file name attribute in a TU does not match
attribute does not the TXLF file name.
match

0 If attribute penalization is passed via GLP from PD to TSO, then Penalties will be
disabled for the project. The following message displays: "Penalties are provided in
the package for the project, manual penalization in Preferences is disabled."

Transcheck preferences control how Transcheck verifies target segments and issues warnings about common
translation errors within a project. For example, if a translated term conflicts with the designated glossary, the

Error Status icon o displays in the Status column in the TXLF Editor view.

To configure Transcheck:

—

1. On the Sidebar, select the Preferences icon =i=.

2. On the Preferences dialog, select Transcheck under Current Project PreferencesNew Project
Preferences.

{ )

0 e To search for an option, enter text in the Transcheck search field above the
options column list. To select all, select the Transcheck check box. To clear
all options, deselect the check box. Use the Up or Down Arrow keys to move
among the options, then the Spacebar to enable or disable.

e The Sub-options panel to the right of the Transcheck Options panel contains
any sub-options related to the selected category. Use the Tab key to enter and




move among the sub-options, then the Spacebar to enable or disable. To exit
the Sub-options panel, press Shift+Tab.

Preferences

General Preferences

’ Configure the Transcheck settings for your project

Caolars
General Transcheck
Transcheck segmants while translating
Layout
Transcheck Capitalization
Segment Segment Content Checks ~ | )] Al Gaps Mismatch
Shoricuts ~/ Captaizaton First Wiord Case Differance Check
\Warn! w7 Source Consistenty
inge Target Capitalization Mismatch Check
« Target Consistency
9 [ Copied Source Source Capitalizaton Mismatch Check
Aute-Fropagation ~  Empty Target Skip Exact Matchas
Aute-Suggestion Mot Skip Context Matches
Spelichecker Nurmnbesr Difference

Machine Tranzlation

Current Project Preferences

Trangkation Memaory
Terminslogy
Penalties

Transcheck

Punchuation
“  Repeated Word
Translation Length
Smart Punciuation
M Tag
w7 Whitespace
Segment Status Checks
Edited Context Match
~  Edted Exact Match
»  Edited Sourcs

Download Transcheck configuration

Msclaimer

Sourca and Targat Consistency Chack work only for Project Transcheci.
Dt haghiight defaults 1o Characters for all Chinese, Japanese and Korean Projects



Preferences

Icons Configure the Transcheck settings for your project

Layout
Transcheck
Segment
Transcheck segments while translating
Shortcuts o
heck Capitalization

Warnings Segment Content Checks A A Caps Mismatch
Tags A Capitalization First Word Case Difference Check
Autc-Propagation 7 Source Consistency Target Capitalization Mismatch Check

. i Source Capitalization Mismatch Check
Auto-Suggestion ~ Target Consistency

. Skip Fxact Matches

spellchecker Copied Source

- Skip Context Matches
Machine Translation Emply Targel

MNote

Current Project Number Difference

Preferences
Punctuation
Translation Memory
| Repeated Word

Terminology )
Translation Length
i .
Penalties Smart Punctuation w
Transcheck Download Transcheck configuration
W
< > Disclaimer -

General Freferences Configure the Transcheck settings for your project
Colors
General Transcheck
(=]
e Transcheck segments while translating
Layout
W (T hec Capitalization
Segment Segment Content Checks ~ A Al Caps Mismalch
Shorcuts w0 i
ol iR First Word Caze Difference Check
~"  Source Consstency
Warnh ¥
nas Targed Capilalization Mismalch Check
Tags ~"  Target Consistency
V¥ Coped Source Source Capiakzation Mismalch Check
AUto-Pro lan
pagat ~" Empty Target Skip Exact Matches
Aune-Sugg " ¥ Note Skip Conlext Matches
Spellchecker =" Mumber Diference
~"  PuUncTuatan
»" Repeated vinrd
Current Project Preferances
~ Transetion Length
Translatlon Memol
i ~ Smart Punctuation
Terminology ~" Tag
Penalties »  wWhitespace
Transcheck Segment Status Checks

w"  Edied Context Match
" Edted Exact Match
»"  Edted Source

Download Transcheck configuration

Diclaimer
Sourca and Targat Consistency Chack work only for Project Transcheck
Dt highibgin defauis 1o Characters for all Cranese, Japanese and Korean Propgcls W

oK Cancel



Fanis - -
leons W Configure the Transcheck settings for your project
Layout
Segment Transcheck
Shorteuts Transcheck segments while translating
Wamlngs ~1 | Transcheck Capitalization
Tags Segment Content Chacks + | 4 All Caps Mesmateh
| izatio
Auto-Propagation ‘_:_apml i g ~ First Word Case Difference Check
~|  Source Consistency
Aute-Suggestian /| Target Consistency " Target Capitalization Mismatch Check
spelichecker ] copid source 1 Source Capitalization Mismatch Check
Machine Transiation ~|  Empty Target Skip Exact Maiches
A hate Skip Context Maiches
<1 Mumber Difference
New Project Preferences A Punchustion
Replacement 1 Repeated Word
Tranelation Memory ~] Transiaton Length
Terminology <1 Smart Punctuation
Penalties M Tog
~1  Whitespace
Transcheck
c Segment 5tatus Checks
Segmentation ~ bdited Context Match
Ellters ] bdited Exact Match
~  bdited Source -
Desciarmer
User Preferences Source and Target Consistency Check work only for Project Transcheck:
Advanced Scttings Enable Spellchecking in Preferences = Spellchecker for Spelling Check to work.
- Diff highlight detauls to Characters for all Chinesa, Japaness and Korean Projects
] 3 -
oK Cancel
General Preferences Transcheck -
Colors Transcheck segments while translating
General Transcheck Capitalization
Icons Segment Content Checks = | Al Caps Mismatch
First Word Case Difference Check
Layout Sopkalizstion Target Capitalization Mismatch Check
Segment Source Consistency Source Capitalization Mismatch Check
Shortcuts Target Consistency Skip exact matches
Copied Source Skip context matches
Warnings
Empty Target
Tags
Note
Auto-Propagation Number Difference
Auto-Suggestion Punctuation
spellchecker Repeated Word
Current Project Preferences = Translation Length
Terminology Smart Punctuation r
Download Transcheck configuration
Penalties R
Transcheck Seurce and Target Consistency Check work anly for Project Transcheck
Diff highlight defaults to Characters for all Chinese, Japanese and Korean Projects
oK Cancel
Enable Transcheck segments while translating to use Transcheck during translation.
On the Transcheck Options panel, select items within any of the major categories.
a) Select items for the Segment Content Checks category.
Option Action
Capitalization Select to identify any capitalization issues for translated segments in the edited
file.
Source Consistency Select for consistency of source content across a single file or multiple edited

files.




Option

Action

Target Consistency

Select for consistency of target content across a single file or multiple edited files.

Copied Source

Select to identify any target segments that are identical to the source segment in
the edited file.

Empty Target Select to identify any empty target segments that do not contain a translation in
the edited file.
Note Select to identify any target segments in the edited file with related notes.

Number Difference

Select to compare numerical values in source and target segments in the edited
file, then identify any discrepancies.

Punctuation

Select to compare punctuation in source and target segments in the edited file,
then identify any discrepancies.

Repeated Word

Select to identify any repetitions of words or subwords in target segments within
the edited file. Repeated subwords are found using a regular expression.

Translation Length

Select to set a character length restriction on the translated segment or to check
character and word expansion percentages.

Smart Punctuation

Select to confirm the punctuation in the target segment is correct for that
language.

Tag

Select to identify any target segments in the edited file with missing tags.

Whitespace

Select to compare source and target segment white space usage in the edited
file, then identify any discrepancies.

b) Select items for the Segment Status Checks category.

Option

Action

Edited Context Match

Select to identify any changes to the context matches for translated segments in
the edited file.

Edited Exact Match

Select to identify any changes to exact matches for translated segments in the
edited file.

Edited Source

Select to identify any updates to the original segment content in the edited file.

Do Not Write To TM
Segment

Select to identify any translated segments marked not to be committed to the
translation memory.

Unedited Exact Match

Select to identify any unedited or overlooked exact match segments in the edited
file.

Unedited Fuzzy Match

Select to identify any unedited or overlooked fuzzy match segments in the edited
file.




Option

Action

Unedited MT

Select to identify all target segments that contain unedited machine translation
(MT) content in the edited file.

c) Select items for the Reference Checks category.

Option

Action

Blocklist

Select to cross-reference the available blocklist with the edited file.

Forbidden Character

Select to identify any provided forbidden characters remaining within the edited
file.

Mistranslated Text

Select to identify any mistranslated or inaccurate translation in segments within
the edited file.

Spelling

Select to identify any misspellings in translated segments within the edited file.

Terminology

Select to identify any overlooked terminology matches for translated segments in
the edited file.

Untranslatable Text

Select to identify all target segments that contain content that cannot be
translated in the edited file.

Untranslated Text

Select to identify all target segments that contain untranslated content in the
edited file.

5. Select OK.

Transcheck is configured for the current project.

Segmentation preferences control how the TXLF editor separates file content into logical segments for a project.

To select segmentation options:

—

1. On the Sidebar, select the Preferences icon 2i=.



2. Select Segmentation under Current Project Preferences.

Preferences

Shortcuts
Warnings

Tags
Auto-Propagation
Auto-Suggestion
Spelichecker

Machine Translation

Current Project Preterences
Replacement
Translation Memory
Terminology
Penalties
Transcheck
Segmentalion

Filters

User Preferences

Advanced Settings

w Configure how bilingual files are segmentad

Segmentation

- Nots -
Please note that the current segmentation changes will apply only to the newly created TXLF files, and NOT
to the already created ones.

Segmentation on break

Select segmentation type |APPLICATION -

Define end-of-segment markers (ESM)

7 l Space | Tab [ | Non-Breaking Space Line Feed | Carriage Fetum

Defing nukes for ending segments
W A number followed by an ESM
An ESM without a trailing space should end a segment
An ESM fdllowed by a space and a lower-case lelter should end a segment

Selsct abbreviations that should not be segmented on

Select a languags: English (United States) -
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B BT i
Segmentation Preview -

OK Cancel

3. Change Segmentation based on your preferences. After all segmentation preferences are selected, select

OK.

Option

Description

Segmentation on break

Select this option to enable segmentation on line breaks.

Select segmentation
type

Select APPLICATION from the drop-down list to use application-specific
segmentation rules.
Select SRX from the drop-down list to use SRX segmentation rules.

Define end-of-segment
markers (ESM)

Enter specific characters into the ESM field to specify custom segment end
characters, such as .?!..
Select checkboxes for any additional end-of-segment markers. Select as many or
as few as you prefer.
Options include:

e Space

e Tab

e Non-Breaking Space

e Line Feed

e Carriage Return

Define rules for ending
segments

Select the rules you want for ending segments. Select as many or as few as you
prefer.



Option

Description

Options include:

e A number followed by an ESM
e An ESM without a trailing space should end a segment
e An ESM followed by a space and a lower-case letter should end a segment

Select abbreviations
that should not be
segmented on

This area allows you to define which abbreviations should not be considered as
end-of-segment markers (ESM). To do so, first select a language from the Select
a language the drop-down list.

Standard abbreviations for that language will be displayed in the text box below
the language selection. You can edit, add, or delete abbreviations in the box.

In the Segmentation Preview box, type a few lines of text that contain
abbreviations or an ESM.

Select Check it out to view how the text will be segmented in the bilingual files
for translation.

Configure a file format filter

Filters preferences control the file format filters for importing source content to Wordfast Pro.

To configure a file format filter:

1. On the Sidebar, select the Preferences icon ZTE.

2. On the Preferences dialog, select Filters under Current Project Preferences.

Preferences

SEqme
Shortcuts
Warnings

Tags
Auto-Propagation
Auto-Suggestion
Spelichecker

Machine Translation

Current Project Preferences
Replacement
Translation Memory
Terminology
Penalties
Transcheck
Segmentation

Filters

User Preferences

Advanced Settings

- -
W Configure how translatable content is parsed from source files

Filters

Configuration

Extract numbers:" time_date_measure| -

Available filters Default

— Active Server Page (".asp)

Active Server Page (*.asp) L Remove
— Adobe FrameMaker Interchange Format (“.mif)

Adobe FrameMaker Interchange Format (*.mif) .

— Adobe InCopy Markup Language (%icml)

Adobe InCopy Markup Language (*.icml) .

— Adobe InDesign Interchange (*.inx)

Adobe InDesign Interchange (*.inx) 0}

Format Settinga

0K Cancel



3. Select a file format filter configuration from the Extract numbers drop-down list to define the filter action on
source segments that contain only numbers.

all Select to extract all segments with only numbers for translation.
time_date_measure Select to extract only segments with a measurement value or the time and date.
none Select to ignore any segments that contain only numeric values during extract.

4. To select the file filter settings for the open project, select a filter to list the current settings on the Format
Settings pane.

o To search the filters, enter the search string in the Available filters search field.

5. (Optional) Highlight a filter name and change settings on the Format Settings pane. The available options are
specific to the file filter you select.

6. (Optional) Add a custom file filter for a filter you need that is not already in the list by selecting Add or
Remove.

7. On the New Filter dialog, select a format from the Choose file format drop-down list to use as a template for
the new filter.

0 The Format Settings options vary, depending on the file format you choose.

= Choose a file format and enter the filter name to
display.

Choose file format:” Adobe InDesign Interchange (*imx)

Filter Mame:" Sample IMNX File Filter

Format Sattings

Fontmapping file: Browse...

0K Cancel

8. Enter a filter name in the Filter Name field, then verify your configuration is correct on the Format Settings
pane.

9. (Optional) Browse for and select any of the related Format Settings for that file format.



10. Select OK.

The file format filter you selected is configured.

Configure advanced settings

Advanced Settings preferences allow you to restore a Wordfast Pro installation to factory or default settings,
migrate preferences between computers, and customize strings.

To configure advanced settings:

1. On the Sidebar, select the Preferences icon :T=".

2. Select Advanced Settings under User Preferences.

Preferences x

W Restore, export, or import your preference settings

Default Settings

Shortcuts
Warnings

Tags

By pressing the Restore Original button, all of your preferences will
revert to their original settings at the time of installation. Please
note that once this button has been pressed, all of your customized
new project and general preferences will be lost.

Auto-Propagation Restore Original

Auto-Suggestion
Spelichecker

Machine Translation By pressing the Restore Defaults button, all of your preferences for

the current project will revert to the default new project preferences.
Please note that a project needs to be open for this button to have
any effect.

Restore Defaults

Current Project Preferences

Replacement
Translation Memory E .
xport/import Preferences Settings

Terminology

You will be able to export all the settings values that are currently

Export . -

oenatics applied in the Preferences.

Transcheck

Segmentation After implementing the setfings, they will be applied once you press
Import the OK bition in The Preferences d?alog.

Filters

User Preferences
Customization String List
Advanced Settings

= Dizclaimsr =

OK Cancel

3. Change Advanced Settings based on your preferences.

Option Description

Default Settings Restore Original reverts all the preferences to their original factory settings.
Once you select this option, all general preferences and custom new project
preferences will be lost.

Restore Defaults reverts the preferences only for the current project to the
default new project preferences.

You must have a project open for this option to take effect.

Export/import
Preferences Settings

Export allows you to export the settings values that you currently have applied in
Preferences for general settings and for a current project. You can select specific



Option

Description

preferences or export them all. You will be asked to browse to a path where the
export file will be saved with a .pref extension.

Import allows you to browse to a saved .pref file and import it. When the file is
selected, a dialog displays the preferences that will be imported. The imported
settings will not be activated in Preferences until you select OK.

Customization String
List

This field is primarily for developer's use. Select the Plus icon ¥, type an option
in the Customization String List field, then select OK. Highlight an option and

select the Minus icon = to delete it from the list.
You must restart the application for the customized strings to be applied or
removed.




This topic includes the keyboard shortcuts that are available for PC and Apple users for Wordfast Pro, Wordfast
Classic, SDLX, and Trados.

PC scheme:

e PC scheme - Wordfast Pro style on page 327

e PC scheme - Wordfast Classic style on page 331
e PC scheme - SDLX style on page 334

e PC scheme - Trados style on page 338

Mac scheme:

e Mac scheme - Wordfast Pro style on page 341

¢ Mac scheme - Wordfast Classic style on page 346
e Mac scheme - SDLX style on page 349

¢ Mac scheme - Trados style on page 353

This section only includes shortcuts with a default application-assigned keystroke

sequence.

Commands Shortcut View
Add Blocklist Alt+C Project
Add Glossary Alt+O Project
Add Note Alt+Shift+N Editor
Add Project Ctrl+Shift+A Home
Add Project TMs Ctrl+Shift+B Quick Tools
Add Term Ctrl+Alt+T Editor
Add TM CtrlI+N Project
Analyze Ctrl+Space Editor
Attach/Detach Toolbar Ctrl+D Editor
Bold Ctrl+B Editor
Clear all tags (Segment) Ctrl+Shift+V Editor
Clear Target Document Alt+Shift+Delete Editor
Clear Target Segment Ctri+Alt+X Editor
Close Ctrl+W Editor
Close project from home window Ctrl+Shift+X Home
Close segment Esc Editor




Commands Shortcut View

Commit All Segments to TM Ctrl+Alt+End Editor

Commit Current Segment Alt+End Editor

Confirm/Unconfirm Segment Alt+Enter Editor

Confirm All Segments Ctrl+Shift+Enter Editor

Copy CtrlI+C Blocklist Editor, TM Editor, Glossary Editor, Editor

Copy All Sources Ctrl+Alt+Insert Editor

Copy All Tags (Document) Alt+Shift+P Editor

Copy All Tags (Segment) Alt+A Editor

Copy selected text to target Alt+F12 Editor

Copy Source Alt+S Editor

Copy Tag Ctrl+Alt+Down Editor

Copy Term Ctrl+0 Editor

Copy TM Ctrl+Shift+C Project

Create Blocklist Alt+B Project

Create Glossary Alt+N Project

Create TM Ctrl+Shift+N Project

Current Segment Leverage Alt+- Editor

Cut Ctrl+X Blocklist Editor, TM Editor, Glossary Editor, Editor

Delete Note Alt+Shift+D Editor

Edit Note Alt+Shift+E Editor

Edit Term Ctrli+E Editor

Export Blocklist Alt+K Project

Export Glossary Alt+E Project

Export Report as PDF format Alt+U Project

Export TM Ctrl+Shift+E Project

Find/Replace Ctrl+F Editor

Get Bilingual Table Ctrl+Alt+P Editor

Go To Segment Ctrl+G Editor

Help Ctrl+Alt+H Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Import Blocklist Alt+J Project

Import Glossary Alt+l Project

Import TM Ctrl+Shift+ Project




Commands Shortcut View
Insert a cent sign Ctrl+; Editor
Insert Copyright Symbol Ctri+Alt+C Editor
Insert Ellipsis Ctri+Alt+. Editor
Insert em dash Alt+Shift+- Editor
Insert en dash F10 Editor
Insert non-breaking hyphen Ctrl+Shift+- Editor
Insert non-breaking space Ctrl+Shift+Space Editor
Insert Registered Trademark CtrI+Alt+R Editor
symbol
Italic Ctri+l Editor
Key Assist Panel Ctrl+Shift+L Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home
Last Modified Segment Shift+F5 Editor
Leverage Previous TU Alt+Left Editor
Leverage the first TM Lookup Alt+1 Editor
match
Leverage the second TM Alt+2 Editor
Lookup match
Leverage the third TM Lookup  Alt+3 Editor
match
Leverage the fourth TM Lookup  Alt+4 Editor
match
Leverage the fifth TM Lookup Alt+5 Editor
match
Leverage the sixth TM Lookup  Alt+6 Editor
match
Leverage the seventh TM Alt+7 Editor
Lookup match
Leverage the eighth TM Lookup Alt+8 Editor
match
Leverage the Next TU Alt+Right Editor
Machine Translate Ctrl+Shift+M Editor
Merge Segments Alt+Page_Down Editor
Modify Alt+M Project
Modify TM Ctrl+Shift+T Project




Commands Shortcut View

Move the cursor between the Shift+Tab Editor

source and the target

Next Needs Translation Ctrl+Enter Editor

Segment

Next Segment (Committo TM)  Alt+Down Editor

Next Segment (No Commit) Ctrl+Down Editor

Next Tag Ctrl+Alt+Right Editor

Next Term Ctrl+9 Editor

Next View Alt+W Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Open Blocklist Alt+H Project

Open Glossary Alt+G Project

Open Project Ctrl+Shift+P Home

Open TM Ctrl+Shift+G Project

Paste Ctrl+V Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Preferences F9 Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Previous Segment (No Commit) Ctrl+Up Editor

Previous Segment (TM Commit) Alt+Up Editor

Previous Tag Ctri+Alt+Left Editor

Previous Term Ctrl+8 Editor

Pseudo Translate Ctrl+Shift+Y Quick Tools

Quick Tools Alt+Q Home

Redo Ctrl+Y Blocklist Editor, TM Editor, Glossary Editor, Editor

Remove Glossary Alt+R Project

Remove Reference Files Alt+0 Project

Remove Report Alt+Z Project

Remove TM Ctrl+Shift+R Project

Replace/Find Ctrl+H Editor

Run Transcheck Ctrl+Shift+Q Editor

Save Ctrl+S Editor

Save As F12 Editor

Save File As Translated Ctrl+Alt+S Editor

Show White Space Characters  Ctrl+Shift+8 Editor




Commands Shortcut View
Simple Project Creator Ctrl+P Home
Source TM Lookup Ctrl+Shift+F Editor
Spell Check F7 Editor
Split Segment Alt+Page_Up Editor
Strikethrough Ctrl+K Editor
Subscript Ctrl+= Editor
Superscript Ctrl+Shift+= Editor
Term Info Alt+T Editor
Terminology Highlight Ctrl+F5 Editor
TM Concordance F8 Editor
Toggle uppercase/lowercase Shift+F3 Editor
Translate All Ctrl+Shift+End Editor
Translate File CtrI+O Project
Translate Until Fuzzy Ctrl+Alt+F Editor
Translate Until No Match Ctrl+Shift Editor
+Page_Down
Unconfirm All Segments Alt+Shift+Enter Editor
Underline Ctrl+U Editor
Undo Ctrl+Z Blocklist Editor, TM Editor, Glossary Editor, Editor
Verify Segment Ctri+Alt+V Editor
This section only includes shortcuts with a default application-assigned keystroke
sequence.
Commands Shortcut View
Add Blocklist Alt+C Project
Add Glossary Alt+O Project
Add Project Ctrl+Shift+A Home
Add Project TMs Ctrl+Shift+B Quick Tools
Add Reference Files Alt+1 Project
Add Term Ctrl+Alt+T Editor
Add TM CtrlI+N Project




Commands Shortcut View

Analyze Ctrl+Space Quick Tools

Attach/Detach Toolbar Ctrl+D Editor

Bold Ctrl+B Editor

Clear Target Document Alt+Shift+Delete Editor

Clear Target Segment Ctri+Alt+X Editor

Close project from home window Ctrl+Shift+X Home

Commit All Segments to TM Ctrl+Alt+End Editor

Commit Current Segment Alt+Q Editor

Confirm/Unconfirm Segment Alt+Enter Editor

Confirm All Segments Ctrl+Shift+Enter Editor

Copy CtrlI+C Blocklist Editor, TM Editor, Glossary Editor, Editor

Copy All Sources Ctrl+Alt+Insert Editor

Copy All Tags (Segment) Alt+P Editor

Copy Source Alt+Insert Editor

Copy Tag Alt+Shift+Down Editor

Copy Tag Ctrl+Alt+Down TM Editor

Copy Term Ctrl+Alt+0 Editor

Copy TM Ctrl+Shift+C Project

Create Blocklist Alt+B Project

Create Glossary Alt+N Project

Create TM Ctrl+Shift+N Project

Current Segment Leverage Alt+- Editor

Cut Ctrl+X Blocklist Editor, TM Editor, Glossary Editor, Editor

Export Blocklist Alt+K Project

Export Glossary Alt+E Project

Export Package Ctrl+E Home

Export Report as PDF format Alt+U Project

Export TM Ctrl+Shift+E Project

Find/Replace Ctrl+F Editor

Go To Segment Ctrl+G Editor

Help Ctri+Alt+H Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Import Blocklist Alt+J Project




Commands Shortcut View

Import Glossary Alt+l Project

Import TM Ctrl+Shift+l Project

Insert non-breaking space Ctrl+Shift+Space Editor

Italic Ctri+l Editor

Key Assist Panel Ctrl+Shift+L Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Last Modified Segment Shift+F5 Editor

Leverage Previous TU Alt+Left Editor

Leverage the Next TU Alt+Right Editor

Merge Segments Alt+Page_Down Editor

Modify Alt+M Project

Modify Project Ctrl+Shift+M Home

Modify TM Ctrl+Shift+T Project

Next Segment (No Commit) Ctrl+Down Editor

Next Tag Ctri+Alt+Right Editor

Next Term Ctrl+Alt+9 Editor

Next Update Alt+Down Blocklist Editor

Next View Alt+W Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Open Blocklist Alt+H Project

Open Glossary Alt+G Project

Open Project Ctrl+Shift+P Home

Open Reference Files Alt+2 Project

Open TM Ctrl+Shift+G Project

Paste Ctrl+V Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Preferences F9 Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Previous Segment (TM Commit) Alt+Up Editor

Previous Tag Ctri+Alt+Left Editor

Previous Term Ctrl+Alt+8 Editor

Pseudo translate Ctrl+Shift+Y Quick Tools

Redo Ctrl+Y Blocklist Editor, TM Editor, Glossary Editor, Editor

Remove Glossary Alt+R Project




Commands Shortcut View
Remove Project Ctri+Alt+R Home
Remove Reference Files Alt+0 Project
Remove Report Alt+Z Project
Remove tag Ctrl+Alt+Up Editor
Remove TM Ctrl+Shift+R Project
Replace/Find Ctrl+H Editor
Save Ctrl+S Editor
Save As F12 Editor
Save File As Translated Ctrl+Alt+S Editor
Show White Space Characters  Ctrl+Shift+8 Editor
Simple Project Creator Ctrl+P Home
Spell Check F7 Editor
Split Segment Alt+Page_Up Editor
Strikethrough CtrlI+K Editor
Subscript Ctrl+= Editor
Superscript Ctrl+Shift+= Editor
Term Info Alt+T Editor
Terminology Highlight Ctrl+F5 Editor
TM Concordance Ctrl+Shift+F Editor
Translate File Ctrl+O Project
Translate Until Fuzzy Ctri+Alt+F Editor
Translate Until No Match Ctrl+Shift Editor
+Page_Down
Unconfirm All Segments Alt+Shift+Enter Editor
Underline Ctrl+U Editor
Undo Ctri+Z Blocklist Editor, TM Editor, Glossary Editor, Editor
Verify Segment Ctri+Alt+V Editor

This section only includes shortcuts with a default application-assigned keystroke

sequence.



Commands Shortcut View

Add Blocklist Alt+C Project

Add Glossary Alt+O Project

Add Note Alt+Shift+N Editor

Add Project Ctrl+Shift+A Home

Add Project TMs Ctrl+Shift+B Quick Tools
Add Term Ctrl+AIt+T Glossary Editor
Add Term Ctrl+T Editor

Add TM CtrlI+N Project
Analyze Ctrl+Space Editor
Attach/Detach Toolbar Ctrl+D Editor

Bold Ctrl+B Editor
Clear Target Document Alt+Shift+Delete Editor
Clear Target Segment Ctrl+Alt+X Editor
Close Ctrl+Shift+W Editor
Close project from home window Ctrl+W Home
Commit All Segments to TM Alt+End Editor
Commit Current Segment Alt+Q Editor
Confirm/Unconfirm Segment Alt+Enter Editor
Confirm All Segments Ctrl+Shift+Enter Editor

Copy CtrlI+C Blocklist Editor, TM Editor, Glossary Editor, Editor
Copy All Sources Ctri+Alt+Insert Editor

Copy All Tags (Document) Alt+Shift+P Editor

Copy All Tags (Segment) Alt+P Editor

Copy selected text to target Alt+F12 Editor

Copy Source F4 Editor

Copy Tag Ctrl+Alt+Down Editor

Copy Term Ctrl+Alt+0 Editor

Copy TM Ctrl+Shift+C Project
Create Blocklist Alt+B Project
Create Glossary Alt+N Project
Create TM Ctrl+Shift+N Project
Current Segment Leverage F8 Editor

Cut Ctrl+X Blocklist Editor, TM Editor, Glossary Editor, Editor




Commands Shortcut View

Delete Note Alt+Shift+D Editor

Edit Note Alt+Shift+E Editor

Edit Term Ctrli+E Editor

Export Blocklist Alt+K Project

Export Glossary Alt+E Project

Export Report as PDF format Alt+U Project

Export TM Ctrl+Shift+E Project

Find/Replace Ctrl+F Editor

Go To Segment Ctrl+L Editor

Help Ctrl+Alt+H Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Import Blocklist Alt+J Project

Import Glossary Alt+l Project

Import TM Ctrl+Shift+ Project

Insert copyright symbol Ctri+Alt+C Editor

Insert ellipsis F11 Editor

Insert em dash Ctrl+F10 Editor

Insert en dash F10 Editor

Insert non-breaking hyphen Ctrl+F9 Editor

Insert non-breaking space Ctrl+Shift+Space Editor

Insert Registered Trademark CtrI+Alt+R Editor

symbol

Italic Ctrl+l Editor

Key assist panel Ctrl+Shift+L Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Last Modified Segment Shift+F5 Editor

Leverage previous TU Alt+Left Editor

Leverage the first TM Lookup Alt+1 Editor

match

Leverage the second TM Alt+2 Editor

Lookup match

Leverage the third TM Lookup  Alt+3 Editor

match

Leverage the fourth TM Lookup  Alt+4 Editor

match




Commands Shortcut View

Leverage the fifth TM Lookup Alt+5 Editor

match

Leverage the 6th TM Lookup Alt+6 Editor

match

Leverage the 7th TM Lookup Alt+7 Editor

match

Leverage the 8th TM Lookup Alt+8 Editor

match

Leverage the Next TU Alt+Right Editor

Machine Translate Ctrl+Shift+F8 Editor

Merge Segments Ctrl+J Editor

Modify Alt+M Project

Modify Project Ctrl+Shift+M Home

Modify TM Ctrl+Shift+T Project

Move the cursor between the Shift+Tab Editor

source and the target

Next Segment (Committo TM)  Alt+Down Editor

Next Segment (No Commit) Ctrl+Down Editor

Next Tag Ctri+Alt+Right Editor

Next Term Ctrl+Alt+9 Editor

Next View Alt+W Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Open Blocklist Alt+H Project

Open Glossary Alt+G Project

Open Project Ctrl+Shift+P Home

Open TM Ctrl+Shift+G Project

Paste Ctrl+V Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Preferences F9 Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Previous Segment (No Commit) Ctrl+Up Editor

Previous Segment (TM Commit) Alt+Up Editor

Previous Tag Ctri+Alt+Left Editor

Previous Term Ctrl+Alt+8 Editor

Pseudo Translate Ctrl+Shift+Y Quick Tools




Commands Shortcut View
Redo Ctrl+Y Blocklist Editor, TM Editor, Glossary Editor, Editor
Remove Glossary Alt+R Project
Remove Reference Files Alt+0 Project
Remove Report Alt+Z Project
Remove Tag Ctrl+Alt+Up Editor
Remove TM Ctrl+Shift+R Project
Replace/Find Ctrl+H Editor
Run Transcheck F12 Editor
Save Ctrl+S Editor
Save File As Translated Ctrl+Alt+S Editor
Show White Space Characters  Ctrl+Shift+8 Editor
Simple Project Creator CtrlI+P Home
Source TM Lookup Ctrl+Shift+F Editor
Spell Check F6 Editor
Split Segment Ctrl+Enter Editor
Strikethrough CtrlI+K Editor
Subscript Ctrl+= Editor
Superscript Ctrl+Shift+= Editor
Term Info Alt+T Editor
Terminology Highlight Ctrl+F5 Editor
TM Concordance F7 Editor
Toggle uppercase/lowercase Shift+F3 Editor
Translate All Ctrl+Shift+End Editor
Translate File CtrI+O Project
Translate Until Fuzzy Ctri+Alt+F Editor
Translate Until No Match Ctrl+Shift Editor
+Page_Down
Unconfirm All Segments Alt+Shift+Enter Editor
Underline Ctrl+U Editor
Undo Ctrl+Z Blocklist Editor, TM Editor, Glossary Editor, Editor
Verify Segment Ctrl+Alt+V Editor




This section only includes shortcuts with a default application-assigned keystroke

sequence.

Commands Shortcut View

Add Blocklist Alt+C Project

Add Glossary Alt+O Project

Add Project TMs Ctrl+Shift+B Quick Tools
Add Reference Files Alt+1 Project

Add Term CtrI+Al+T Glossary Editor
Add Term Ctrl+F11 Editor

Add T™M Ctrl+N Project
Analyze Ctrl+Space Quick Tools
Attach/Detach Toolbar Ctrl+D Editor

Bold Ctrl+B Editor
Clear Target Document Alt+Shift+Delete Editor
Clear Target Segment Ctri+Alt+X Editor
Close Ctrl+W Editor
Close project from home window Ctrl+Shift+X Home
Commit All Segments to TM Ctrl+Shift+U Editor
Commit Current Segment Alt+Q Editor
Confirm/Unconfirm Segment Alt+Enter Editor
Confirm All Segments Ctrl+Shift+Enter Editor

Copy CtrlI+C Blocklist Editor, TM Editor, Glossary Editor, Editor
Copy All Tags (Segment) Alt+P Editor

Copy selected text to target Alt+F12 Editor

Copy Source F4 Editor

Copy Tag Ctrl+F4 Editor

Copy Term Ctrl+Alt+Down Editor

Copy TM Ctrl+Shift+C Project
Create Blocklist Alt+B Project
Create Glossary Alt+N Project
Create TM Ctrl+Shift+N Project
Current Segment Leverage Alt+Space Editor

Cut Ctrl+X Blocklist Editor, TM Editor, Glossary Editor, Editor




Commands Shortcut View

Export Blocklist Alt+K Project

Export Glossary Alt+E Project

Export Package Ctri+E Home

Export Report as PDF format Alt+U Project

Export TM Ctrl+Shift+E Project

Go To Segment Ctrl+L Editor

Help Ctri+Alt+H Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Import Blocklist Alt+J Project

Import Glossary Alt+l Project

Import TM Ctrl+Shift+l Project

Insert en dash F10 Editor

Insert non-breaking space Ctrl+Shift+Space Editor

Italic Ctrl+l Editor

Key Assist Panel Ctrl+Shift+L Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Last Modified Segment Shift+F5 Editor

Machine Translate Ctrl+Shift+F8 Editor

Merge Segments Ctrl+J Editor

Modify Alt+M Project

Modify Project Ctrl+Shift+M Home

Modify TM Ctrl+Shift+T Project

Move the cursor between the Shift+Tab Editor

source and the target

Next Segment (Committo TM)  Enter Editor

Next Segment (No Commit) Ctrl+Down Editor

Next Tag Ctri+Alt+Right TM Editor

Next Update Alt+Down Blocklist Editor

Next View Alt+W Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Open Blocklist Alt+H Project

Open Glossary Alt+G Project

Open Project Ctrl+Shift+P Home

Open Reference Files Alt+2 Project




Commands Shortcut View

Open TM Ctrl+Shift+G Project

Paste Ctrl+V Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Preferences F9 Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Previous Tag Ctri+Alt+Left Editor

Previous Update Alt+Up Blocklist Editor

Pseudo Translate Ctrl+Shift+Y Quick Tools

Redo Ctrl+Y Blocklist Editor, TM Editor, Glossary Editor, Editor

Remove Glossary Alt+R Project

Remove Project Ctrl+Alt+R Home

Remove Reference Files Alt+0 Project

Remove Report Alt+Z Project

Remove TM Ctrl+Shift+R Project

Save Ctrl+S Editor

Save File As Translated Ctrl+Alt+S Editor

Show White Space Characters  Ctrl+Shift+8 Editor

Simple Project Creator Ctrl+P Home

Source TM Lookup Ctrl+Shift+F Editor

Spell Check F6 Editor

Split Segment Alt+S Editor

Strikethrough Ctrl+K Editor

Subscript Ctrl+= Editor

Superscript Ctrl+Shift+= Editor

Term Info Alt+T Editor

Terminology Highlight Ctrl+F5 Editor

TM Concordance F7 Editor

Translate All Ctrl+Shift+A Editor

Translate File CtrI+O Project

Unconfirm All Segments Alt+Shift+Enter Editor

Underline Ctrl+U Editor

Undo Ctrl+Z Blocklist Editor, TM Editor, Glossary Editor, Editor

Verify Segment Ctri+Alt+V Editor




This section only includes shortcuts with a default application-assigned keystroke

sequence.

Commands Shortcut View
Add Blocklist ~C Project
Add Glossary 0 Project
Add Note 0N Editor
Add Project $TA Home
Add Project TMs ®0B Quick Tools
Add Term FT Editor
Add TM N Project
Analyze ¥Space Editor
Attach/Detach Toolbar #D Editor
Bold #B Editor
Clear all tags (Segment) BV Editor
Clear Target Document R Editor
Clear Target Segment AX Editor
Close BW Editor
Close project from home window %X Home
Close segment 8 Editor
Commit All Segments to TM FHEN Editor
Commit Current Segment N Editor
Confirm/Unconfirm Segment e Editor
Confirm All Segments Bie Editor
Copy #C Blocklist Editor, TM Editor, Glossary Editor, Editor
Copy All Sources #¥~\Insert Editor
Copy All Tags (Document) P Editor
Copy All Tags (Segment) A Editor
Copy selected text to target ~F12 Editor
Copy Source oS Editor
Copy Tag N Editor
Copy Term 0 Editor
Copy TM ®1C Project




Commands Shortcut View

Create Blocklist ~\B Project

Create Glossary ~°N Project

Create TM BTN Project

Current Segment Leverage Q Editor

Cut #X Blocklist Editor, TM Editor, Glossary Editor, Editor

Delete Note ~D Editor

Edit Note .= Editor

Edit Term HE Editor

Export Blocklist ~K Project

Export Glossary ~E Project

Export Report as PDF format ~uU Project

Export TM BIE Project

Find/Replace ¥*F Editor

Get Bilingual Table P Editor

Go To Segment #G Editor

Help ¥~H Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Import Blocklist ~J Project

Import Glossary ~ Project

Import TM £ Project

Insert a cent sign 8; Editor

Insert copyright symbol #\C Editor

Insert ellipsis . Editor

Insert em dash - Editor

Insert en dash - Editor

Insert non-breaking hyphen B- Editor

Insert non-breaking space ¥ Space Editor

Insert Registered Trademark #\R Editor

symbol

Italic | Editor

Key Assist Panel #$oL Blocklist Editor, TM Editor, Glossary Editor, Quick

Tools, Editor, Project, Home

Last Modified Segment TF5 Editor

Leverage Previous TU B Editor




Commands Shortcut View

Leverage the first TM Lookup 1 Editor

match

Leverage the second TM 22 Editor

Lookup match

Leverage the third TM Lookup 23 Editor

match

Leverage the fourth TM Lookup ~4 Editor

match

Leverage the fifth TM Lookup ~5 Editor

match

Leverage the sixth TM Lookup 6 Editor

match

Leverage the seventh TM 7 Editor

Lookup match

Leverage the eighth TM Lookup ~8 Editor

match

Leverage the Next TU H- Editor

Machine Translate ®ITM Editor

Merge Segments ¥ Editor

Modify ~M Project

Modify TM ®BOT Project

Move the cursor between the T Editor

source and the target

Next Needs Translation ¥e Editor

Segment

Next Segment (Committo TM) ! Editor

Next Segment (No Commit) 8 Editor

Next Tag E: N Editor

Next Term 9 Editor

Next View W Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Open Blocklist ~H Project

Open Glossary G Project

Open Project $oP Home

Open TM ®BG Project




Commands Shortcut View

Paste #*V Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Preferences F9 Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Previous Segment (No Commit) 81t Editor

Previous Segment (TM Commit) ~* Editor

Previous Tag FH N\ Editor

Previous Term 8 Editor

Pseudo Translate ®UY Quick Tools

Redo 8BY Blocklist Editor, TM Editor, Glossary Editor, Editor

Remove Glossary ~R Project

Remove Reference Files ~0 Project

Remove Report \Z Project

Remove TM BIR Project

Replace/Find ¥H Editor

Run Transcheck Q Editor

Save ¥#S Editor

Save As F12 Editor

Save File As Translated S Editor

Show White Space Characters 08 Editor

Simple Project Creator *P Home

Source TM Lookup ®OF Editor

Spell Check F7 Editor

Split Segment % Editor

Strikethrough #K Editor

Subscript 8= Editor

Superscript ®O= Editor

Term Info T Editor

Terminology Highlight 8BF5 Editor

TM Concordance F8 Editor

Toggle uppercase/lowercase oF3 Editor

Translate All E-RIRN Editor

Translate File 0 Project

Translate Until Fuzzy B F Editor




Commands Shortcut View

Translate Until No Match E I Editor
Unconfirm All Segments e Editor
Underline U Editor
Undo ®Z Blocklist Editor, TM Editor, Glossary Editor, Editor
Verify Segment vV Editor

This section only includes shortcuts with a default application-assigned keystroke

sequence.

Commands Shortcut View

Add Blocklist ~C Project
Add Glossary ~0 Project

Add Note 0N Editor

Add Project HTA Home

Add Project TMs #0B Quick Tools
Add Reference Files ~\o1 Project

Add Term T Editor

Add TM N Project
Analyze ¥Space Quick Tools
Attach/Detach Toolbar #D Editor

Bold B Editor
Clear Target Document N Editor
Clear Target Segment AX Editor
Close project from home window &8 ¢X Home
Commit All Segments to TM BN Editor
Confirm/Unconfirm Segment e Editor
Confirm All Segments Hie Editor

Copy ®C Blocklist Editor, TM Editor, Glossary Editor, Editor
Copy All Sources ~cfrinsert Editor

Copy All Tags (Segment) ~P Editor

Copy Source ~Zlnsert Editor

Copy Tag N TM Editor




Commands Shortcut View

Copy Tag o Editor

Copy Term 0 Editor

Copy TM ®1C Project

Create Blocklist ~B Project

Create Glossary ~N Project

Create TM E N Project

Current Segment Leverage \Q Editor

Cut #X Blocklist Editor, TM Editor, Glossary Editor, Editor

Delete Note 0D Editor

Edit Note ~oE Editor

Edit Term HE Editor

Export Blocklist K Project

Export Glossary ~E Project

Export Package HE Home

Export Report as PDF format ~uU Project

Export TM $OE Project

Find/Replace ¥*F Editor

Go To Segment 8G Editor

Help $\H Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Import Blocklist ~oJ Project

Import Glossary ~ Project

Import TM ol Project

Insert non-breaking space ¥ 7 Space Editor

Italic | Editor

Key Assist Panel BOL Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Last Modified Segment F5 Editor

Leverage Previous TU B Editor

Leverage the Next TU eSS Editor

Merge Segments ¢ Editor

Modify M Project

Modify Project BTM Home

Modify TM ®BOT Project




Commands Shortcut View

Next Segment (No Commit) * Editor

Next Tag RIS Editor

Next Term 9 Editor

Next Update o4 Blocklist Editor

Next View W Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Open Blocklist ~H Project

Open Glossary G Project

Open Project ®oP Home

Open Reference Files 2 Project

Open TM ®BG Project

Paste 8V Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Preferences F9 Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Previous Segment (TM Commit) ~ct Editor

Previous Tag E N Editor

Previous Term H\8 Editor

Pseudo Translate BLY Quick Tools

Redo 8Y Blocklist Editor, TM Editor, Glossary Editor, Editor

Remove Glossary ~R Project

Remove Project BR Home

Remove Reference Files 0 Project

Remove Report Z Project

Remove tag E N

Remove TM $OR Project

Replace/Find ¥H Editor

Save #S Editor

Save As F12 Editor

Save File As Translated E N Editor

Show White Space Characters 18 Editor

Simple Project Creator 8P Home

Spell Check F7 Editor

Split Segment o Editor




Commands Shortcut View
Strikethrough #K Editor
Subscript 8= Editor
Superscript ®o= Editor
Term Info ~T Editor
Terminology Highlight ¥$F5 Editor
TM Concordance HOF Editor
Translate File 0 Project
Translate Until Fuzzy BF Editor
Translate Until No Match E I Editor
Unconfirm All Segments e Editor
Underline U Editor
Undo ®Z Blocklist Editor, TM Editor, Glossary Editor, Editor
Verify Segment BV Editor
This section only includes shortcuts with a default application-assigned keystroke
sequence.
Commands Shortcut View
Add Blocklist ~C Project
Add Glossary O Project
Add Note ~ON Editor
Add Project FTA Home
Add Project TMs $0B Quick Tools
Add Term T Editor
Add Term BT Glossary Editor
Add TM #N Project
Analyze ¥Space Editor
Attach/Detach Toolbar #D Editor
Bold ¥#B Editor
Clear Target Document R Editor
Clear Target Segment AMX Editor
Close #IW Editor




Commands Shortcut View

Close project from home window W Home

Commit All Segments to TM Y Editor

Confirm/Unconfirm Segment e Editor

Confirm All Segments Hie Editor

Copy ®C Blocklist Editor, TM Editor, Glossary Editor, Editor
Copy All Sources ¥~\Insert Editor

Copy All Tags (Document) P Editor

Copy All Tags (Segment) ~P Editor

Copy selected text to target ~F12 Editor

Copy Source F4 Editor

Copy Tag N Editor

Copy Term 0 Editor

Copy TM ®1C Project

Create Blocklist ~B Project

Create Glossary ~oN Project

Create TM $ON Project

Current Segment Leverage Q Editor

Cut #X Blocklist Editor, TM Editor, Glossary Editor, Editor
Delete Note ~D Editor

Edit Note ~TE Editor

Edit Term HE Editor

Export Blocklist K Project

Export Glossary ~E Project

Export Report as PDF format ~uU Project

Export TM HOE Project

Find/Replace ¥$F Editor

Go To Segment £ Editor

Help $~\H Blocklist Editor, TM Editor, Glossary Editor, Quick

Tools, Editor, Project, Home

Import Blocklist ~oJ Project

Import Glossary ~ Project

Import TM S Project

Insert copyright symbol #\C Editor




Commands Shortcut View
Insert ellipsis F11 Editor
Insert em dash - Editor
Insert en dash - Editor
Insert non-breaking hyphen ¥$F9 Editor
Insert non-breaking space ¥ Space Editor
Insert Registered Trademark $\R Editor
symbol
Italic 4 Editor
Key Assist Panel #OL Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home
Last Modified Segment ©F5 Editor
Leverage Previous TU B Editor
Leverage the first TM Lookup 1 Editor
match
Leverage the second TM 22 Editor
Lookup match
Leverage the third TM Lookup o3 Editor
match
Leverage the fourth TM Lookup ~4 Editor
match
Leverage the fifth TM Lookup o5 Editor
match
Leverage the sixth TM Lookup 6 Editor
match
Leverage the seventh TM 7 Editor
Lookup match
Leverage the eighth TM Lookup ~\8 Editor
match
Leverage the Next TU H- Editor
Machine Translate $OF8 Editor
Merge Segments ~J Editor
Modify ~M Project
Modify Project ¥ITM Home
Modify TM BT Project
Move the cursor between the i Editor

source and the target




Commands Shortcut View

Next Segment (Committo TM) ~c! Editor

Next Segment (No Commit) 8 Editor

Next Tag B~ Editor

Next Term $\9 Editor

Next View W Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Open Blocklist ~H Project

Open Glossary G Project

Open Project ®oP Home

Open TM 86 Project

Paste 8V Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Preferences F9 Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Previous Segment (No Commit) 81t Editor

Previous Segment (TM Commit) ~ct Editor

Previous Tag E N Editor

Previous Term H\8 Editor

Pseudo Translate BLY Quick Tools

Redo 8Y Blocklist Editor, TM Editor, Glossary Editor, Editor

Remove Glossary ~R Project

Remove Reference Files ~\0 Project

Remove Report \Z Project

Remove tag N Editor

Remove TM #OR Project

Replace/Find ¥$H Editor

Run Transcheck F12 Editor

Save #S Editor

Save File As Translated #\S Editor

Show White Space Characters 18 Editor

Simple Project Creator ¥*P Home

Source TM Lookup ®OF Editor

Spell Check F6 Editor

Split Segment e Editor




Commands Shortcut View
Strikethrough #K Editor
Subscript 8= Editor
Superscript ®o= Editor
Term Info ~T Editor
Terminology Highlight ¥$F5 Editor
TM Concordance F7 Editor
Toggle uppercase/lowercase TF3 Editor
Translate All E IR Editor
Translate File #0 Project
Translate Until Fuzzy H~\F Editor
Translate Until No Match E I Editor
Unconfirm All Segments e Editor
Underline U Editor
Undo *Z Blocklist Editor, TM Editor, Glossary Editor, Editor
Verify Segment vV Editor
This section only includes shortcuts with a default application-assigned keystroke
sequence.
Commands Shortcut View
Add Blocklist ~C Project
Add Glossary ~0 Project
Add Project TMs $0B Quick Tools
Add Reference Files 1 Project
Add Term F#F11 Editor
Add Term BT Glossary Editor
Add TM N Project
Analyze ¥Space Quick Tools
Attach/Detach Toolbar D Editor
Bold ¥#B Editor
Clear Target Document RSIJE> Editor
Clear Target Segment AX Editor




Commands Shortcut View

Close #W Editor

Close project from home window &1 X Home

Commit All Segments to TM ®yoU Editor

Confirm/Unconfirm Segment e Editor

Confirm All Segments Hie Editor

Copy #C Blocklist Editor, TM Editor, Glossary Editor, Editor

Copy All Tags (Segment) ~P Editor

Copy selected text to target ~F12 Editor

Copy Source F4 Editor

Copy Tag ¥$F4 Editor

Copy Term N Editor

Copy TM ®1C Project

Create Blocklist ~B Project

Create Glossary ~N Project

Create TM $ON Project

Current Segment Leverage ~Q Editor

Cut 8X Blocklist Editor, TM Editor, Glossary Editor, Editor

Export Blocklist K Project

Export Glossary ~E Project

Export Package H$E Home

Export Report as PDF format ~uU Project

Export TM BIE Project

Go To Segment £ Editor

Help $\H Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Import Blocklist ~oJ Project

Import Glossary ~ Project

Import TM S Project

Insert en dash - Editor

Insert non-breaking space ¥ Space Editor

Italic £ Editor

Key Assist Panel #$oL Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Last Modified Segment TF5 Editor




Commands Shortcut View

Machine Translate H$0F8 Editor

Merge Segments e Editor

Modify ~M Project

Modify Project $IM Home

Modify TM ®OT Project

Move the cursor between the T Editor

source and the target

Next Segment (Committo TM) < Editor

Next Segment (No Commit) * Editor

Next Tag H o~ TM Editor

Next Update o Blocklist Editor

Next View W Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Open Blocklist ~H Project

Open Glossary G Project

Open Project ®BIP Home

Open Reference Files 22 Project

Open TM ®0G Project

Paste 8V Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Preferences F9 Blocklist Editor, TM Editor, Glossary Editor, Quick
Tools, Editor, Project, Home

Previous Tag H Editor

Previous Update ~t Blocklist Editor

Pseudo Translate ®UY Quick Tools

Redo 8BY Blocklist Editor, TM Editor, Glossary Editor, Editor

Remove Glossary R Project

Remove Project #\R Home

Remove Reference Files 0 Project

Remove Report \Z Project

Remove TM BIR Project

Save #S Editor

Save File As Translated $\S Editor

Show White Space Characters 18 Editor




Commands Shortcut View
Simple Project Creator ¥*P Home
Source TM Lookup ®OF Editor
Spell Check F6 Editor
Split Segment oS Editor
Strikethrough $K Editor
Subscript 8= Editor
Superscript ®o= Editor
Term Info ~T Editor
Terminology Highlight ¥$F5 Editor
TM Concordance F7 Editor
Translate All HTA Editor
Translate File #0 Project
Unconfirm All Segments e Editor
Underline U Editor
Undo ¥*Z Blocklist Editor, TM Editor, Glossary Editor, Editor
Verify Segment $\V Editor




This section contains hardware and software requirements for using Wordfast.

Supported Operating Systems Microsoft Windows 7+ 64-bit, Mac OS X 10.11+ 64-bit, and Linux
64-bit
Java Runtime Environment If not present, Wordfast Pro automatically installs Java Runtime

Environment during the application installation process

License and Registration Activation of the full Wordfast Pro installation requires a license and

registration

Minimum System Memory 4 GB RAM

Minimum Screen Resolution 1366 x 768 pixels

The Formatting tab in the TXLF Editor includes formatting tools you can use to edit the target content format.

Formatting tools fall into three categories: format, tags, and options.

o Format category options are only available for MS Office source file formats.

Format Buttons

Button Keyboard Shortcut Description
B Ctrl+B Format the selected text as bold.
Bold
I Ctri+l Format the selected text as italic.
Italic
U Ctrl+U Format the selected text as underlined.
Underline
X Ctrl+= Format the selected text as subscript.
Subscript
X Ctrl+Shift+= Format the selected text as superscript.
Superscript
ABE Ctrl+K Format the selected text to display as strikethrough

Strike

(deleted), without actually deleting the text.

Tags Buttons



Button Keyboard Shortcut Description
= No shortcut Display actual formatting associated with tags for the
Tag active segment (when supported.)
Formatting
. No shortcut Display the content of the formatting tags for the active
Tag segment.

Mon-Formatting

Options Buttons

Button Keyboard Shortcut Description
- Ctrl+Shift+Space Insert a non-breaking space at the cursor location.
Mon-Breaking
Space
q No shortcut Insert a marker to indicate left-to-right reading direction.
Left To Right
Marker
q No shortcut Insert a marker to indicate right-to-left reading direction.
Right To Left
Marker
& Ctrl+D Attach and detach the Formatting toolbar. When

Attach /
Detach

attached, the toolbar is displayed as a tab. When
detached, the toolbar is displayed as a minimized
toolbar that can be moved to any area of the TXLF
Editor.

The Filters selection on the Preferences dialog box configures how translatable content is parsed from source

files.

Format and Extension

Active Server Page (*.asp)

Adobe FrameMaker Interchange Format (*.mif)

Adobe InCopy Markup language (*.icml)

Adobe InDesign Interchange (*.inx)

Adobe InDesign Markup Language (*.idml)

Flat OPC XML Word Document Format (*.xml)

Hypertext Markup Language (*.htm)

Hypertext Markup Language (*.html)

JSON files (*.json)




Format and Extension

Java Server Page (*.jsp)

MS Excel 2007 Spreadsheet (*.xlsx)

MS Excel Open XML Macro-Enabled Spreadsheet (*.xIsm)

MS Excel Open XML Spreadsheet Template (*.xltx)

MS Excel Open Spreadsheet (*.xls)

MS Excel Spreadsheet template (*.xIt)

MS PowerPoint 2007 Presentation (*.pptx)

MS PowerPoint 97-2003 Template (*.pot)

MS PowerPoint Macro-Enabled Presentation (*.pptm)

MS PowerPoint Macro-Enabled Show (*.ppsm)

MS PowerPoint Macro-Enabled Template (*.potm)

MS PowerPoint Presentations (*.ppt)

MS PowerPoint Show (*.ppsx)

MS PowerPoint Template (*.potx)

MS Visio Document (*.vdx)

MS Visio Document (*.vsd)

MS Visio Document (*.vsdx)

MS Word 2007 Document (*.docx)

MS Word Document (*.doc)

MS Word Open XML Macro-Enabled Document (*.docm)

MS Word Open XML Macro-Enabled Template (*.dotm)

MS Word Open XML Template (*.dox)

MS Word Template (*.dot)

Markdown file (*.md)

MemoQ XLIFF (*.mqxliff)

Microsoft Word 2003 WordprocessingML document (*.xml)

PO files (*.po)

Plain Text (*.txt)

Portable Document Format (*.pdf)

Quark Documents (*.tag)

Rich Text Format (*.rtf)

SDL XLIFF (*.sdIxliff)

SubRip (*.srt)




Format and Extension

TXML (*.txml)

Trados TTX (*.ttx)

WF TXLF Document (*.txIf)

XLIFF (*.xIf)

XLIFF 2.0 (*.xIf)

XLIFF 2.0 (*.xliff)

How do | obtain a Wordfast Pro License and install the application?

Wordfast products are try-before-you-buy. You can download a free 30-day Demo mode of Wordfast
Pro from http://www.wordfast.com/. Demo mode has limited functionality until you enter the
activation key. When you purchase a Wordfast license, you can generate an activation key at https://
www.wordfast.com/myaccount by signing in with your sign in email and password. Copy and save
the activation key.

To activate Wordfast Pro, click on the Sidebar. Click either Online Registration or Manual
Registration and follow the instructions to activate your product using the activation key. Once
activated, Wordfast Pro changes from Demo mode to the full unlocked version.

What does Wordfast Pro Demo mode mean?

When in Demo mode, you are limited to creating bilingual projects and storing up to 500 translation
units in your Translation Memory. To get a full version, you must upload a license. Refer to Activation
on page 9.

Why is my completed project now showing as less than 100% complete in my Projects List?

The latest version of Wordfast Pro contains a new segment state feature and an improved Progress
Bar. As a result, projects from legacy versions of Wordfast Pro might register as less than 100%
complete or N/A in the Projects List. To resolve the issue, open the project, then open the
translation file. If you have multiple translation files, chain them together. In the TXLF Editor view,
click Mark All Translated. Save and close the project. In the Project List view, click Recalculate
Progress. The project should now register as 100% complete.

What happens if | upload a corrupt file for translation when creating a project?

If one of the files is corrupt or invalid, you can still create a project with clean files. The corrupt or
invalid file will not upload and you receive a warning message.

How do | chain individual files?

Instead of opening files one-by-one to display in individual tabs, you can chain files to open in a
single tab as long as these files are in the same batch. You cannot chain files across batches.
Chaining files has the following main advantages:

e Open hundreds of files within seconds.


http://www.wordfast.com/
https://www.wordfast.com/myaccount
https://www.wordfast.com/myaccount

e Filter or search and replace in one pass as opposed to once per individual file.

Why is the Analyze button inactive when | open a chained file for translation?

The Analyze action you can normally access in TXLF Editor view is inactive when you open a
chained file because the translation memory cannot provide the best results.

What are the different ways to analyze files?

The analysis process converts source files into TXLF, leverages the content against existing
translation memories, and generates a report listing matches, non-matches, word count, character
count, and segment count. You can analyze source files in the following ways:

e Analyze files within a project in the Current Projects view.

¢ Analyze any files outside of the project files on the Analysis tab in the Quick Tools view.

e Analyze a file open for translation in TXLF Editor view by clicking the Analyze button on the
Translation tab.

Refer to Analysis on page 213.

How do | use Skip 100% and 100%+ Segments when using TXLF Editor view?

To skip 100% and 100%+ segments when moving to a segment that requires linguistic changes, you
have two options:

e (Preferred) Set preferences to Skip 100% and 100%+ segments. This allows you to view the
100% and 100%+ segments for context while editing adjacent No Match and Fuzzy match or
MT pre-translations.

e Filter for All except 100% and Context match segments.

How do | update a TM with my translations?

To update a TM after you finish translating or editing a segment in TXLF Editor view, you must
commit it to the TM. Committing a segment will turn the color highlight from pink to purple. You can
commit a segment to the TM as follows:

e Move to the next segment clicking the Next Segment button, or by using Alt + Down Arrow.

e While your cursor is in a segment, click Commit on the Translation tab.

¢ Click Commit All on the Translation tab to add all the segments in the file to the TM.

If a segment does not require any changes, for example, if the 99% match or the MT match is
linguistically correct, you can change the Translation Memory settings in Preferences to add these
items to the TM. To change the TM settings:

Click 2=

e Click Translation Memory in the Current Project Preferences section.

e Select the items you would like to have committed to the TM when working in your project:
o Write 'exact' matches to TM

o Write 'unedited MT' to TM

o Write 'unedited fuzzy' to TM

How do | keep translations from updating the master TM?

To prevent a segment from updating the TM:

1. Open the file for translation and click on the segment that you do not want to write to the TM.



2. In the TXLF Editor view, click Do Not Write To TM on the Translation tab. The Status column
displays ch‘ and does not update the TM.

3.
To write the segment to the TM, select the segment and click Do Not Write To TM again. The l:b
is removed from the Status column, and the segment may then be updated to the TM.

How do | correctly apply inline formatting?

You can apply inline formatting to the target segment in two ways:

1. You can enter tag(s) from the source language segment for basic styles such as bold and italic
using the buttons on the Formatting tab. However, these formatting buttons could introduce tags
in the target that do not match the source. Unless the linguist identifies these mismatched tags
using Transcheck and corrects them, they will prevent affected TXLF files from converting into
monolingual files at the align stage.

2. To avoid the mismatched tags, after opening a file for translation, go to Preferences > Tags and
select Show Formatting as Tags.

Since this preference persists from one WFP session to another, you only have to set it once.
This preference enables you to reuse tags from the source using the Copy button under the
Translation tab. If the tag preference is set to Show Text Formatting (when supported), you
must apply formatting using the buttons in the Formatting tab, unless you toggled segment-by-
segment from Tag Formatting to Tag Non-Formatting.

Why is the Whole Words Only check box inactive on the Find/Replace dialog?

In the Find and Replace dialog, the Whole Words Only check box is inactive if you added multiple
words or punctuation to the Find field.

What are Preferences and how do | access them?

You can customize all user interface options and features in the preferences section.

—
To access preferences, on the Sidebar click =i=.

e Configure preferences that will apply to all projects in the General Preferences section.

e Configure preferences that apply only to the currently active project in the Current Project
Preferences section.

e Configure advanced settings in the User Preferences section.

Refer to Current project preferences.

How can | preview a file during translation?

In TXLF Editor, on the File tab, click Preview, then select Live Preview, Office Preview, or Html
Preview from the drop-down menu. Live Preview works with Word, PowerPoint, or Markdown files.
It opens a preview of the target content for comparison to your source content. If you click on a line of
text in the preview document, your cursor will move to that segment in the TXLF file. Office Preview
will open a PDF preview of the current translation file. Html Preview will open a preview as an HTML
file, only if the source file was HTML.

Another option is to click Preview File, and a translated file will open if the source is available.
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